
Field Reference for Configuration Pages

This chapter provides descriptions of the fields found in the pages under theConfiguration tab of Cisco Prime
Infrastructure.

• Network Devices Field Descriptions, on page 1
• Features and Technologies Field Descriptions, on page 9
• CLI Templates Field Descriptions, on page 108
• Wireless Configuration Field Descriptions, on page 136
• Compliance Field Descriptions, on page 152
• Configure Switches, on page 157

Network Devices Field Descriptions
The following topics contain descriptions of the fields found in theConfiguration > Network Devices pages:

Wireless Controllers > System > AP 802.1X Supplicant Credentials
The following table describes the fields in Configuration > Network Devices > Controllers > AP 802.1X
Supplicant Credentials page.

Table 1: Wireless Controllers > System > AP 802.1X Supplicant Credentials

DescriptionField

Template Basic

Enter a name for the template.Name

Enter an optional description for the template.Description

Enter one or more tags. Tags are used to group templates. There are two ways you can tag a template:

• Create the tags when you create the template.

• Use the Tag icon located under the Templates search bar.

Tags

Validation Criteria

Choose the device type from the drop-down list.Device Type
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DescriptionField

Template Detail

Select this option to enable the global supplicant credentials.Global Supplicant Credential

Wireless Controllers > System > AP Timers
Table 2-2 describes the fields in Configuration > Network Devices > Controllers > AP Timers page.

Table 2: Wireless Controllers > System > AP Timers

DescriptionField

The Access Point Mode is automatically populated. The values in the Access Point Mode column are
links. When you click a link, the Controller Template access point mode page appears.

• FlexConnect Mode—Click this link to configure FlexConnect Mode template.

• Local Mode—Click this link to configure the Local Mode template.

Access Point Mode

Displays the number of controllers the WLAN template is applied to.Applied to Controllers

Displays the number of virtual domains the controller template is applied to.Applied to Virtual Domains

Indicates when the template was last saved.Last Saved At

Wireless Controllers > System > AP Timers > FlexConnect Mode > Edit
The following describes the fields in Configuration > Network Devices > Controllers > AP Timers >
FlexConnect Mode > Edit page.

Table 3: Configuration > Network Devices > Controllers > AP Timers > FlexConnect Mode > Edit

DescriptionField

Template Basic

Enter a name for the template.Name

Enter an optional description for the template.Description

Enter one or more tags. Tags are used to group templates. There are two ways you can tag a template:

• Create the tags when you create the template.

• Use the Tag icon located under the Templates search bar.

Tags

Validation Criteria

Choose the device type from the drop-down list.Device Type
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DescriptionField

Template Detail

The Access Point Mode is automatically populated.Access Point Mode

Select this check box to enable AP Fast Heartbeat Timeout.AP Fast Heartbeat Timer State

Enter an AP Fast Heartbeat Timeout value. The valid range is 1 to 15 seconds. The default is 10
seconds. The recommended timeout values are:

• 10 to 15 seconds for 7500 series controllers.

• 10 to 15 seconds for 5500 series controllers Release 7.0.98.0 and earlier.

• 1 to 10 seconds for 5500 series controllers Release 7.0.98.0 and later.

1 to10 seconds for other controllers.

AP Fast Heartbeat Timeout

Wireless Controllers > System > AP Timers > Local Mode > Edit
The following table describes the fields in Configuration > Network Devices > Controllers > AP Timers
> Local Mode > Edit page.

Table 4: Configuration > Network Devices > Controllers > AP Timers > Local Mode > Edit

DescriptionField

Template Basic

Enter a name for the template.Name

Enter an optional description for the template.Description

Enter one or more tags. Tags are used to group templates. There are two ways you can tag a template:

• Create the tags when you create the template.

• Use the Tag icon located under the Templates search bar.

Tags

Validation Criteria

Choose the device type from the drop-down list.Device Type

Template Detail

The Access Point Mode is automatically populated.Access Point Mode

Select this check box to enable AP Fast Heartbeat Timeout.AP Fast Heartbeat Timer State
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DescriptionField

Enter an AP Fast Heartbeat Timeout value. The valid range is 1 to 15 seconds. The default is 10
seconds. The recommended timeout values are:

• 10 to 15 seconds for 7500 series controllers.

• 10 to 15 seconds for 5500 series controllers Release 7.0.98.0 and earlier.

• 1 to 10 seconds for 5500 series controllers Release 7.0.98.0 and later.

1 to10 seconds for other controllers.

AP Fast Heartbeat Timeout

Wireless Controllers > System > AP Username Password
The following table describes the fields inConfiguration > Network Devices > Controllers > APUsername
Password page.

Table 5: Configuration > Network Devices > Controllers > AP Username Password

DescriptionField

Template Basic

Enter a name for the template.Name

Enter an optional description for the template.Description

Enter one or more tags. Tags are used to group templates. There are two ways you can tag a template:

• Create the tags when you create the template.

• Use the Tag icon located under the Templates search bar.

Tags

Validation Criteria

Choose the device type from the drop-down list.Device Type

Template Detail

Type the password that you want to be inherited by all access point that join the controller.AP Password

Retype the access point password.Confirm Password

Enable password is applicable for Cisco IOS APs.Enable Password

For Cisco IOS access points, you must also enter and confirm the enable password.Confirm Enable Password

Wireless Controllers > System > DHCP
The following table describes the fields in Configuration > Network Devices > Controllers > DHCP page.
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Table 6: Configuration > Network Devices > Controllers > DHCP

DescriptionField

Template Basic

Enter a name for the template.Name

Enter an optional description for the template.Description

Enter one or more tags. Tags are used to group templates. There are two ways you can tag
a template:

• Create the tags when you create the template.

• Use the Tag icon located under the Templates search bar.

Tags

Validation Criteria

Choose the device type from the drop-down list.Device Type

Template Detail

ChooseAP-MAC,AP-MAC-SSID,AP-ETHMAC, orAP-NAME-SSID from the drop-down
list.

DHCP Option 82 Remote Id field
format

Select the check box to enable DHCP proxy.When DHCP proxy is enabled on the controller,
the controller unicasts DHCP requests from the client to the configured servers. At least one
DHCP server must be configured on either the interface associated with the WLAN or on
the WLAN itself. DHCP proxy is enabled by default.

DHCP Proxy

Enter the DHCP Timeout in seconds, after which the DHCP request times out. The default
setting is 5. Allowed values range from 5 to 120 seconds.

DHCP Timeout is applicable for Controller Release 7.0.114.74 and later.

DHCP Timeout

Wireless Controllers > System > Dynamic Interface
The following table describes the fields in Configuration > Network Devices > Controllers > Dynamic
Interface page.

Table 7: Configuration > Network Devices > Controllers > Dynamic Interface

DescriptionField

Template Basic

Enter a name for the template.Name

Enter an optional description for the template.Description
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DescriptionField

Enter one or more tags. Tags are used to group templates. There are two ways you can tag
a template:

• Create the tags when you create the template.

• Use the Tag icon located under the Templates search bar.

Tags

Validation Criteria

Choose the device type from the drop-down list.Device Type

Template Detail

Interface Address

Select this check box to mark the interface as wired.Guest LAN

Select this check box to quarantine a VLAN.Quarantine

Enter the net mask address of the interface.Netmask

Physical Information

Select this check box to enable the Link Aggregation (LAG).LAG Mode

Enter a primary port number.

Primary and Secondary port numbers are present only in the Cisco 4400 Series Wireless
Controllers.

Primary Port Number

Enter a secondary port to be used by the interface when the primary port is down. When the
primary port is reactivated, the Cisco 4400 SeriesWireless Controller transfers the interfaces
back to the primary port.

Secondary Port Number

Select this check box to enable access point management.AP Management

DHCP Information

Enter the IP address of the primary DHCP server.Primary DHCP Server

Enter the IP address of the secondary DHCP server.Secondary DHCP Server

Choose the DHCP proxymode type from the drop-down list. The possible values are: Global,
Enabled, and Disabled.

DHCP Proxy Mode

Select this check box to enable the DHCP relay agent information option.Enable DHCP Option 82

Select this check box to enable the DHCP Option 82 - Link Select.Enable DHCP Option 82- Link Select

Choose a value from the Link Select replay source drop-down list.Link Select relay source

Select this check box to enable the DHCP Option 82-VPN Select.Enable DHCP Option 82-VPN Select

Select VRF Name.VPN Select-VRF Name

Select VPN ID.VPN Select-VPN ID
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DescriptionField

Access Control List

From the ACL Name drop-down list, choose a name from the list of defined names.ACL Name

From the mDNS Profile drop-down list, choose the mDNS profile. The default option is
none.

mDNS Profile

Wireless Controllers > System > General - System Field Descriptions
The following table describes the fields in Configuration > Network Devices > Wireless Controllers >
System > General - System page.

Table 8: Wireless Controllers > System > General - System Field Descriptions

DescriptionField

Disable or enable.802.3x Flow Control Mode

Disable or enable.802.3 Bridging

Choose PAP, CHAP, or MD5-CHAP.

• PAP—Password Authentication Protocol. Authentication method where user information
(username and password) is transmitted in clear text.

• CHAP—Challenge Handshake Authentication Protocol. Authentication method where
user information is encrypted for transmission.

• MD5-CHAP—Message Digest 5 Challenge Handshake Authentication Protocol. With
MD5, passwords are hashed using the Message Digest 5 algorithm.

Web Radius Authentication

Enter a value between 30 and 3600 seconds.

The access point maintains a list of backup controllers and periodically sends primary discovery
requests to each entry in the list.When configured, the primary discovery request timer specifies
the amount of time that a controller has to respond to the discovery request of the access point
before the access point assumes that the controller cannot be joined and waits for a discovery
response from the next controller in the list.

AP Primary Discovery Timeout

Layer 3 or Layer 2. See the Lightweight Access Point Protocol Transport Mode section for
more information.

CAPWAP Transport Mode

Automatically populated.Current LWAPP Operating Mode

Disable or enable.Broadcast Forwarding
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DescriptionField

Choose Disable if you want to disable LAG.

Link aggregation (LAG) is a partial implementation of the 802.3ad port aggregation standard.
It bundles all of the controller distribution system ports into a single 802.3ad port channel,
thereby reducing the number of IP addresses needed to configure the ports on your controller.
When LAG is enabled, the system dynamically manages port redundancy and load balances
access points transparently to the user.

LAG is disabled by default on the Cisco 5500 and 4400 series controllers but enabled by default
on the CiscoWiSM and the controller in the Catalyst 3750G IntegratedWireless LANController
Switch.

LAG Mode

• Disable—Select to disable multicast support on the controller.

• Unicast—Select if the controller, upon receiving a multicast packet, forwards the packets
to all the associated access points. FlexConnect supports only unicast mode.

• Multicast—Select to enable multicast support on the controller.

Ethernet Multicast Support

Disable or enable. See the Aggressive Load Balancing section for more information on load
balancing.

Aggressive Load Balancing

• Disable—Same-subnet clients communicate through the controller.

• Enable—Same-subnet clients communicate through a higher-level router.

Peer to Peer Blocking Mode

Disable or enable.

Over-the-air provisioning (OTAP) is supported by Cisco 5500 and 4400 series controllers. If
this feature is enabled on the controller, all associated access points transmit wireless CAPWAP
or LWAPP neighbor messages, and new access points receive the controller IP address from
these messages. This feature is disabled by default and should remain disabled when all access
points are installed.

Disabling OTAP on the controller does not disable it on the access point. OTAP cannot be
disabled on the access point.

Over Air Provision AP Mode

Disable or enable.

Enabling AP Fallback causes an access point which lost a primary controller connection to
automatically return to service when the primary controller returns.

AP Fallback

Disable or enable.

To configure failover priority settings for access points, you must first enable the AP Failover
Priority feature. See the AP Failover Priority section for more information.

AP Failover Priority

Disable or enable.AppleTalk Bridging
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DescriptionField

Disable or enable.

When fast SSID changing is enabled, the controller allows clients to move between SSIDs.
When the client sends a new association for a different SSID, the client entry in the controller
connection table is cleared before the client is added to the new SSID.When fast SSID changing
is disabled, the controller enforces a delay before clients are allowed to move to a new SSID.

If enabled, the client connects instantly to the controller between SSIDs without having
appreciable loss of connectivity.

Fast SSID change

Disable or enable.

Because the master controller is normally not used in a deployed network, the master controller
setting is automatically disabled upon reboot or OS code upgrade.

Master Controller Mode

Disable or enable.Wireless Management

Disable or enable. The number of hits are displayed in the ACL Rule page.ACL Counters

Disable or enable.Multicast Mobility Mode

Enter domain name.Default Mobility Domain Name

Enter the amount of delay time allowed between tries for a client attempting to join another
access point. See theMobility Anchor Group Keep Alive Interval section for more information.

When you hover your mouse cursor over the parameter text box, the valid range
for that field appears.

Tip

Mobility Anchor Group Keep Alive
Interval

Enter number of allowable retries.

When you hover your mouse cursor over the parameter text box, the valid range
for that field appears.

Tip

Mobility Anchor Group Keep Alive
Retries

Enter network name.RF Network Name

Enter timeout in seconds.User Idle Timeout (seconds)

Enter timeout in seconds.ARP Timeout (seconds)

Features and Technologies Field Descriptions
The following topics contain descriptions of the fields found in the Features and Technologies templates:

• Application Visibility Field Descriptions

• Controller Templates Field Descriptions

• Interfaces Templates Field Descriptions

• Network Analysis Module Field Descriptions
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• Security Templates Field Descriptions

Application Visibility Field Descriptions
The Application Visibility feature allows you to monitor the traffic sent toward the Internet. You can monitor
the traffic flow and generate reports based on the traffic flow.

The following table describes the fields in Configuration > Templates > Features and Technologies >
Application Visibility & Control > Application Visibility.

Table 9: Application Visibility

DescriptionField

Template Detail

Choose an interface role from the drop-down list. For information about creating the interface role,
see the “Controlling User Access” section in the User Guide for the Cisco Prime Network Control
System WAN 1.1.

Apply to Interface Role

Traffic Statistics

Click Off if you do not want to collect the statistics pertaining to data packets.

We recommend that you:

• Configure the required minimal set of filters.

• Collect only traffic statistics for sites that run only IPv4 traffic.

On/Off

Select an option to generate the report on IPv4, IPv6, or both IPv4 and IPv6 traffic.IPs, Subnets

HTTP URL Visibility

Click Off if you do not want to collect the statistics on HTTP URL visibility.On/Off

Select a specific set of IPv4 addresses or subnets to be monitored and decide whether to generate the
report for IPv6 traffic.

IPs, Subnets

Select a specific set of applications that should be monitored (there could be up to 32 monitored
applications). By default, all the enterprise related HTTP-based applications are included in the list.

Applications

Select the Sampling Rate and Direction from the drop-down list. To reduce the performance impact
on the device, select only the relevant traffic to be monitored.

Advanced Options

Application Response Time

Click Off if you do not want to collect the Application Response Time metrics.On/Off

Select a specific set of IPv4 addresses or subnets to be monitored and decide whether to generate the
report for IPv6 traffic.

IPs, Subnets

Select a specific set of applications that should be monitored (there could be up to 32 monitored
applications). By default, all the enterprise related HTTP-based applications are included in the list.

Applications
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DescriptionField

Voice/Video Metrics

Click Off if you do not want to collect the metrics on voice/video traffic.On/Off

Select a specific set of IPv4 addresses or subnets to be monitored and decide whether to generate the
report for IPv6 traffic.

IPs, Subnets

Select a specific set of applications that should be monitored (there could be up to 32 monitored
applications). By default, all the enterprise related RTP enterprise-related applications are monitored.

Applications

Controller Templates Field Descriptions
Altering configurations across a large number of controllers can be tedious and time-consuming, and templates
save you time by applying the necessary configurations and by ensuring consistency across controllers. When
you are implementing new services or a new site, use these controller templates to define controller parameters
and settings, which you can later deploy to a specified number of wireless LAN controllers.

The following topics contain field descriptions for pages found in Configuration > Templates > Features
and Technologies > Controller.

• Controller 802.11

• Controller > 80211a or n or ac

• Controller > 80211b or g or n

• Controller > CLI > General

• Controller > FlexConnect > FlexConnect AP Groups

• Controller > IPv6

• Controller > Location

• Controller > Management

• Controller > Mesh > Mesh Settings

• Controller > PMIP

• Controller >Security

• Controller > System

• Controller > WLANs > WLAN Configuration

• Controller > mDNS

Controller 802.11
The following topics contain field descriptions for pages found in Configuration > Templates > Features
and Technologies > Controller > 802.11.

• Controller > 802.11 > Band Select
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• Controller > 802.11 > Load Balancing

• Controller > 802.11 > Media Stream

• Controller > 802.11 > Preferred Call

• Controller > 802.11 > RF Profiles

Controller > 802.11 > Band Select

The following table describes the Template Detail fields found in Configuration > Templates > Features
and Technologies > Controller > 802.11 > Band Select.

Table 10: Controller > 802.11 > Band Select

DescriptionField

Enter a value from 1 to 10 for the probe cycle count. The cycle count sets the number of suppression
cycles for a new client. The default cycle count is 2.

Probe Cycle Count

Enter a value from 1 to 1000 milliseconds for the scan cycle period threshold. This setting determines
the time threshold during which new probe requests from a client come from a new scanning cycle.
The default cycle threshold is 200 milliseconds.

Scan Cycle Period Threshold

Enter a value from 10 to 200 seconds for the age-out suppression. Age-out suppression sets the
expiration time for pruning previously known 802.11b/g clients. The default value is 20 seconds.
After this time elapses, clients become new and are subject to probe response suppression.

Age Out Suppression

Enter a value from 10 to 300 seconds for the age-out dual band. The age-out period sets the expiration
time for pruning previously known dual-band clients. The default value is 60 seconds. After this time
elapses, clients become new and are subject to probe response suppression.

Age Out Dual Band

Enter a value between –20 and –90 dBm for the acceptable client Received Signal Strength Indicator
(RSSI). This field sets the minimum RSSI for a client to respond to a probe. The default value is –80
dBm.

Acceptable Client RSSI

Controller > 802.11 > Load Balancing

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Controller > 802.11 > Load Balancing.

Table 11: Controller > 802.11 > Load Balancing

DescriptionField

Enter a value from 1 to 20. The page size becomes part of the algorithm that determines whether an access
point is too heavily loaded to accept more client associations:

load-balancing page + client associations on AP with lightest load = load-balancing threshold

ClientWindowSize

Enter a value from 0 to 10. The denial count sets the maximum number of association denials during load
balancing.

Max Denial Count
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Controller > 802.11 > Media Stream

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Controller > 802.11 > Media Stream.

Table 12: Controller > 802.11 > Media Stream

DescriptionField

Enter the name of the media stream.Media Stream Name

Enter the start IP address of the media stream to be multicast.Multicast Destination Start IP

Enter the end IP address of the media stream to be multicast. Start IP and End IP can be IPv4 or
IPv6 multicast address, starting from controller Version 7.2.x.

Multicast Destination End IP

Enter the maximum bandwidth that a media stream can use.MaximumExpectedBandwidth

Enter the average packet size that a media stream can use.Average Packet Size

Enter the Resource Reservation Control (RRC) calculations that are updated periodically; if disabled,
RRC calculations are done only once when a client joins a media stream.

RRC Periodical Update

Enter the priority of RRC with the highest at 1 and the lowest at 8.RRC Priority

Choose the Traffic Profile Violation from the drop-down list. The drop-down list appears if the
stream is dropped or put in the best effort queue if the stream violates the QoS video profile.

Traffic Profile Violation

Choose the Policy from the drop-down list. The drop-down list appears if the media stream is
admitted or denied.

Policy

Controller > 802.11 > Preferred Call

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Controller > 802.11 > Preferred Call.

Table 13: Controller > 802.11 > Preferred Call

DescriptionField

Enter a value to identify the preferred number. You can have a maximum of six preferred call numbers. The valid
range is from 1 to 6. The default value is 1.

Number Id

Enter the preferred call number.Preferred
Number

Controller > 802.11 > RF Profiles

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Controller > 802.11 > RF Profiles.
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Table 14: Controller > 802.11 > RF Profiles

DescriptionField

Enter the name of the template.Template Name

Enter the name of the current profile.Profile Name

Enter the Description of the template.Description

Choose the radio type of the access point from the drop-down list.Radio Type

Enter a value from -10 to 30dBm for the minimum power level assignment. The default
value is -10 dBM.

MinimumPower Level Assignment (-10
to 30 dBm)

Enter a value from -10 to 30dBm for the maximum power level assignment. The default
value is 30 dBM.

MaximumPower Level Assignment (-10
to 30 dBm)

Enter a value from -80 to -50dBm for the power threshold v1. The default value is -70
dBM.

Power Threshold v1(-80 to -50 dBm)

Enter a value from -80 to -50dBm for the power threshold v2.The default value is -67
dBM.

Power Threshold v2(-80 to -50 dBm)

Select the data rates from the drop-down lists to specify the rates at which data can be
transmitted between the access point and the client. These data rates are available:

• 802.11a—6, 9, 12, 18, 24, 36, 48, and 54 Mbps.

• 802.11b/g—1, 2, 5.5, 6, 9, 11, 12, 18, 24, 36, 48, or 54 Mbps.

For each data rate, you must also choose one of these options:

• Mandatory—Clients must support this data rate to associate to an access point on the
controller.

• Supported—Any associated clients that support this data rate might communicate
with the access point using that rate. However, the clients are not required to be able
to use this rate to associate.

• Disabled—The clients specify the data rates used for communication.

Data Rates

Controller > 80211a or n or ac
The following topics contain field descriptions for pages found in Configuration > Templates > Features
and Technologies > Controller > 80211a or n or ac.

• Controller > 80211a or n or ac > dot11a-RRM > DCA

• Controller > 80211a or n or ac > dot11a-RRM > Intervals

• Controller > 80211a or n or ac > dot11a-RRM > TPC

• Controller > 80211a or n or ac > dot11a-RRM > Thresholds

• Controller > 80211a or n or ac > 802.11h
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• Controller > 80211a or n or ac > CleanAir

• Controller > 80211a or n or ac > EDCA Parameters

• Controller > 80211a or n or ac > High Throughput (802.11n)

• Controller > 80211a or n or ac > Media Parameters > General

• Controller > 80211a or n or ac > Media Parameters > Video

• Controller > 80211a or n or ac > Media Parameters > Voice

• Controller > 80211a or n or ac > Parameters

• Controller > 80211a or n or ac > Roaming Parameters

Controller > 80211a or n or ac > dot11a-RRM > DCA

The Radio Resource Management (RRM) Dynamic Channel Assignment (DCA) page allows you to choose
the DCA channels as well as the channel width for this controller.

RRMDCA supports 802.11n 40-MHz channel width in the 5-GHz band. The higher bandwidth allows radios
to achieve higher instantaneous data rates.

Choosing a larger bandwidth reduces the nonoverlapping channels that could potentially reduce the overall
network throughput for certain deployments.

Note

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Controller > 80211a or n or ac > dot11a-RRM > DCA.

Table 15: Controller > 80211a or n or ac > dot11a-RRM > DCA

DescriptionField

From the drop-down list, choose one of three modes:

• Automatic—The transmit power is periodically updated for all access points that permit this operation.

• On Demand—Transmit power is updated when you click Assign Now.

• Disabled—No dynamic transmit power assignments occur, and values are set to their global default.

Assignment Mode

Select the enable check box to have RRM consider interference from foreign Cisco access points (those
non-Cisco access points outside RF/mobility domain) when assigning channels. Unselect this check box
to have RRM ignore this interference. In certain circumstances with significant interference energy (dB)
and load (utilization) from foreign access points, RRM might adjust the channel assignment to avoid
these channels (and sometimes adjacent channels) in access points close to the foreign access points. This
adjustment increases capacity and reduces variability for the Cisco WLAN Solution.

Avoid Foreign AP
Interference

Select the enable check box to have controllers consider the traffic bandwidth used by each access point
when assigning channels to access points. Unselect this check box to have RRM ignore this value. In
certain circumstances and with denser deployments, there might not be enough channels to properly create
perfect channel reuse. In these circumstances, RRM can assign better reuse patterns to those access points
that carry more traffic load.

Avoid Cisco AP Load

Field Reference for Configuration Pages
15

Field Reference for Configuration Pages
Controller > 80211a or n or ac > dot11a-RRM > DCA



DescriptionField

Select the enable check box to have access points avoid channels that have interference from nonaccess
point sources, such as microwave ovens or Bluetooth devices. Unselect this check box to have RRM
ignore this interference. In certain circumstances with significant interference energy (dB) from non-802.11
noise sources, RRMmight adjust the channel assignment to avoid these channels (and sometimes adjacent
channels) in access points close to the noise sources. This adjustment increases capacity and reduces
variability for the Cisco WLAN Solution.

Avoid non 802.11 Noise

Always enabled (not configurable). Signal Strength Contribution constantly monitors the relative location
of all access points within the RF/mobility domain to ensure near-optimal channel reuse. The net effect
is an increase in Cisco WLAN Solution capacity and a reduction in co-channel and adjacent channel
interference.

Signal Strength
Contribution

Select the enable check box to disable spectrum event-driven RRM. By default, Event Driven RRM is
enabled. Event Driven RRM is used when a CleanAir-enabled access point detects a significant level of
interference.

Event Driven RRM

If Event Driven RRM is enabled, this field displays the threshold level at which event-driven RRM is
triggered. It can have a value of either Low, Medium, or High. When the interference for the access point
rises above the threshold level, RRM initiates a local Dynamic Channel Assignment (DCA) run and
changes the channel of the affected access point radio if possible to improve network performance. Low
represents a decreased sensitivity to changes in the environment while High represents an increased
sensitivity.

Sensitivity Threshold

Controller > 80211a or n or ac > dot11a-RRM > Intervals

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Controller > 80211a or n or ac > dot11a-RRM > Intervals.

Table 16: Controller > 80211a or n or ac > dot11a-RRM > Intervals

DescriptionField

Enter the interval at which you want strength measurements taken for each access point. The default
is 300 seconds.

Neighbor Packet Frequency

Enter the interval at which you want noise and interference measurements taken for each access
point. The default is 300 seconds.

Channel Scan Duration

Enter the interval at which you want load measurements taken for each access point. The default
is 300 seconds.

This parameter cannot be applied to Cisco WLC Release 4.3 or later.Note

Load Measurement Interval

Enter the interval at which you want coverage measurements taken for each access point. The
default is 300 seconds.

This parameter cannot be applied to Cisco WLC Release 4.3 or later.Note

CoverageMeasurement Interval

Field Reference for Configuration Pages
16

Field Reference for Configuration Pages
Controller > 80211a or n or ac > dot11a-RRM > Intervals



Controller > 80211a or n or ac > dot11a-RRM > TPC

The controller dynamically controls access point transmit power based on real-time wireless LAN conditions.
Normally, power can be kept low to gain extra capacity and reduce interference. The controller attempts to
balance the transmit power of the access points according to how the access points are seen by their third
strongest neighbor.

The transmit power control (TPC) algorithm both increases and decreases the power of an access point in
response to changes in the RF environment. In most instances, TPC seeks to lower the power of an access
point to reduce interference, but in the case of a sudden change in the RF coverage—for example, if an access
point fails or becomes disabled—TPC can also increase power on surrounding access points. This feature is
different from Coverage Hole Detection. Coverage Hole Detection is primarily concerned with clients, while
TPC is tasked with providing enough RF power to achieve desired coverage levels while avoiding channel
interference between access points.

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Controller > 80211a or n or ac > dot11a-RRM > TPC.

Table 17: Controller > 80211a or n or ac > dot11a-RRM > TPC

DescriptionField

Choose TPCv1 or TPCv2 from the drop-down list.

The TPCv2 option is applicable only for controller Version 7.2.x or later.Note

TPC Version

From the Dynamic Assignment drop-down list, choose one of three modes:

• Automatic—The transmit power is periodically updated for all access points that permit this
operation.

• On Demand—Transmit power is updated when you click Assign Now.

• Disabled—No dynamic transmit power assignments occur, and values are set to their global
default.

Dynamic Assignment

Indicates the maximum power assigned. Range: -10 to 30 dB. Default: 30 dB.Maximum Power Assignment

Indicates the minimum power assigned. Range: -10 to 30 dB. Default: 30 dB.Minimum Power Assignment

Click the check box if you want to enable Dynamic Transmission Power Control.Dynamic Tx Power Control

Enter a transmitted power threshold from -50 to -80.Transmitted Power Threshold

Shows the transmitted power control interval in seconds (read-only).Control Interval

Controller > 80211a or n or ac > dot11a-RRM > Thresholds

Use this option to create or modify a template for setting various RRM thresholds such as load, interference,
noise, and coverage.

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Controller > 80211a or n or ac > dot11a-RRM > Thresholds.
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You must disable the 802.11a/n/ac network before applying these RRM threshold values.Note

Table 18: Controller > 80211a or n or ac > dot11a-RRM > Thresholds

DescriptionField

Enter the minimum number of failed clients currently associated with the controller.Min Failed Clients

Enter the target range of coverage threshold (dB).Coverage Level

When the Coverage Level field is adjusted, the value of the Signal Strength (dBm) automatically
reflects this change. The Signal Strength field provides information regarding what the signal
strength is when adjusting the coverage level.

Signal Strength

Enter the Data RSSI (–60 to –90 dBm). This number indicates the value for theminimumReceived
Signal Strength Indicator (RSSI) for data required for the client to associate to an access point.

Data RSSI

Enter the Voice RSSI (–60 to –90 dBM). This number indicates the value for the minimum
Received Signal Strength Indicator (RSSI) required for voice for the client to associate to an
access point.

Voice RSSI

Enter the maximum number of clients able to be associated with the controller.Max. Clients

Enter the percentage of threshold for this radio type.RF Utilization

Enter an interference threshold from 0 to 100 percent.Interference Threshold

Enter a noise threshold from -127 to 0 dBm. When the controller is outside of this threshold, it
sends an alarm to Prime Infrastructure.

Noise Threshold

Enter the coverage exception level percentage.When the coverage drops by this percentage from
the configured coverage for the minimum number of clients, a coverage hole is generated.

Coverage Exception Level Per AP

Controller > 80211a or n or ac > 802.11h

802.11h informs client devices about channel changes and can limit the transmit power of the client device.
Create or modify a template for configuration 802.11h parameters (such as power constraint and channel
controller announcement) and applying these settings to multiple controllers.

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Controller > 80211a or n or ac > 802.11h.

Table 19: Controller > 80211a or n or ac > 802.11h

DescriptionField

Select the Power Constraint check box if you want the access point to stop transmission on the current
channel.

Power Constraint
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DescriptionField

Select the Channel Announcement check box to enable channel announcement. Channel announcement
is a method in which the access point announces when it is switching to a new channel and the new channel
number.

ChannelAnnouncement

Controller > 80211a or n or ac > CleanAir

Use this option to create or modify a template for configuring CleanAir parameters for the 802.11a/n/ac radio.
You can configure the template to enable or disable CleanAir. You can also configure the type of interfering
devices to include for reporting and alarms.

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Controller > 80211a or n or ac > CleanAir.

Table 20: Controller > 80211a or n or ac > CleanAir

DescriptionField

Select the Report interferers check box to enable the CleanAir system to report and detect
sources of interference, or unselect it to prevent the controller from reporting interferers. The
default value is unselected.

Report Interferers

Make sure that any sources of interference that need to be detected and reported by the CleanAir
system appear in the Interferences to Detect box and any that do not need to be detected appear
in the Interferers to Ignore box. Use the > and < buttons to move interference sources between
these two boxes. By default, all interference sources are ignored.

Interferers Ignored/Selected for
Reporting

Select the Persistent Device Propagation check box to enable propagation of information about
persistent devices that can be detected by CleanAir. Persistent device propagation enables
designating information about interference types and propagating this information to the
neighboring access points. Persistent interferers are present at the location and interfere with the
WLAN operations even if they are not detectable at all times.

Persistent Device Propagation

Select theAir Quality Alarm check box to enable the triggering of air quality alarms, or unselect
the box to disable this feature.

Air Quality Alarm

If you selected the Air Quality Alarm check box, enter a value from 1 to 100 in the Air Quality
Alarm Threshold field to specify the threshold at which you want the air quality alarm to be
triggered. When the air quality falls below the threshold level, the alarm is triggered. A value of
1 represents the worst air quality, and 100 represents the best. The default value is 1.

Air Quality Alarm Threshold

Select the Air Quality Unclassified Category Alarm check box to enable the alarms to be
generated for unclassified interference category. CleanAir can detect and monitor unclassified
interferences. Unclassified interference are interference that are detected but do not correspond
to any of the known interference types.

Air QualityUnclassifiedCategory
Alarm

If you selected the Air Quality Unclassified Category Alarm check box, enter a value from 1
to 99 in the Air Quality Unclassified Category Severity Threshold text box to specify the threshold
at which you want the unclassified category alarm to be triggered. The default is 20.

Air QualityUnclassifiedCategory
Severity Threshold
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DescriptionField

Select the Interferers For Security Alarm check box to trigger interferer alarms when the
controller detects specified device types, or unselect it to disable this feature. The default value
is unselected.

Interferers For Security Alarm

Make sure that any sources of interference that need to trigger interferer alarms appear under
Interferers Selected for Security Alarms and any that do not need to trigger interferer alarms
appear in the Interferers Ignored for Security Alarms. Use the > and < buttons to move
interference sources between these two boxes. By default, all interferer sources for security alarms
are ignored.

Interferers Ignored/Selected for
Security Alarms

Controller > 80211a or n or ac > EDCA Parameters

Enhanced distributed channel access (EDCA) parameters are designed to provide preferential wireless channel
access for voice, video, and other quality of service (QoS) traffic.

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Controller > 80211a or n or ac > EDCA Parameters.

Table 21: Controller > 80211a or n > EDCA Parameters

DescriptionField

Choose one of the following options from the EDCA Profile drop-down list:

• WMM—Enables the Wi-Fi Multimedia (WMM) default parameters. This is the default value. Choose
this option when voice or video services are not deployed on your network.

• Spectralink Voice Priority—Enables Spectralink voice priority parameters. Choose this option if
Spectralink phones are deployed on your network to improve the quality of calls.

• Voice Optimized—Enables EDCA voice-optimized profile parameters. Choose this option when voice
services other than Spectralink are deployed on your network.

• Voice & Video Optimized—Enables EDCA voice- and video-optimized profile parameters. Choose this
option when both voice and video services are deployed on your network.

Video services must be deployed with admission control (ACM). Video services without ACM are
not supported.

Note

You must shut down the radio interface before configuring EDCA parameters.Note

EDCA Profile

Enable low latency MAC only if all clients on the network are WMM compliant.Low LatencyMAC

Controller > 80211a or n or ac > High Throughput (802.11n)

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Controller > 80211a or n or ac > High Throughput (802.11n).
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Table 22: Controller > 80211a or n or ac > High Throughput (802.11n)

DescriptionField

Select the 802.11n Network Status Enabled check box to enable high throughput.802.11n Network Status Enabled

Choose which level of data rate you want supported. Modulation coding schemes (MCS) are
similar to 802.11a data rate. The defaults are 20MHz and short guarded interval. When you select
the Supported check box next to a numbered Data Rate, the chosen numbers appear in the Selected
MCS Indexes field at the bottom of the column.

Selected MCS Indexes

Controller > 80211a or n or ac > Media Parameters > General

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Controller > 80211a or n or ac > Media Parameters > General.

Table 23: Controller > 80211a or n or ac > Media Parameters > General

DescriptionField

Specify the percentage of maximum bandwidth allowed. This option is only available
when CAC is enabled.

MaximumMedia Bandwidth (0 to 85%)

Controller > 80211a or n or ac > Media Parameters > Video

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Controller > 80211a or n or ac > Media Parameters > Video.

Table 24: Controller > 80211a or n or ac > Media Parameters > Video

DescriptionField

Select the check box to enable admission control.Admission Control (ACM)

Specify the percentage of maximum bandwidth allowed. This option is only available when
CAC is enabled.

Maximum Bandwidth Allowed

Specify the percentage of reserved roaming bandwidth. This option is only available when
CAC is enabled.

Reserved Roaming Bandwidth

If Admission Control (ACM) is enabled, specify the CAC method as either load-based or
static. Load-based CAC incorporates a measurement scheme that takes into account the
bandwidth consumed by all traffic types from itself, from co-channel access points, and by
co-located channel interference. Load-based CAC also covers the additional bandwidth
consumption resulting from PHY and channel impairment.

CAC Method

Select the Unicast Video Redirect check box to enable all nonmedia stream packets in
video queue are redirected to the best effort queue. If disabled, all packets with video
marking are kept in video queue.

Unicast Video Redirect

Specify the physical data rate required for the client to join a media stream from the Client
Minimum Phy Rate drop-down list.

Client Minimum Phy Rate
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DescriptionField

Select theMulticast Direct Enable check box to set the Media Direct for anyWLANwith
Media Direct enabled on a WLAN on this radio.

Multicast Direct Enable

Specify the maximum number of streams per Radio to be allowed.Maximum Number of Streams per
Radio

Specify the maximum number of streams per Client to be allowed.Maximum Number of Streams per
Client

Select the Best Effort QOS Admission check box to redirect new client requests to the
best effort queue. This happens only if all the video bandwidth has been used. If this is
disabled and maximum video bandwidth has been used, then any new client request is
rejected.

Best Effort QOS Admission

Controller > 80211a or n or ac > Media Parameters > Voice

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Controller > 80211a or n or ac> Media Parameters > Voice.

Table 25: Controller > 80211a or n or ac > Media Parameters > Voice

DescriptionField

Select the check box to enable admission control. For end users to experience acceptable audio
quality during a VoIP phone call, packets must be delivered from one endpoint to another with low
latency and low packet loss. To maintain QoS under differing network loads, call admission control
(CAC) is required. CAC on an access point allows it to maintain controlled QoS when the network
is experiencing congestion and keep the maximum allowed number of calls to an acceptable quantity.

Admission Control (ACM)

If Admission Control (ACM) is enabled, specify the CAC method as either load-based or static.
Load-based CAC incorporates ameasurement scheme that takes into account the bandwidth consumed
by all traffic types from itself, from co-channel access points, and by co-located channel interference.
Load-based CAC also covers the additional bandwidth consumption resulting from PHY and channel
impairment.

CAC Method

Specify the percentage of maximum bandwidth allowed. This option is only available when CAC is
enabled.

Maximum Bandwidth
Allowed

Specify the percentage of reserved roaming bandwidth. This option is only available when CAC is
enabled.

ReservedRoamingBandwidth

Select the check box to enable expedited bandwidth as an extension of CAC for emergency calls.
You must have an expedited bandwidth IE that is CCXv5 compliant so that a TSPEC request is given
higher priority.

Expedited Bandwidth

Select the check box to enable SIP CAC. SIP CAC should be used only for phones that support status
code 17 and do not support TSPEC-based admission control.

SIP CAC

Specify the codec name you want to use on this radio. The available options are G.711, G.729, and
User Defined.

SIP Codec
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DescriptionField

Specify the bandwidth in kilobits per second that you want to assign per SIP call on the network.
This field can be configured only when the SIP Codec selected is User Defined.

SIP Call Bandwidth

Specify the sample interval in milliseconds that the codec must operate in.SIP Sample Interval

Select the check box to enable metric collection. Traffic streammetrics are a series of statistics about
VoIP over your wireless LAN that inform you of the QoS of the wireless LAN. For the access point
to collect measurement values, traffic stream metrics must be enabled. When this is enabled, the
controller begins collecting statistical data every 90 seconds for the 802.11b/g interfaces from all
associated access points. If you are using VoIP or video, this feature should be enabled.

Metric Collection

Controller > 80211a or n or ac > Parameters

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Controller > 80211a or n or ac > Parameters.

Table 26: Controller > 80211a or n or ac > Parameters

DescriptionField

Select the check box to enable 802.11a/n network status.802.11a Network Status

Use this drop-down list to enable Clientlink on all access point 802.11a/n radios that support ClientLink.
Otherwise, choose Disable.

Client Link

Enter the amount of time between beacons in milliseconds. The valid range is from 20 to 1000milliseconds.Beacon Period

Enter the number of beacon intervals that might elapse between transmission of beacon frames containing
a traffic indicator message (TIM) element whose delivery count text box is 0. This value is transmitted
in the DTIM period field of beacon frames. When client devices receive a beacon that contains a DTIM,
they normally wake up to check for pending packets. Longer intervals between DTIMS let clients sleep
longer and preserve power. Conversely, shorter DTIM periods reduce the delay in receiving packets but
use more battery power because clients wake up more often.

DTIM Period

Determine the size at which packets are fragmented (sent as several pieces instead of as one block). Use
a low setting in areas where communication is poor or where there is a great deal of radio interference.

Fragmentation Threshold

Enter the percentage for 802.11e maximum bandwidth.802.11e Max Bandwidth

Select the check box to enable Cisco Compatible Extension (CCX) LocationMeasurement.When enabled,
this enhances the location accuracy of clients.

Mode

Enter the interval at which CCX Location Measurement signals are broadcast, in seconds. The CCX
locationmeasurement interval of the Cisco Compatible Extension can only be changed whenmeasurement
mode is enabled.

Interval
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DescriptionField

Select the negotiation type for each data rate. The client and controller negotiate data rates between them.
If the data rate is set to Mandatory, the client must support it to use the network. If a data rate is set as
Supported by the controller, any associated client that also supports that same rate might communicate
with the access point using that rate. However, it is not required that a client uses all the rates marked
supported to associate. For each rate, a drop-down list of Mandatory or Supported is available. Each data
rate can also be set to Disable to match client settings.

Data Rate Dropdowns

From this drop-down list in the Noise/Interference/Rogue Monitoring Channels section, choose either all
channels, country channels, or DCA channels based on the level of monitoring you want. Dynamic Channel
Allocation (DCA) automatically selects a reasonably good channel allocation amongst a set of managed
devices connected to the controller.

Channel List

Controller > 80211a or n or ac > Roaming Parameters

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Controller > 80211a or n or ac > Roaming Parameters.

Table 27: Controller > 80211a or n or ac > Roaming Parameters

DescriptionField

Use the Mode drop-down list to choose one of the configurable modes: Default values or Custom values. If
you select Default, the roaming parameters are unavailable for editing and have the default values displayed
in the text boxes. Select Custom to edit the roaming parameters.

Mode

Enter a value for the minimum Received Signal Strength Indicator (RSSI) required for the client to associate
to an access point. If the average received signal power of the client dips below this threshold, reliable
communication is usually impossible. Therefore, clients must already have found and roamed to another
access point with a stronger signal before the minimumRSSI value is reached. Range: -80 to -90 dBm. Default:
-85 dBm.

Minimum RSSI

Enter a value to indicate how strong the signal strength of a neighboring access point must be for the client
to roam to it. This field is intended to reduce the amount of ping-ponging between access points if the client
is physically located on or near the border between two access points. Range: 2 to 4 dB. Default: 2 dB.

Roaming Hysteresis

Enter the RSSI value from the associated access point of the client, below which the client must be able to
roam to a neighboring access point within the specified transition time. This field also provides a power-save
method to minimize the time that the client spends in active or passive scanning. For example, the client can
scan slowly when the RSSI is above the threshold and scan more rapidly when below the threshold. Range:
-70 to -77 dB. Default: -72 dB.

The Scan Threshold and Transition Time parameters guarantee a minimum level of client roaming
performance. Together with highest expected client speed and RoamingHysteresis, these parameters
make it possible to design a wireless LAN network that supports roaming simply by ensuring a
certain minimum overlap distance between access points.

Note

Adaptive Scan
Threshold
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DescriptionField

Enter the maximum time allowed for the client to detect a suitable neighboring access point to roam to and
to complete the roam, whenever the RSSI from the associated access point of the client is below the scan
threshold. Range: 1 to 10 seconds. Default: 5 seconds.

The Scan Threshold and Transition Time parameters guarantee a minimum level of client roaming
performance. Together with highest expected client speed and RoamingHysteresis, these parameters
make it possible to design a wireless LAN network that supports roaming simply by ensuring a
certain minimum overlap distance between access points.

Note

Transition Time

Controller > 80211b or g or n
The following topics contain field descriptions for pages found in Configuration > Templates > Features
and Technologies > Controller > 80211b or g or n.

• Controller >802.11b or g or n > dot11b-RRM > DCA

• Controller > 802.11b or g or n > dot11b-RRM > Intervals

• Controller > 802.11b or g or n > dot11b-RRM > Thresholds

• Controller > 802.11b or g or n > dot11b-RRM > TPC

• Controller > 80211a or n or ac > CleanAir

• Controller > 802.11b or g or n > EDCA Parameters

• Controller > 802.11b or g or n > High Throughput (802.11n), on page 26

• Controller > 802.11b or g or n > Media Parameters

• Controller > 802.11b or g or n > Parameters

• Controller > 802.11b or g or n > Roaming Parameters

Controller >802.11b or g or n > dot11b-RRM > DCA

For a description of the fields on Configuration > Templates > Features and Technologies > Controller
> 802.11b or g or n > dot11b-RRM > DCA, see Controller > 80211a or n or ac > dot11a-RRM > DCA

Controller > 802.11b or g or n > dot11b-RRM > Intervals

For a description of the fields on Configuration > Templates > Features and Technologies > Controller
> 802.11b or g or n > dot11b-RRM> Intervals, see Controller > 80211a or n or ac > dot11a-RRM> Intervals

Controller > 802.11b or g or n > dot11b-RRM > TPC

For a description of the fields on Configuration > Templates > Features and Technologies > Controller
> 802.11b or g or n > dot11b-RRM > TPC, see Controller > 80211a or n or ac > dot11a-RRM > TPC.

Controller > 802.11b or g or n > dot11b-RRM > Thresholds

For a description of the fields on Configuration > Templates > Features and Technologies > Controller
> 802.11b or g or n > dot11b-RRM > Thresholds, see Controller > 80211a or n or ac > dot11a-RRM >
Thresholds
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Controller > 802.11b or g or n > CleanAir

For a description of the fields on Configuration > Templates > Features and Technologies > Controller
> 802.11b or g or n > CleanAir, see Controller > 80211a or n or ac > CleanAir.

Controller > 802.11b or g or n > EDCA Parameters

Use this option to create or modify a template for configuring 802.11b/g/n EDCAparameters. EDCAparameters
designate preconfigured profiles at the MAC layer for voice and video.

The following table describes the Template Detail fields in Configuration > Templates > Features and
Technologies > Controller > 802.11b or g or n > EDCA Parameters.

Table 28: Controller > 80211b or g or n > EDCA Parameters

DescriptionField

Profiles include Wi-Fi Multimedia (WMM), Spectralink Voice Priority (SVP), Voice Optimized, and Voice &
Video Optimized. WMM is the default EDCA profile.

You must shut down the radio interface before configuring EDCA Parameters.Note

DisablingWMM or changing the EDCA profile fromWMM on the device will disable the 11n rates
when the AP is rebooted.

Note

EDCA Profile

Enable this option only if DSCP marking is correct for media (RTP) and signaling packets.LowLatencyMAC

Controller > 802.11b or g or n > High Throughput (802.11n)

Use this option to create or modify a template for configuring high-throughput parameters such as MCS (data
rate) settings and indexes and for applying these 802.11n settings to multiple controllers.

The following table describes the Template Detail fields in Configuration > Templates > Features and
Technologies > Controller > 802.11b or g or n > High Throughput(802.11n).

Table 29: Controller > 80211b or g or n > High Throughput(802.11n)

DescriptionField

Select the check box to enable high throughput.802.11n Network Status

Choose which level of data rate you want supported. MCS is modulation coding schemes that are similar
to 802.11a data rate. The values 20MHz and short guarded interval are used as defaults. When you select
the Supported check box, the chosen numbers appear in the Selected MCS Indexes page.

MCS (Data Rate) Settings

Controller > 802.11b or g or n > Media Parameters

Use this option to create or modify a template for configuring 802.11b/g/n voice parameters such as Call
Admission Control and traffic stream metrics.

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Controller > 802.11b or g or n > Media Parameters.
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Table 30: Controller > 80211b or g or n > Media Parameters

DescriptionField

General

Specify the percentage maximum of bandwidth allowed. This option is only available when
CAC is enabled.

Maximum Media Bandwidth (0 to
85%)

Video

Select the check box to enable admission control.Admission Control (ACM)

Specify the percentage of maximum bandwidth allowed. This option is only available when
CAC is enabled.

Maximum Bandwidth

Specify the percentage of reserved roaming bandwidth. This option is only available when
CAC is enabled.

Reserved Roaming Bandwidth

Select the Unicast Video Redirect check box to enable all nonmedia stream packets in the
video queue to be redirected to the best effort queue. If disabled, all packets with videomarking
are kept in video queue.

Unicast Video Redirect

Choose the physical data rate required for the client to join a media stream from the Client
Minimum Phy Rate drop-down list.

Client Minimum Phy Rate

Select theMulticast Direct Enable check box to set the Media Direct for any WLAN with
Media Direct enabled on a WLAN on this radio.

Multicast Direct Enable

Specify the maximum number of streams per radio to be allowed.Maximum Number of Streams per
Radio

Specify the maximum number of streams per client to be allowed.Maximum Number of Streams per
Client

Select the Best Effort QOS Admission check box to redirect new client requests to the best
effort queue. This happens only if all the video bandwidth has been used. If disabled and
maximum video bandwidth has been used, then any new client request is rejected.

Best Effort QOS Admission

Voice

Select the check box to enable admission control. For end users to experience acceptable
audio quality during a VoIP phone call, packets must be delivered from one endpoint to another
with low latency and low packet loss. To maintain QoS under differing network loads, Call
Admission Control (CAC) is required. CAC on an access maintains a controlled QoS when
the network is experiencing congestion and keep the maximum allowed number of calls to
an acceptable quantity.

Admission Control (ACM)

If Admission Control (ACM) is enabled, specify the CAC method as either load-based or
static. Load-based CAC incorporates a measurement scheme that takes into account the
bandwidth consumed by all traffic types from itself, from co-channel access points, and by
co-located channel interference. Load-based CAC also covers the additional bandwidth
consumption resulting from PHY and channel impairment.

CAC Method
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DescriptionField

Enter the percentage of maximum bandwidth allowed. This option is only available when
CAC is enabled.

Maximum Bandwidth Allowed

Enter the percentage of reserved roaming bandwidth. This option is only available when CAC
is enabled.

Reserved Roaming Bandwidth

Select the check box to enable expedited bandwidth as an extension of CAC for emergency
calls. You must have an expedited bandwidth IE that is CCXv5 compliant so that a TSPEC
request is given higher priority.

Expedited Bandwidth

Select the check box to enable SIP CAC. SIP CAC should be used only for phones that support
status code 17 and do not support TSPEC-based admission control.

SIP CAC

Choose the codec name you want to use on this radio from the SIP Codec drop-down list.
The available options are G.711, G.729, and User Defined.

SIP Codec

Enter the bandwidth in kilobits per second that you want to assign per SIP call on the network.
This field can be configured only when the SIP Codec selected is User Defined.

SIP Call Bandwidth

Enter the sample interval in milliseconds that the codec must operate in.SIP Sample Interval

Enter the maximum number of calls per radio.Max Number of Calls per Radio

Select the check box to enable metric collection. Traffic streammetrics are a series of statistics
about VoIP over your wireless LAN that inform you of the QoS of the wireless LAN. For the
access point to collect measurement values, traffic stream metrics must be enabled. When
this is enabled, the controller begins collecting statistical data every 90 seconds for the
802.11b/g interfaces from all associated access points. If you are using VoIP or video, this
feature should be enabled.

Metric Collection

Controller > 802.11b or g or n > Parameters

Use this option to create or modify a template for configuring 802.11b/g/n parameters (such as power and
channel status, data rates, channel list, and CCX location measurement) and/or applying these settings to
controller(s).

The following table describes the Template Detail fields in Configuration > Templates > Features and
Technologies > Controller > 802.11b or g or n > Parameters.

Table 31: Controller > 802.11b or g or n > Parameters

DescriptionField

Enter the name of the security policy in force.Policy Name

Choose Enable or Disable from the drop-down list. Beam forming refers to a general signal processing
technique used to control the directionality of the reception or transmission of a signal.

Beam Forming

Enter the transmitted power threshold. The valid range is from -50 to -80.Transmitted Power
Threshold
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DescriptionField

The rate at which the SSID is broadcast by the access point (the amount of time between beacons). The
valid range is from 100 to 600 milliseconds.

Beacon Period

The number of beacon intervals that might elapse between transmission of beacon frames containing a
traffic indicator message (TIM) element whose delivery count field is 0. This value is transmitted in the
DTIM period field of beacon frames. When client devices receive a beacon that contains a DTIM, they
normally “wake up” to check for pending packets. Longer intervals between DTIMs let clients sleep
longer and preserve power. Conversely, shorter DTIM periods reduce the delay in receiving packets but
use more battery power because clients wake up more often.

The DTIM period is not applicable in controller Version 5.0.0.0 and later.

DTIM Period

Determine the size at which packets are fragmented (sent as several pieces instead of as one block). Use
a low setting in areas where communication is poor or where there is a great deal of radio interference.
The default value is 2346.

Fragmentation Threshold

Percentage for 802.11e max bandwidth. The default value is 100.802.11e Max Bandwidth

From the Dynamic Assignment drop-down list, choose any one of the following dynamic transmit power
assignment modes:

• Automatic—The transmit power is periodically updated for all access points that permit this operation.

• On Demand—Transmit power is updated when you click Assign Now.

• Disabled—No dynamic transmit power assignments occur and values are set to their global default.

The default is Automatic. The power levels and available channels are defined by the country code setting
and are regulated on a country by country basis.

Dynamic Assignment

Select this check box to enable DTPC support. If this option is enabled, the transmit power level of the
radio is advertised in the beacons and the probe responses.

Dynamic Tx Power
Control

From the AssignmentMode drop-down list, choose any one of the following dynamic channel assignment
modes:

• Automatic—The channel assignment is periodically updated for all access points that permit this
operation.

• On Demand—Channel assignments are updated when desired.

• Disabled—No dynamic channel assignments occur and values are set to their global default.

The default is Automatic.

Assignment Mode

Enable this Radio Resource Management (RRM) foreign 802.11 interference-monitoring field to have
Radio Resource Management consider interference from foreign (non-Cisco access points outside the
RF/mobility domain) access points when assigning channels to Cisco access points. Disable this field to
have Radio Resource Management ignore this interference.

In certain circumstances with significant interference energy (dB) and load (utilization) from Foreign
access points, Radio ResourceManagement might adjust the channel assignment to avoid these channels
(and sometimes adjacent channels) in Cisco access points close to the Foreign access points to increase
capacity and reduce variability for the Cisco WLAN Solution.

Avoid Foreign AP
Interference
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DescriptionField

Enable this Radio Resource Management (RRM) bandwidth-sensing field to have controllers consider
the traffic bandwidth used by each access point when assigning channels to access points. Disable this
field to have Radio Resource Management ignore this value.

In certain circumstances and with denser deployments, there might not be enough channels to properly
create perfect channel reuse. In these circumstances, Radio Resource Management can assign better
reuse patterns to those APs that carry more traffic load.

Avoid Cisco AP Load

Enable this Radio Resource Management (RRM) noise-monitoring field to have access points avoid
channels that have interference from non-Access Point sources, such as microwave ovens or Bluetooth
devices. Disable this field to have Radio Resource Management ignore this interference.

In certain circumstances with significant interference energy (dB) from non-802.11 noise sources, Radio
Resource Management might adjust the channel assignment to avoid these channels (and sometimes
adjacent channels) in access points close to the noise sources to increase capacity and reduce variability
for the Cisco WLAN Solution.

Avoid non 802.11 Noise

This check box is always enabled (not configurable). Radio Resource Management (RRM) constantly
monitors the relative location of all access points within the RF/mobility domain to ensure near-optimal
channel reuse. The net effect is an increase in CiscoWLANSolution capacity and a reduction in co-channel
and adjacent channel interference.

Signal Strength
Contribution

The data rates set are negotiated between the client and the controller. If the data rate is set to Mandatory,
the client must support it to use the network. If a data rate is set as Supported by the controller, any
associated client that also supports that same rate might communicate with the access point using that
rate. But it is not required that a client be able to use all the rates marked Supported to associate 6, 9, 12,
18, 24, 36, 48, and 54 Mbps.

For each rate, a drop-down list selection of Mandatory or Supported is available. Each data rate can also
be set to Disabled to match client settings.

Data Rates

Choose between all channels, country channels, or DCA channels based on the level of monitoring you
want. Dynamic Channel Allocation (DCA) automatically selects a reasonably good channel allocation
among a set of managed devices connected to the controller.

Channel List

Enable or disable the broadcast radio measurement request. When enabled, this parameter enhances the
location accuracy of clients.

Mode

Interval in seconds between measurement requests.

The Cisco Compatible Extension locationmeasurement interval can be changed only whenmeasurement
mode is enabled.

Interval

Controller > 802.11b or g or n > Roaming Parameters

The following table describes the Template Detail fields in Configuration > Templates > Features and
Technologies > Controller > 802.11b or g or n > Roaming Parameters.
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Table 32: Controller > 802.11b or g or n > Roaming Parameters

DescriptionField

Choose Default Values or Custom Values from the drop-down list. If you select Default Values, the roaming
parameters are unavailable and the default values are displayed.

Mode

Enter a value for the minimum Received Signal Strength Indicator (RSSI) required for the client to associate
to an access point. If the client average received signal power dips below this threshold, reliable communication
is usually impossible. Therefore, clients must already have found and roamed to another access point with a
stronger signal before the minimum RSSI value is reached. Range: -80 to -90 dBm. Default: -85 dBm.

Minimum RSSI

Enter a value to indicate how strong the signal strength of a neighboring access point must be in order for the
client to roam to it. This field is intended to reduce the amount of ping ponging between access points if the
client is physically located on or near the border between two access points. Range: 2 to 4 dB. Default: 2 dB.

Roaming Hysteresis

Enter the RSSI value, from a client associated access point, below which the client must be able to roam to
a neighboring access point within the specified transition time. This field also provides a power-save method
to minimize the time that the client spends in active or passive scanning. For example, the client can scan
slowly when the RSSI is above the threshold and scan more rapidly when below the threshold. Range: -70
to -77 dB. Default: -72 dB.

The Scan Threshold and Transition Time parameters guarantee a minimum level of client roaming
performance. Together with the highest expected client speed and roaming hysteresis, these
parameters make it possible to design a wireless LAN network that supports roaming simply by
ensuring a certain minimum overlap distance between access points.

Note

Adaptive Scan
Threshold

Enter the maximum time allowed for the client to detect a suitable neighboring access point to roam to and
to complete the roam whenever the RSSI from the client associated access point is below the scan threshold.
Range: 1 to 10 seconds. Default: 5 seconds.

The Scan Threshold and Transition Time parameters guarantee a minimum level of client roaming
performance. Together with the highest expected client speed and roaming hysteresis, these
parameters make it possible to design a wireless LAN network that supports roaming simply by
ensuring a certain minimum overlap distance between access points.

Note

Transition Time

Controller > CLI > General
Use this option to create templates containing a set of CLI commands and apply them to one or more controllers
from Prime Infrastructure. These templates are meant for provisioning features in multiple controllers for
which there is no SNMP support or custom Prime Infrastructure user interface. The template contents are
simply a command array of strings. No support for substitution variables, conditionals, and the like exist.

The CLI sessions to the device are established based on user preferences. The default protocol is SSH.

If the Controller Telnet credentials check fails or the Controller CLI template fails with an invalid username
and password even though the correct username and password are configured on the controller, check whether
the controller has exceeded the number of CLI connections it can accept. If the connections have exceeded
the maximum limit, then either increase the maximum allowed CLI sessions or terminate any preexisting CLI
sessions on the controller, and then retry the operation.

Note
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The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Controller > CLI > General.

Table 33: Controller > CLI > General

DescriptionField

Enter the series of CLI commands.Commands

Select the Refresh Config after Apply check box to perform a refresh config on
the controller after the CLI template is applied successfully.

Refresh Config after Apply

Select the Save Config to Flash after apply check box to save the configuration.Save Config to Flash after apply

Select the Reboot Controller after apply check box to reboot the controller.Reboot Controller after apply

Select the Ignore errors onApply Template to Controllers to ignore all the errors
while applying the template.

Ignore errors on Apply Template to Controllers

Controller > FlexConnect > FlexConnect AP Groups
The following table describes the Template Detail fields in Configuration > Templates > Features and
Technologies > Controller > FlexConnect > FlexConnect AP Groups.

Table 34: Controller > FlexConnect > FlexConnect AP Groups

DescriptionField

General

The primary RADIUS authentication servers for this AP group. If a RADIUS authentication
server is not present on the controller, Prime Infrastructure configured RADIUS server does not
apply.

Primary RADIUS

Enter the port number. of the primary RADIUS server.Port Number

Enter the shared secret in the text box.Shared Secret

Re-enter the shared secret.Confirm Shared Secret

The secondary RADIUS authentication servers for this AP group. If a RADIUS authentication
server is not present on the controller, Prime Infrastructure configured RADIUS server does not
apply.

Secondary RADIUS

An access point Ethernet MAC address cannot exist in more than one FlexConnect group on the
same controller. If more than one group is applied to the same controller, select the Ethernet
MAC check box to unselect an access point from one of the groups. You can save this change
or apply it to controllers.

FlexConnect AP

Enables local authentication for a FlexConnect group.

Make sure that the Primary RADIUS Server and Secondary RADIUS Server fields
are set to None on the General tab.

Note

FlexConnect Configuration
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DescriptionField

Enables local authentication for this FlexConnect group. The default value is unselected.

When you attempt to use this feature, a warning message indicates that it is a licensed
feature.

Note

You can click the Users configured in the group link that appears at the bottom of
the page to view the list of FlexConnect users. You can create FlexConnect users only
after you save the FlexConnect AP Group.

Note

FlexConnect Local Authentication

Allows a FlexConnect access point to authenticate clients using LEAP.

To allow a FlexConnect access point to authenticate clients using EAP-FAST, select the
EAP-FAST check box. To use manual PAC provisioning, enter the key used to encrypt and
decrypt PACs in the EAP-FAST Key and Confirm EAP-FAST Key text boxes.

EAP Type

Allows PACs to be sent automatically to clients that do not have one during PAC provisioning.Auto Key Generation

The authority identifier of the EAP-FAST server. The identifier must be 32 hexadecimal
characters.

EAP-FAST Key

The authority identifier of the EAP-FAST server in text format. You can enter up to 32
hexadecimal characters.

EAP-FAST Authority ID

The authority information of the EAP-FAST server.EAP-FAST Authority Info

The number of seconds for the PAC to remain viable in the edit box. The valid range is 2 to
4095 seconds.

EAP-FAST Pac Timeout

Image Upgrade

Select to upgrade the FlexConnect access points.FlexConnect AP Upgrade

The maximum retries for the slave to undertake to start the download from the master in the
FlexConnect group. This option is available only if you select the FlexConnect AP Upgrade
check box.

You can add an access point as a master access point only if the FlexConnect AP
Upgrade check box is enabled on the General tab.

Note

Slave Maximum Retry Count

Use the edit table on this tab to add VLAN-ACL mappings.VLAN-ACL Mapping

The valid VLAN ID range is 1 to 4094.VLAN ID

Choose an Ingress ACL.Ingress ACL

Choose an Egress ACL.Egress ACL

Use the edit table on this tab to add WLAN-ACL mappings.WLAN-ACL Mapping

WLAN ID.WLAN ID

Choose a WLAN profile.WLAN Profile Name

Choose a WebAuth ACL.WebAuth ACL
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DescriptionField

Use the edit table on this tab to add or select Local-Split ACLs.Local Split

Choose a WLAN profile name from the list.WLAN Profile Name

Choose a local-split ACL.Local-Split ACL

Use the edit table on this tab to add or select Web Policy ACLs.Web Policies

Choose a Web Policy ACL. You can add up to a maximum of 16 Web-Policy ACLs.Web-Policy ACL

Use the edit table on this tab to add or select Central DHCP for each WLAN profile.Central DHCP

Choose a WLAN profile name from the list.WLAN Profile Name

Choose Enable to enable central DHCP for this profile.Central DHCP

Choose Enable to enable DNS override for this profile.Override DNS

Choose Enable to enable network address and port address translation for this profile.NAT-PAT

Controller > IPv6
The following topics contain field descriptions for pages found in Configuration > Templates > Features
and Technologies > Controller > IPv6.

• Controller > IPv6 > Neighbor Binding Timers

• Controller > IPv6 > RA Guard

• Controller > IPv6 > RA Throttle Policy

Controller > IPv6 > Neighbor Binding Timers

The following table describes the Template Detail fields in Configuration > Templates > Features and
Technologies > Controller > IPv6 > Neighbor Binding Timers.

Table 35: Controller > IPv6 > Neighbor Binding Timers

DescriptionField

This field enables the down lifetime. If you have selected this check box, specify the value in the Down
Lifetime Interval text box. This down lifetime interval indicates the maximum time, in seconds, an entry
learned from a down interface is kept in the binding table before the entry is deleted or proof is received
that the entry is reachable. The range is 0 to 86400 seconds, and the default value is 0.

Down Lifetime Interval

This field enables the reachable lifetime. If you have selected this check box, specify the value in the
Reachable Lifetime Interval text box. The reachable lifetime interval indicates the maximum time, in
seconds, an entry is considered reachable without getting a proof of reachability (direct reachability
through tracking, or indirect reachability through Neighbor Discovery protocol [NDP] inspection). After
that, the entry is moved to stale.The range is 0 to 86400 seconds, and the default value is 0.

Reachable Lifetime
Interval
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DescriptionField

This field enables the stale lifetime. If you have selected this check box, specify the value in the Stale
Lifetime Interval text box. The stale lifetime interval indicates the maximum time, in seconds, a stale
entry is kept in the binding table before the entry is deleted or proof is received that the entry is reachable.
The range is 0 to 86400 seconds, and the default value is 0.

Stale Lifetime Interval

Controller > IPv6 > RA Guard

RA Guard is a Unified Wireless solution used to drop RA from wireless clients. It is configured globally, and
by default it is enabled. You can create or modify a template for configuring IPv6 Router Advertisement
parameters.

Controller > IPv6 > RA Throttle Policy

Use this option to limit the amount of multicast Router Advertisements (RA) circulating on the wireless
network. You can create or modify a template for configuring IPv6 Router Advertisement parameters such
as RA Throttle Policy, Throttle Period, and other options.

The following table describes the Template Detail fields in Configuration > Templates > Features and
Technologies > Controller> IPv6 > RA Throttle Policy.

Table 36: Controller > IPv6 > RA Throttle Policy

DescriptionField

Enables the RA throttle policy.RAThrottle Policy

Duration of the throttle period in seconds. The range is 10 to 86400 seconds.Throttle Period

The number of RA that passes through over a period in seconds.Max Through

<<not present>>

Indicates the behavior in case of RA with an interval option.Interval Option

<<not present>>

Indicates the minimum number of RA not throttled per router.Allow At-least

<<not present>>

Indicates the maximum number of RA not throttled per router.Allow At-most

<<not present>>

Controller > Location
The following topics describe the fields on the Configuration > Templates > Features and Technologies
> Controller > Location page.

• Controller > Location > Global BLE Configuration

• Controller > Location > Location Configuration > General

• Controller > Location > Location Configuration > Advanced
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Controller > Location > Global BLE Configuration

The following table describes the fields on Configuration > Templates > Features and Technologies >
Controller > Location > Global BLE Configuration.

Table 37: Controller > Location > Global BLE Configuration

DescriptionField

Enter the BLE transmission interval in hertz (Hz).Beacon Interval

Fixed Beacon Ids. For CUWN devices, the fixed Beacon Id index are from 1 to 5 and for CUWN-IOS and UA
devices, the Beacon Id index are from 0 to 4.

Beacon Id

A unique identifier defined by the Beacon administrator.UUid

A calibrated indicator of the RSSI of the transmitted measured at a 1m distance.Tx Power
(dBM)

Beacon status: Enable or DisableBeacon Status

Controller > Location > Location Configuration > General

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Controller > Location > Location Configuration > General.

Table 38: Controller > Location > Location Configuration > General

DescriptionField

Select the check box to enable tag collection. Before the mobility services engine can collect asset
tag data from controllers, you must enable the detection of active RFID tags using the config rfid
status enable command on the controllers.

RFID Tag Data Collection

Select the check box to enable calibration for the client. Controllers send regular S36 or S60 requests
(depending on the client capability) by way of the access point to calibrating clients. Packets are
transmitted on all channels. All access points irrespective of channel (and without a channel change)
gather RSSI data from the client at each location. These additional transmissions and channel
changes might degrade contemporaneous voice or video traffic. To use all radios (802.11a/b/g/n)
available, you must enable multiband in the Advanced tab.

Calibrating Client

Select the check box to have a noncalibrating client. No S36 requests are transmitted to the client.
S36 and S60 are client drivers compatible with specific Cisco Compatible Extensions. S36 is
compatible with CCXv2 or later. S60 is compatible with CCXv4 or later. For details, see Cisco
Context Aware and Location FAQ.

Normal Client

Specify how many seconds should elapse before notification of the found tag, client, rogue AP, or
rogue client.

Tags, Clients and Rogue
APs/Clients

Enter the number of seconds after which RSSI measurements for clients should be discarded.For Clients

Enter the number of seconds after which RSSI measurements for calibrating clients should be
discarded.

For Calibrating Clients
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DescriptionField

Enter the number of seconds after which RSSI measurements for tags should be discarded.For Tags

Enter the number of seconds after which RSSI measurement for rogue access points should be
discarded.

For Rogue APs

Controller > Location > Location Configuration > Advanced

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Controller > Location > Location Configuration > Advanced.

Table 39: Controller > Location > Location Configuration > Advanced

DescriptionField

Enter a value in seconds to set the RFID tag data timeout.RFID Tag Data Timeout

Select the check box to send S36 and S60 packets (where applicable) on all channels. Calibrating
clients must be enabled on the General tab.

Calibrating Client Multiband

Controller > Management
The following topics contain field descriptions for pages found in Configuration > Templates > Features
and Technologies > Controller > Management.

• Controller > Management > Legacy Syslog

• Controller > Management > Local Management User

• Controller > Management > Telnet SSH

• Controller > Management > Trap Control

• Controller > Management > Trap Receiver

Controller > Management > Legacy Syslog

Legacy Syslog applies to controllers Version 5.0.6.0 and earlier.Note

For basic information about creating this template, see the Creating Feature-Level Configuration Templates
section in the Cisco Prime Infrastructure 3.1 User Guide.

Controller > Management > Local Management User

Use this option to configure local users, their privilege level, and password.

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Controller > Management > Local Management User.
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Table 40: Controller > Management > Local Management User

DescriptionField

Enter a template username.User Name

Enter a password for this local management user template.Password

Reenter the password.Confirm Password

Use the Access Level drop-down list to choose either Read Only or Read Write.Access Level

Select the Update Telnet Credentials check box to update the user credentials in Prime Infrastructure
for Telnet/SSH access.

If the template is applied successfully and the Update Telnet Credentials option is enabled,
the applied management user credentials are used in Prime Infrastructure for Telnet/SSH
credentials to that applied controller.

Note

Update Telnet Credentials

Controller > Management > Telnet SSH

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Controller > Management > Telnet SSH.

Table 41: Controller > Management > Telnet SSH

DescriptionField

Enter the number of minutes a Telnet session is allowed to remain inactive before being logged off. A
zero means there is no timeout. The valid range is 0 to 160, and the default is 5.

Session Timeout

Enter the number of simultaneous Telnet sessions allowed. The valid range is 0 to 5, and the default is
5. New Telnet sessions can be allowed or disallowed on the DS (network) port. New Telnet sessions
are always allowed on the service port.

Maximum Sessions

Select Yes to allow new Telnet sessions on the DS port or select No to disallow them. New Telnet
sessions can be allowed or disallowed on the DS (network) port. New Telnet sessions are always allowed
on the service port. The default is Yes.

Allow New Telnet Session

Select Yes to allow Secure Shell Telnet sessions or select No to disallow them. The default is Yes.Allow New SSH Session

Controller > Management > Trap Control

The following table describes the Template Detail fields in Configuration > Templates > Features and
Technologies > Controller > Management > Trap Control.

Table 42: Controller > Management > Trap Control

DescriptionField

Select this check box to enable all of the traps on this page.Select All Traps
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DescriptionField

The SNMPv2 entity has received a protocol message that is not properly authenticated. When a user
who is configured in SNMP V3 mode tries to access the controller with an incorrect password, the
authentication fails and a failure message is displayed. However, no trap logs are generated for the
authentication failure.

SNMP Authentication

Select the Link (Port) Up/Down check box to change the state to up or down.Link (Port) Up/Down

Select theMultiple Users check box to allow two users to log in with the same login ID.Multiple Users

Select the Spanning Tree check box to enable spanning tree traps. See the STP specification for
descriptions of individual parameters.

Spanning Tree

Select the Rogue AP check box to send a trap with the MAC address whenever a rogue access point
is detected or when a rogue access point was detected earlier and no longer exists.

Rogue AP

Select the Controller Config Save check box to send a notification when the configuration is
modified.

Controller Config Save

Select the 802.11 Association check box to send a trap when a client is associated to a WLAN. This
trap does not guarantee that the client is authenticated.

802.11 Association

Select the 802.11 Disassociation check box to send the disassociate notification when the client
sends a disassociation frame.

802.11 Disassociation

Select the 802.11 Deauthentication check box to send the deauthenticate notification when the client
sends a deauthentication frame.

802.11 Deauthentication

Select the 802.11 Failed Authentication check box to send the authenticate failure notification when
the client sends an authentication frame with a status code other than successful.

802.11 Failed Authentication

Select the 802.11 Failed Association check box to send the associate failure notification when the
client sends an association frame with a status code other than successful.

802.11 Failed Association

Select the Excluded check box to send the associate failure notification when a client is excluded.Excluded

Select theAPRegister check box to send a notification when a access point associates or disassociates
with the controller.

AP Register

Select the AP Interface Up/Down check box to send a notification when a access point interface
(802.11a/n or 802.11b/g/n) status goes up or down.

AP Interface Up/Down

Select theLoad Profile check box to send a notification when the load profile state changes between
PASS and FAIL.

Load Profile

Select theNoise Profile check box to send a notification when the noise profile state changes between
PASS and FAIL.

Noise Profile

Select the Interference Profile check box to send a notification when the interference profile state
changes between PASS and FAIL.

Interference Profile

Select theCoverage Profile check box to send a notification when the coverage profile state changes
between PASS and FAIL.

Coverage Profile
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DescriptionField

Select the Channel Update check box to send a notification when the dynamic channel algorithm
of an access point is updated.

Channel Update

Select the Tx Power Update check box to send a notification when the dynamic transmit power
algorithm of an access point is updated.

Tx Power Update

Select the User Auth Failure check box to send a trap to inform you that a client RADIUS
authentication failure has occurred.

User Auth Failure

Select the RADIUS Server No Response check box to send a trap to indicate that no RADIUS
server(s) are responding to authentication requests sent by the RADIUS client.

RADIUS Server NoResponse

Select the check box to send a IPsec packets with invalid hashes were found in an inbound ESP SA.ESP Authentication Failure

Select the ESP Authentication Failure check box to send a notification when IPsec packets with
invalid sequence numbers were found in an inbound ESP SA.

ESP Replay Failure

Select the Invalid SPI check box to send a notification when a packet with an unknown SPI is
detected from the specified peer with the specified SPI using the specified protocol.

Invalid SPI

Select the check box IKE Negotiation Failure to send a notification when an attempt to negotiate
a phase 1 IKE SA fails. The notification counts are also sent as part of the trap, along with the current
value of the total negotiation error counters.

IKE Negotiation Failure

Select the IKE Suite Failure check box to send a notification when a attempt to negotiate a phase
2 SA suite for the specified selector fails. The current total failure counts are passed as well as the
notification type counts for the notify involved in the failure.

IKE Suite Failure

Select the Invalid Cookie check box to send a notification when ISAKMP packets with invalid
cookies are detected from the specified source, intended for the specified destination. The initiator
and responder cookies are also sent with the trap.

Invalid Cookie

Select theWEP Decrypt Error check box to send a notification when the controller detects a WEP
decrypting error.

WEP Decrypt Error

Select the Signature Attack check box to enable the 802.11 security trap.Signature Attack

Controller > Management > Trap Receiver

If you have monitoring devices on your network that receive SNMP traps, you can use this page to add a trap
receiver template.

The following table describes the Template Detail fields in Configuration > Templates > Features and
Technologies > Controller > Management > Trap Receiver.

Table 43: Controller > Management > Trap Receiver

DescriptionField

Enter the IP address of the server.IP Address
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DescriptionField

Select this check box to enable the administrator status if you want SNMP traps to be sent to the receiver.Admin
Status

Controller > Mesh > Mesh Settings
Use this option to configure an access point to establish a connection with the controller.

The following table describes the Template Detail fields in Configuration > Templates > Features and
Technologies > Controller > Mesh > Mesh Settings.

Table 44: Controller > Mesh > Mesh Settings

DescriptionField

The Root AP to Mesh AP Range is 12000 feet by default. Enter the optimum distance (in feet) that
should exist between the root access point and the mesh access point. This global field applies to
all access points when they join the controller and all existing access points in the network.

RootAP to MeshAP Range

The Client Access on Backhaul Link check box is not selected by default. When this option is
enabled, mesh access points can associate with 802.11a/n wireless clients over the 802.11a/n
backhaul. This client association is in addition to the existing communication on the 802.11a/n
backhaul between the root and mesh access points.

This feature applies only to access points with two radios.Note

Client Access on Backhaul Link

Select theBackground Scanning check box to enable background scanning or unselect it to disable
the feature. The default value is disabled. Background scanning allows Cisco Aironet 1510 Access
Points to actively and continuously monitor neighboring channels for more optimal paths and
parents.

Background Scanning

TheMeshDCAChannels check box is not selected by default. Select this option to enable backhaul
channel deselection on the Controller using the DCA channel list configured in the Controller. Any
change to the channels in the Controller DCA list is pushed to the associated access points. This
feature applies only to the 1524SB mesh access points. For more information on this feature, see
the Controller Configuration Guide.

Mesh DCA Channels

Select the Global Public Safety check box to enable global public safety.Global Public Safety

Choose either 2.4GHz or 5GHz radios for RAP downlink backhaul from the Mesh RAP

Downlink Backhaul drop-down list.

Mesh RAP Downlink

Backhaul

From the SecurityMode drop-down list, chooseEAP (Extensible Authentication Protocol) or PSK
(pre-shared key).

Security Mode

Controller > PMIP
Proxy Mobile IPv6 is a network-based mobility management protocol that supports a mobile node by acting
as the proxy for the mobile node in any IP mobility-related signaling. The mobility entities in the network
track the movements of the mobile node and initiate the mobility signaling and set up the required routing
state.
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The main functional entities are the Local Mobility Anchor (LMA) andMobile Access Gateway (MAG). The
LMAmaintains the reachability state of the mobile node and is the topological anchor point for the IP address
of the mobile node. The MAG performs the mobility management on behalf of a mobile node. The MAG
resides on the access link where themobile node is anchored. The controller implements theMAG functionality.

The following topics contain field descriptions for pages found in Configuration > Templates > Features
and Technologies > Controller > PMIP.

• Controller > PMIP > Global Config

• Controller > PMIP > LMA Config

• Controller > PMIP > PMIP Profile

Controller > PMIP > Global Config

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Controller > PMIP > Global Config.

Table 45: Controller > PMIP > Global Config

DescriptionField

The name of the domain.Domain Name

Maximum number of binding updates that the controller can send to the MAG. The valid range
is from 0 to 40000.

Maximum Bindings Allowed

Lifetime of the binding entries in the controller. The valid range is from 10 to 65535 seconds.
The default value is 65535. The binding lifetime should be a multiple of 4 seconds.

Binding Lifetime

Refresh time of the binding entries in the controller. The valid range is from 4 to 65535 seconds.
The default value is 300 seconds. The binding refresh time should be a multiple of 4 seconds.

Binding Refresh Time

Initial timeout between the proxy binding updates (PBUs) when the controller does not receive
the proxy binding acknowledgments (PBAs). The valid range is from 100 to 65535 seconds.
The default value is 1000 seconds.

Binding Initial Retry Timeout

Maximum timeout between the proxy binding updates (PBUs) when the controller does not
receive the proxy binding acknowledgments (PBAs). The valid range is from 100 to 65535
seconds. The default value is 32000 seconds.

Binding Maximum Retry Timeout

Maximum amount of time difference between the timestamp in the received proxy binding
acknowledgment and the current time of the day. The valid range is from 1 to 255 milliseconds.
The default value is 7 milliseconds.

Replay Protection Timestamp

Minimum amount of time that the controller waits before retransmitting the BRI message. The
valid range is from 500 to 65535 seconds.

MinimumBRI Retransmit Timeout

Maximum amount of time that the controller waits before retransmitting the Binding Revocation
Indication (BRI) message. The valid range is from 500 to 65535 seconds. The default value is
2000 seconds.

MaximumBRI Retransmit Timeout
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DescriptionField

Maximum number of times that the controller retransmits the BRI message before receiving
the Binding Revocation Acknowledgment (BRA) message. The valid range is from 1 to 10.
The default value is 1.

BRI Retries

Controller > PMIP > LMA Config

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Controller > PMIP > LMA Config.

Table 46: Controller > PMIP > LMA Config

DescriptionField

Name of the LMA connected to the controller.LMA Name

IP address of the LMA connected to the controller.LMA IP
Address

Controller > PMIP > PMIP Profile

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Controller > PMIP > PMIP Profile.

Table 47: Controller > PMIP > PMIP Profile

DescriptionField

Enter the profile name, then click Add.PMIP Profile

Name of the Network Access Identifier (NAI) associated with the profile.NetworkAccess Identifier

Name of the LMA with which the profile is to be associated.LMA Name

Name of the access point node connected to the controller.Access Point Node

Controller >Security
The following topics contain field descriptions for pages found in Configuration > Templates > Features
and Technologies > Controller > Security.

• Controller > Security > AAA LDAP Servers

• Controller > Security > AAA > RADIUS Acct Servers

• Controller > Security > AAA > RADIUS Auth Servers

• Controller > Security > AAA > TACACS+ Servers

• Controller > Security > Local EAP > EAP-FAST Parameters

• Controller > Security > Local EAP > General - Local EAP
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• Controller > Security > Local EAP > Local EAP Profiles

• Controller > Security > Wireless Protection Policies > Friendly Access Point

• Controller > Security > Wireless Protection Policies > Ignored Rogue AP

• Controller > Security > Wireless Protection Policies > Rogue AP Rules

• Controller > Security > Wireless Protection Policies > Rogue Policies

• Controller > Security > Access Control Lists

• Controller > Security > CPU Access Control List

• Controller > Security > File Encryption

• Controller > Security > IP Groups

• Controller > Security > IPv6 Groups

• Controller > Security > Protocol Groups

• Controller > Security > URL ACLs

Controller > Security > AAA LDAP Servers

This section explains how to configure a Lightweight Directory Access Protocol (LDAP) server as a backend
database, similar to a RADIUS or local user database. An LDAP backend database allows the controller to
query an LDAP server for the credentials (username and password) of a particular user. These credentials are
then used to authenticate the user. For example, local EAP might use an LDAP server as its backend database
to retrieve user credentials.

The following table describes the Template Detail fields in Configuration > Templates > Features and
Technologies > Controller > Security > AAA > LDAP Servers.

Table 48: Controller > Security > AAA LDAP Servers

DescriptionField

Enter the IP address of the server.Server Address

Port number of the controller to which the access point is connected.Port Number

Choose Authenticated or Anonymous. If you choose Authenticated, you must enter a bind username and
password as well. A bind is a socket opening that performs a lookup. Anonymous bind requests are rejected.

Bind Type

Enter the distinguished name of the subtree in the LDAP server that contains a list of all the users.Server User BaseDN

Enter the attribute that contains the username in the LDAP server.Server User Attribute

Enter the ObjectType attribute that identifies the user.Server User Type

Enter the number of seconds between retransmissions. The valid range is from 2 to 30 seconds, and the default
value is 2 seconds.

Retransmit Timeout

Select the Enable check box if you want the LDAP server to have administrative privileges.Admin Status
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Controller > Security > AAA > RADIUS Acct Servers

This page allows you to add a RADIUS accounting template or make modifications to an existing RADIUS
accounting template.

The following table describes the Template Detail fields in Configuration > Templates > Features and
Technologies > Controller > Security > AAA > RADIUS Acct Servers.

Table 49: Controller > Security > AAA > RADIUS Acct Servers

DescriptionField

Enter the server address.Server Address

Enter the port address.Port Number

Choose either ASCII or Hex.

Regardless of the format you choose, for security reasons, only ASCII is visible on
the wireless LAN controller (and Prime Infrastructure). For this reason, you cannot
use a template to replicate the configuration on a second controller during auto
provisioning. You should set the key format again in the template in case a
discovered template is applied to another device.

Note

Shared Secret Format

Enter and confirm the RADIUS shared secret used by the server you specified.Shared SecretConfirm Shared Secret

Select the Enable check box if you want to establish administrative privileges for the server.Admin Status

Select if you want to enable the network user authentication. If this option is enabled, this
entry is considered as the RADIUS authenticating server for the network user.

Network User

Specify the time in seconds after which the RADIUS authentication request times out and a
retransmission by the controller occurs. You can specify a value from 2 to 30 seconds.

Retransmit Timeout

Select the Enable check box to enable IP security.IPsec Enable

Controller > Security > AAA > RADIUS Auth Servers

Use this option to add a RADIUS authentication template or makemodifications to an existing template. After
these server templates are configured, controller users who log in to the controller through the CLI or GUI
are authenticated.

The following table describes the Template Detail fields in Configuration > Templates > Features and
Technologies > Controller > Security > AAA > RADIUS Auth Servers.

Table 50: Controller > Security > AAA > RADIUS Auth Servers

DescriptionField

Enter the server address.Server Address

Enter the port address.Port Number
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DescriptionField

Choose either ASCII or hex.

Regardless of the format you choose, for security reasons, only ASCII is visible on the WLC
(and Prime Infrastructure). For this reason, you cannot use a template to replicate the
configuration on a second controller during auto provisioning. You should set the key format
again in the template in case a discovered template is applied to another device.

Note

Shared Secret Format

Enter the RADIUS shared secret used by your specified server.Shared Secret

Reenter the RADIUS shared secret used by your specified server.Confirm Shared Secret

Select the check box if you want to enable key wrap. If this check box is enabled, the authentication
request is sent to RADIUS servers that have following key encryption key (KEK) and message
authenticator code keys (MACK) configured. When enabled, the following fields appear:

• Shared Secret Format: Enter ASCII or hexadecimal.

Regardless of the format you choose, for security reasons, only ASCII is visible on the WLC
(and Prime Infrastructure). For this reason, you cannot use a template to replicate the
configuration on a second controller during auto provisioning. You should set the key format
again in the template in the event a discovered template is applied to another device.

Note

• KEK Shared Secret: Enter the KEK shared secret.

• MACK Shared Secret: Enter the MACK shared secret.

Each time the controller is notified with the shared secret, the existing shared secret is
overwritten with the new shared secret.

Note

Key WRAP

Select if you want to enable administration privileges.Admin Status

Select if you want to enable support for RFC 3576. RFC 3576 is an extension to the Remote Authentication
Dial In User Service (RADIUS) protocol. It allows dynamic changes to a user session and includes
support for disconnecting users and changing authorizations applicable to a user session. With these
authorizations, support is provided for Disconnect and Change-of-Authorization (CoA) messages.
Disconnect messages immediately terminate a user session, whereas CoA messages modify session
authorization attributes such as data filters.

Support for RFC 3576

Select if you want to enable network user authentication. If this option is enabled, this entry is considered
as the RADIUS authenticating server for the network user.

Network User

Select if you want to enable management authentication. If this option is enabled, this entry is considered
as the RADIUS authenticating server for the management user.

Management User

Specify the time in seconds after which the RADIUS authentication request times out and a retransmission
is attempted by the controller. You can specify a value from 2 to 30 seconds.

Retransmit Timeout

If you click to enable the IP security mechanism, additional IP security fields are added to the page.IPsec
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DescriptionField

Choose which IP security authentication protocol to use. The options areHMAC-SHA1,HMAC-MD5,
and None.

Message Authentication Codes (MAC) are used between two parties that share a secret key to validate
information transmitted between them. HMAC (Hash MAC) is a mechanism based on cryptographic
hash functions and can be used in combinationwith any iterated cryptographic hash function. HMAC-MD5
and HMAC-SHA1 are two constructs of the HMAC using the MD5 hash function and the SHA1 hash
function. HMAC also uses a secret key for calculation and verification of the message authentication
values

IPsec Authentication

Select the IP security encryption mechanism to use:

• DES—Data Encryption Standard is a method of data encryption using a private (secret) key. DES
applies a 56-bit key to each 64-bit block of data.

• Triple DES—Data Encryption Standard that applies three keys in succession.

• AES 128 CBC—Advanced Encryption Standard uses keys with a length of 128, 192, or 256 bits to
encrypt blocks with a length of 128, 192, or 256 bits. AES 128 CBC uses a 128-bit data path in
Cipher Clock Chaining (CBC) mode.

• None—No IP security encryption mechanism.

IPsec Encryption

The Internet Key Exchange (IKE) authentication is not an editable text box. Internet Key Exchange
protocol (IKE) is used as a method of distributing the session keys (encryption and authentication), as
well as providing a way for the VPN endpoints to agree on how data should be protected. IKE keeps
track of connections by assigning a bundle of security associations (SAs) to each connection.

IKE Authentication

Choose either aggressive or main. This sets the IKE protocol. IKE phase 1 is used to negotiate how IKE
is protected. Aggressive mode passes more information in fewer packets, with the benefit of a slightly
faster connection, at the cost of transmitting the identities of the security gateways in the clear.

IKE Phase 1

Set the timeout interval (in seconds) when the session expires.Lifetime

Set the IKE Diffie-Hellman group. The options are group 1 (768 bits), group 2 (1024 bits), or group 5
(1536 bits). Diffie-Hellman techniques are used by two devices to generate a symmetric key where you
can publicly exchange values and generate the same symmetric key.

Although all three groups provide security from conventional attacks, Group 5 is considered more secure
because of its larger key size. However, computations involving Group 1-based or Group 2-based keys
might occur slightly faster because of their smaller prime number size.

IKE Diffie Hellman
Group

Controller > Security > AAA > TACACS+ Servers

Use this option to add a TACACS+ server or make modifications to an existing TACACS+ server template.
After these server templates are configured, controller users who log in to the controller through the CLI or
GUI are authenticated.

The following table describes the Template Detail fields in Configuration > Templates > Features and
Technologies > Controller > Security > AAA > TACACS+ Servers.

Field Reference for Configuration Pages
47

Field Reference for Configuration Pages
Controller > Security > AAA > TACACS+ Servers



Table 51: Controller > Security > AAA > TACACS+ Servers

DescriptionField

Select one or more server types by selecting their respective check boxes. The following server types are
available:

• authentication—Server for user authentication/authorization.

• authorization—Server for user authorization only.

• accounting—Server for RADIUS user accounting.

Server Type

Enter the IP address of the server.Server Address

Enter the port number of the server. The default is 49.Port Number

Choose either ASCII or hex.

Regardless of which format you choose, for security reasons, only ASCII is visible on the WLC (and
Prime Infrastructure). For this reason, you cannot use a template to replicate the configuration on a second
controller during auto provisioning. Set the key format again in the template in the event a discovered
template is applied to another device.

Shared Secret Format

Enter the TACACS+ shared secret used by your specified server.Shared Secret

Reenter the TACACS+ shared secret used by your specified server.Confirmed Shared Secret

Select if you want the LDAP server to have administrative privileges.Admin Status

Enter the time, in seconds, after which the TACACS+ authentication request times out and a retransmission
is attempted by the controller.

Retransmit Timeout

Controller > Security > Local EAP > EAP-FAST Parameters

This authentication type (Flexible Authentication via Secure Tunneling) uses a three-phased tunnel
authentication process to provide advanced 802.1X EAP mutual authentication. A username, password, and
PAC are used to perform mutual authentication with the RADIUS server through the access point. This page
allows you to add an EAP-FAST template or make modifications to an existing EAP-FAST template.

The following table describes the Template Detail fields in Configuration > Templates > Features and
Technologies > Controller > Security > Local EAP > EAP-FAST Parameters.

Table 52: Controller Security Local EAP EAP_FAST Parameters

DescriptionField

Enter the number of days for the PAC to remain viable. The valid range is 1 to 1000 days, and
the default setting is 10 days.

Time to Live for the PAC

Enter the authority identifier of the local EAP-FAST server in hexadecimal characters. You
can enter up to 32 hexadecimal characters, but you must enter an even number of characters.

Authority ID

Enter the authority identifier of the local EAP-FAST server in text format.Authority Info
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DescriptionField

Enter the key (in hexadecimal characters) used to encrypt and decrypt PACs.Server Key and Confirm Server Key

Select to enable anonymous provisioning. This feature allows PACs to be sent automatically
to clients that do not have one during PAC provisioning. If you disable this feature, PACs
must be manually provisioned.

Anonymous Provision

Controller > Security > Local EAP > General - Local EAP

This page allows you to specify a timeout value for local EAP. You can then add or make changes to an
existing local EAP general template.

If any RADIUS servers are configured on the controller, the controller tries to authenticate the wireless clients
using the RADIUS servers first. Local EAP is attempted only if no RADIUS servers are found, either because
the RADIUS servers timed out or no RADIUS servers were configured. If four RADIUS servers are configured,
the controller attempts to authenticate the client with the first RADIUS server, then the second RADIUS
server, and then local EAP. If the client attempts to then reauthenticate manually, the controller tries the third
RADIUS server, then the fourth RADIUS server, and then local EAP.

Note

The following table describes the Template Detail fields in Configuration > Templates > Features and
Technologies > Controller > Security > Local EAP > General - Local EAP.

Table 53: Controller > Security > Local EAP > General - Local EAP

DescriptionField

Enter the amount of time (in seconds) that the controller
attempts to authenticate wireless clients using local EAP
after any pair of configured RADIUS servers fail. The
valid range is 1 to 3600 seconds, and the default setting
is 1000 seconds.

Local Auth Active Timeout

Enter the values specified below if you are using EAP-FAST,
manual password entry, one-time password, or 7920/7921 phones.
You must increase the 802.1x timeout values on the controller
(default=2 seconds) for the client to obtain the PAC using
automatic provisioning. The recommended and default timeout
on the Cisco ACS server is 20 seconds. Roaming fails if these
values are not set the same across multiple controllers.

Note

1Local EAP Identity Request Timeout

20Local EAP Identity Request Maximum Retries

0Local EAP Dynamic WEP Key Index

20Local EAP Request Timeout

2Local EAP Request Maximum Retries
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DescriptionField

1000 (in milliseconds)EAPOL-Key Timeout

2EAPOL-Key Max Retries

Choose Enable to limit the number of devices that can
be connected to the controller with the same username.

Max Login Ignore Identity Response

Controller > Security > Local EAP > Local EAP Profiles

This page allows you to add a local EAP profile template or make modifications to an existing template. Local
EAP is an authenticationmethod that allows users and wireless clients to be authenticated locally. It is designed
for use in remote offices that want to maintain connectivity to wireless clients when the backend system
becomes disrupted or the external authentication server goes down.When you enable local EAP, the controller
serves as the authentication server and the local user database, thereby removing dependence on an external
authentication server. Local EAP retrieves user credentials from the local user database or the LDAP backend
database to authenticate users.

The LDAP backend database supports only these local EAP methods: EAP-TLS and EAP-FAST with
certificates. LEAP and EAP-FAST with PACs are not supported for use with the LDAP backend database.

Note

The following table describes the Template Detail fields in Configuration > Templates > Features and
Technologies > Controller > Security > Local EAP > Local EAP Profiles.

Table 54: Controller > Security > Local EAP > Local EAP Profiles

DescriptionField

User-defined identification.EAP Profile Name

Choose the desired authentication type:

• LEAP—This authentication type leverages Cisco Key Integrity Protocol (CKIP) and
Multi-Modal Hashing (MMH)message integrity check (MIC) for data protection. A username
and password are used to perform mutual authentication with the RADIUS server through the
access point.

• EAP-FAST—This authentication type (Flexible Authentication via Secure Tunneling) uses a
three-phased tunnel authentication process to provide advanced 802.1X EAP mutual
authentication. A username, password, and PAC (protected access credential) are used to
perform mutual authentication with the RADIUS server through the access point.

• TLS—This authentication type uses a dynamic session-basedWEP key derived from the client
adapter and RADIUS server to encrypt data. It requires a client certificate for authentication.

• PEAP—This authentication type is based on EAP-TLS authentication but uses a password
instead of a client certificate for authentication. PEAP uses a dynamic session-basedWEP key
derived from the client adapter and RADIUS server to encrypt data.

Select Profile Methods
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DescriptionField

Determinewhether Cisco or another vendor issued the certificate for authentication. Only EAP-FAST
and TLS require a certificate.

Certificate Issuer

Select if you want the incoming certificate from the client to be validated against the certificate
authority (CA) certificates on the controller.

Check Against CA Certificates

Select if you want the common name (CN) in the incoming certificate to be validated against the
common name of the CA certificate.

Verify Certificate CN Identity

Select if you want the controller to verify that the incoming device certificate is still valid and has
not expired.

Check Against Date Validity

Select if a local certificate is required.Local Certificate Required

Select if a client certificate is required.Client Certificate Required

Controller > Security > Wireless Protection Policies > Friendly Access Point

This template allows you to import friendly internal access points. Importing these friendly access points
prevents nonlightweight access points from being falsely identified as rogues.

Friendly Internal access points were previously referred to as Known APs.Note

The Friendly AP page identifies the MAC address of an access point, status, any comments, and whether or
not the alarm is suppressed for this access point.

Friendly access points can be added by either importing the access point or manually entering the access point
information:

• To import an access point using the Import feature:

• Select the Import from File check box.

• Enter the file path or click Browse to navigate to the correct file.

Use a line break to separate MAC addresses in the file that you import. For example, enter theMAC addresses
as follows:00:00:11:22:33:4400:00:11:22:33:4500:00:11:22:33:46

To manually add an access point, follow these steps:

Note

Procedure

Step 1 Unselect the Import from File check box.
Step 2 Enter theMAC address for the access point.
Step 3 Choose Internal access point from the Status drop-down list.
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Step 4 Enter a comment regarding this access point, if necessary.
Step 5 Select the Suppress Alarms check box to suppress all alarms for this access point.

Controller > Security > Wireless Protection Policies > Ignored Rogue AP

The Ignored Rogue AP Template page allows you to create or modify a template for importing ignored access
points. Access points in the Ignored AP list are not identified as rogues.

An Ignored Rogue AP template does not get applied to any controller. It suppresses the rogue AP/Adhoc
alarm if Ignored Rogue AP Template has the rogue MAC address when the controller reports the Rogue AP
to Prime Infrastructure and this MAC address is added to the Rogue AP Ignore-List on the controller.

Ignored rogue access points can be added by either importing the access point or manually entering the access
point information:

Procedure

Step 1 To import an ignored rogue access point using the Import feature. <<Import feature is Not present>>
Step 2 Select the Import from File check box. <<Not present>>
Step 3 Enter the file path or use the Browse button to navigate to the correct file. The import file must be a CSV file

with MAC address (one MAC Address per line).<<Not present>>

For example, enter the MAC addresses as
follows:00:00:11:22:33:4400:00:11:22:33:4500:00:11:22:33:46

Note

What to do next

To manually add an ignored rogue access point unselect the Import from File check box. <<Not present>>

Controller > Security > Wireless Protection Policies > Rogue AP Rules

Rogue access point rules allow you to define rules to automatically classify rogue access points. Prime
Infrastructure applies the rogue access point classification rules to the controllers. These rules can limit the
appearance of a rogue on maps based on RSSI level (weaker rogue access points are ignored) and time limit
(a rogue access point is not flagged unless it is seen for the indicated period of time).

The rogue access point rules also help reduce false alarms.

Rogue classes include the following types:

• Malicious Rogue—A detected access point that matches the user-defined malicious rules or has been
manually moved from the Friendly AP category.

• Friendly Rogue—Known, acknowledged, or trusted access point or a detected access point that matches
user-defined friendly rules.

• Unclassified Rogue—A detected access point that does not match the malicious or friendly rules.

The following table describes the Template Detail fields in Configuration > Templates > Features and
Technologies > Controller > Security > Wireless Protection Policies > Rogue AP Rules.
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Table 55: Controller > Security > Wireless Protection Policies > Rogue AP Rules

DescriptionField

ChooseMalicious or Friendly from the drop-down list. A rogue is considered malicious if a
detected access point matches the user-defined malicious rules or has been manually moved from
the Friendly AP category. A rogue is considered friendly if it is a known, acknowledged, or trusted
access point or a detected access point that matches the user-defined Friendly rules.

Rule Type

ChooseMatch All Conditions orMatch Any Condition.Match Type

Select the check box to enable open authentication.Open Authentication

Select the check box to enable the matching of a managed AP SSID.

Managed SSIDs are the SSIDs configured for the WLAN and known to the system.Note

Match Managed AP SSID

Select the check box to enable the matching of user-configured SSIDs.

User-configured SSIDs are the SSIDs that are manually added. Enter the user-configured
SSIDs (one per line) in the Match User Configured SSID text box.

Note

Match User Configured SSID

Select the check box to enable the Minimum RSSI threshold limit.

Enter the minimumRSSI threshold level (dB) in the text box. The detected access point
is classified as malicious if it is detected above the indicated RSSI threshold.

Note

Minimum RSSI

Select the check box to enable the Time Duration limit.

Enter the time duration limit (in seconds) in the text box. The detected access point is
classified as malicious if it is viewed for a longer period of time than the indicated time
limit.

Note

Time Duration

Select the check box to enable the Minimum Number Rogue Clients limit. Enter the minimum
number of rogue clients allowed. The detected access point is classified as malicious if the number
of clients associated to the detected access point is greater than or equal to the indicated value.

Minimum Number Rogue
Clients

Controller > Security > Wireless Protection Policies > Rogue Policies

This page enables you to configure the rogue policy (for access points and clients) applied to the controller.

The following table describes the Template Detail fields in Configuration > Templates > Features and
Technologies > Controller > Security > Wireless Protection Policies > Rogue Policies.
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Table 56: Controller > Security > Wireless Protection Policies > Rogue Policies

DescriptionField

Determine whether or not the Rogue Location Discovery Protocol (RLDP) is connected to the
enterprise wired network. Choose one of the following:

• Disable—Disables RLDP on all access points.

• All APs—Enables RLDP on all access points.

• Monitor Mode APs—Enables RLDP only on access points in monitor mode.

With RLDP, the controller instructs a managed access point to associate with the
rogue access point and sends a special packet to the controller. If the controller
receives the packet, the rogue access point is connected to the enterprise network.
This method works for rogue access points that do not have encryption enabled.

Note

Rogue Location Discovery Protocol

Enter the expiration timeout (in seconds) for rogue access point entries.Expiration Timeout for Rogue AP
and Rogue Client Entries

Enter the time interval in seconds at which the APs should send the rogue detection report to
the controller. A valid range is from 10 to 300 seconds, and the default value is 10 seconds.
This feature is applicable to APs that are in monitor mode only.

Rogue Detection Report Interval

Enter the minimum RSSI value that a rogue should have for the APs to detect and for the rogue
entry to be created in the controller. A valid range is from -70 to -128 dBm, and the default
value is -128 dBm. This feature is applicable to all the AP modes.

There can be many rogues with very weak RSSI values that do not provide any valuable
information in the rogue analysis. Therefore, you can use this option to filter the rogues by
specifying the minimum RSSI value at which the APs should detect rogues.

Rogue Detection Minimum RSSI

Enter the time interval at which a rogue has to be consistently scanned for by the AP after the
first time the rogue is scanned. By entering the transient interval, you can control the time
interval at which the AP should scan for rogues. The APs can filter the rogues based on their
transient interval values. The valid range is from 120 to 1800 seconds, and the default value is
0. This feature is applicable to APs that are in monitor mode only

Rogue Detection Transient Interval
(Enter 0 to Disable)

Select to enable the AAA validation of rogue clients.Validate Rogue Clients against
AAA

Select to enable detection and reporting of rogue clients participating in ad hoc networking.Detect and Report AdhocNetworks

Automatically contains rogues that are detected on the wired network.Rogue on Wire

Automatically contains rogues that are advertising your network’s SSID. If you leave this
parameter unselected, the controller only generates an alarm when such a rogue is detected.

Using our SSID

Automatically contains a rogue access point to which trusted clients are associated. If you leave
this parameter unselected, the controller only generates an alarmwhen such a rogue is detected.

Valid Client on Rogue AP
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Controller > Security > Access Control Lists

The following table describes the Template Detail fields in Configuration > Templates > Features and
Technologies > Controller > Security > Access Control Lists.

Table 57: Controller > Security > Access Control Lists

DescriptionField

IPv6 is supported from controller Version 7.2.x.ACL Type

Related Topics

• To create reusable grouped IP addresses, see Controller > System

• To create a new protocol group, see Controller > Security > Protocol Groups

Controller > Security > CPU Access Control List

CPU ACL configuration with IPv6 is not supported in this release because all IP addresses of controllers on
interfaces use IPv4 except the virtual interface.

Note

Use the existing ACLs established in the Creating a FlexConnect Access Control List Template (see Cisco
Prime Infrastructure 3.1 User Guide) to set traffic controls between the Central Processing Unit (CPU) and
Network Processing Unit (NPU).

Controller > Security > File Encryption

This page enables you to add a file encryption template or make modifications to an existing file encryption
template.

The following table describes the Template Detail fields in Configuration > Templates > Features and
Technologies > Controller > Security > File Encryption.

Table 58: Controller > Security > File Encryption

DescriptionField

Enter an encryption key text string of exactly 16 ASCII characters.Encryption KeyConfirm Encryption Key

Controller > Security > IP Groups

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Controller > Security > IP Groups.

To create IPv6 groups, see Controller > Security > IPv6 Groups
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Table 59: Controller > Security > IP Groups

DescriptionField

Enter an IPv4 address format.IP Address

Netmask allows you to set the subnet mask in dotted-decimal notation rather than the CIDR notation
for the IP address property. A range of IP addresses defined so that only machines with IP addresses
within the range are allowed to access an Internet service.

NetmaskNotation

Classless InterDomain Routing (CIDR) notation is a protocol that allows the assignment of Class C
IP addresses in multiple contiguous blocks. Use this protocol to add a large number of clients that
exist in a subnet range by configuring a single client object.

CIDR Notation

All the IP address groups are listed. One IP address group can have a maximum of 128 IP address
and netmask combinations. To define a new IP address group, choose Add. To view or modify an
existing IP address group, click the URL of the IP address group. The IP address group page opens.

For the IP address of any, an any group is predefined.Note

Use the Move Up and Move Down buttons to rearrange the order of the list items. Use the Delete
button to delete any IP address or netmask.

List of IP
Addresses/Netmasks

Related Topic

To create IPv6 groups, see Controller > Security > IPv6 Groups

Controller > Security > IPv6 Groups

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Controller > Security > IPv6 Groups.

Table 60: Controller > Security > IPv6 Groups

DescriptionField

Enter an IPv6 address format.IP Address

Prefix for IPv6 addresses, ranging from 0 to 128.Prefix Length

All the IP address groups are listed. One IP address group can have a maximum of 128 IP address
and netmask combinations. To define a new IP address group, choose Add. To view or modify an
existing IP address group, click the URL of the IP address group. The IP address group page opens.

For the IP address of any, an any group is predefined.Note

Use the Move Up and Move Down buttons to rearrange the order of the list items. Use the Delete
button to delete any IP address or netmask.

List of IP Addresses/Netmasks

Related Topics

To create IPv4 groups, see Controller > System
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Controller > Security > Protocol Groups

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Controller > Security > Protocol Groups.

Table 61: Controller > Security > Protocol Groups

DescriptionField

The rule name is provided for the existing rules, or you can now enter a name for a new rule. ACLs are
not required to have rules defined. When a packet matches all the fields of a rule, the action for this rule
is exercised.

Rule Name

Choose a protocol from the drop-down list:

• Any—All protocols

• TCP—Transmission Control Protocol

• UDP—User Datagram Protocol

• ICMP—Internet Control Message Protocol

• ESP—IP Encapsulating Security Payload

• AH—Authentication Header

• GRE—Generic Routing Encapsulation

• IP—Internet Protocol

• Eth Over IP—Ethernet over Internet Protocol

• Other Port OSPF—Open Shortest Path First

• Other—Any other IANA protocol (http://www.iana.org/)

Some protocol choices (such as TCP or UDP) cause additional Source Port and Dest Port GUI elements
to appear.

Protocol

Enter the source port. Can be Any, HTTP, HTTPS, Telnet, RADIUS, DHCP Server, DHCP Client, DNS,
L2TP, PPTP control, FTP control, SMTP, SNMP, LDAP, Kerberos, NetBIOSNS, NetBIOSDS, NetBIOS
SS, MS Dir Server, Other, and Port Range.

Source Port

Enter the destination port. If TCP or UDP is selected, can be Any, HTTP, HTTPS, Telnet, RADIUS,
DHCP Server, DHCP Client, DNS, L2TP, PPTP control, FTP control, SMTP, SNMP, LDAP, Kerberos,
NetBIOS NS, NetBIOS DS, NetBIOS SS, MS Dir Server, Other, and Port Range.

Dest Port

ChooseAny or Specific from the drop-down list. If Specific is selected, enter the DSCP (0 through 255).
DSCP is a packet header code that can be used to define the quality of service across the Internet.

DSCP (Differentiated
Services Code Point)

Controller > Security > URL ACLs

URL filtering feature allows you to control access to Internet websites. It does so by permitting or denying
access to specific websites based on information contained in a URL access control list (ACL). The URL
filtering then restricts access based on the ACL list.

Field Reference for Configuration Pages
57

Field Reference for Configuration Pages
Controller > Security > Protocol Groups

http://www.iana.org


Using location based filtering, APs are grouped under various AP groups andWLAN profiles separate trusted
and non-trusted clients within the same SSID. This forces re-authentication and new VLAN when a trusted
client moves to a non-trusted AP or vice-versa.

The Wireless Controller (WLC) supports up to 64 ACLs and each ACL can contain up to 100 URLs. These
ACLs are configured to either allow or deny requests, and can be associated with different interfaces (ex:
WLAN, LAN), thus increasing effective filtering. Policies can be implemented locally on a WLAN or an AP
group that is different from the applied global policy.

The number of rules (URLs) supported in each ACL varies for different WLCs:

• Cisco 5508 WLC and WiSM2 support 64 rules in per URL ACL.

• Cisco 5520, 8510, and 8540 WLCs support 100 rules per URL ACL.

• Restrictions for URL Filtering and NAT.

• Not supported on Cisco 2504 WLCs, vWLC, and Mobility Express.

• Supports WLAN Central Switching and not Local switching.

• Not supported in Flex mode with local switching.

• URL name is limited to 32 characters in length.

• No AVC Profile for the matched URLs. ACL Actions support for the Matched URLs.

• White list and Black list can be created using the “*” implicit rule in the ACL to allow or deny requests
respectively.

• HTTPS URLs are not supported.

• ACL may fail to filter in the following situations:

• URL is across fragmented packets.

• IP packets are fragmented.

• Direct IP address or proxy setup used instead of URL.

• These are currently not supported. If any URL matches with these conditions, it will not be considered
for filtering.

• Wildcard URLs (ex: www.uresour*loc.com)

• Sub-URL (ex: www.uresour*loc.com/support)

• Sub-Domain (ex: reach.url.com or sub1.url.com)

• If there is any duplicate URL present while creating the template, then the duplicate URL Rule is not
considered

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Controller > Security > URL ACLs.
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Table 62: Controller > Security > URL ACLs

DescriptionField

In the URL Name text box, enter the URL address.URL

Select Allow or Deny from the drop-down list.Rule Action

Controller > System
The following topics contain field descriptions for pages found in Configuration > Templates > Features
and Technologies > Controller > System.

• Controller > System > AP 802.1X Supplicant Credentials

• Controller > System > AP Username Password

• Controller > System > DHCP

• Controller > System > Dynamic Interface

• Controller > System > General

• Controller > System > Global CDP Configuration

• Controller > System > QoS Profiles

• Controller > System > SNMP Community

• Controller > System > Traffic Stream Metrics QoS

• Controller > System > User Roles

Controller > System > AP 802.1X Supplicant Credentials

Use this option to configure 802.1X authentication between lightweight access points and the switch. The
access point acts as an 802.1X supplicant and is authenticated by the switch using EAP-FASTwith anonymous
PAC provisioning. You can set global authentication settings that all access points inherit as they join the
controller. All access points that are currently joined to the controller and any that join in the future are
included.

For basic information about creating this template, see Creating Feature-Level Configuration Templates
section in the Cisco Prime Infrastructure 3.1 User Guide.

Controller > System > AP Username Password

Use this option to create or modify a template for setting an access point username and password. All access
points inherit the password as they join the controller and these credentials are used to log in to the access
point via the console or Telnet/SSH.

The AP Username Password page enables you to set a global password that all access points inherit as they
join a controller. When you are adding an access point, you can also choose to accept this global username
and password or override it on a per-access point basis.

Also, in controller software Release 5.0, after an access point joins the controller, the access point enables
console port security and you are prompted for your username and password whenever you log in to the access
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point console port. When you log in, you are in nonprivileged mode and you must enter the enable password
to use the privileged mode.

For basic information about creating this template, see Creating Feature-Level Configuration Templates
section in the Cisco Prime Infrastructure 3.1 User Guide.

Controller > System > DHCP

The following table describes the Template Detail fields in Configuration > Templates > Features and
Technologies > Controller > System > DHCP.

Table 63: Controller > System > DHCP

DescriptionField

This field provides additional security whenDHCP is used to allocate network addresses. Specifically,
it enables the controller to act as a DHCP relay agent to prevent DHCP client requests from untrusted
sources. The controller can be configured to add option 82 information to DHCP requests from
clients before forwarding the requests to the DHCP server.

DHCP Option 82 Remote Id
field format

Select theDHCP Proxy check box to enable DHCP proxy on a global basis rather than on aWLAN
basis.

When DHCP proxy is enabled on the controller, the controller unicasts DHCP requests from the
client to the configured servers. At least one DHCP server must be configured on either the interface
associated with the WLAN or on the WLAN itself.

DHCP Proxy

(For Controller Version 7.0.114.74 and later) Enter the DHCP timeout, in seconds.DHCP Timeout

Controller > System > Dynamic Interface

The following table describes the Template Detail fields in Configuration > Templates > Features and
Technologies > Controller > System > Dynamic Interface.

Table 64: Controller > System > Dynamic Interface

DescriptionField

Select to mark the interface as wired.Guest LAN

Enable/disable to quarantine a VLAN. Select the check box to enable.Quarantine

Enter the netmask address of the interface.Netmask

Select this check box to enable or disable LAG Mode. If LAG mode is selected with this interface, then
the settings can be applied only to the LAG-enabled controllers.

LAG Mode

Enter the port currently used by the interface.Primary Port Number

Enter a secondary port to be used by the interface when the primary port is down. When the primary port
is reactivated, the Cisco 4400 Series Wireless LAN controller transfers the interfaces back to the primary
port.

Primary and secondary port numbers are present only in the Cisco 4400 Series Wireless LAN controllers.

Secondary Port Number

Field Reference for Configuration Pages
60

Field Reference for Configuration Pages
Controller > System > DHCP

http://www.cisco.com/c/en/us/td/docs/net_mgmt/prime/infrastructure/3-1/user/guide/pi_ug.html


DescriptionField

Select this check box to enable access point management.AP Management

Enter the IP addresses of the primary DHCP servers.Primary DHCP Server

Enter the IP addresses of the secondary DHCP servers.SecondaryDHCPServer

Choose a name from the list of defined names.

From the Add Format Type drop-down list in the Add Interface Format Type group box, choose either
Device Info or File. If you choose device info, you must configure the device-specific fields for each
controller. If you choose File, you must configure CSV device-specific fields (Interface Name, VLAN
Identifier, Quarantine VLAN Identifier, IP Address, and Gateway) for all the managed controllers specified
in the CSV file (see the following table).

ACL Name

The sample CSV files are as follows.

Table 65: Sample CSV Files

gatewayinterface_

ip_address

quarantine_

vlan_id

vlan_idinterface_nameip_address

209.165.200.229209.165.200.22821dyn-1209.165.200.224

209.165.200.231209.165.200.23024interface-1209.165.200.225

209.165.200.233209.165.200.23235interface-2209.165.200.226

209.165.200.235209.165.200.23432dyna-2209.165.200.227

The first row of the CSV file is used to describe the columns included. The CSV files can contain the following
fields:

• ip_address

• interface_name

• vlan_id

• quarantine_vlan_id

• interface_ip_address

• gateway

If you choose Apply to Controllers, you advance to the Apply To page where you can configure device-specific
fields for each controller.

Use the Add and Remove options to configure device-specific fields for each controllers. If you click Edit,
a dialog box appears with the current parameter input.

Make the necessary changes in the dialog box, then click OK.
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If you change the interface fields, theWLANs are temporarily disabled, therefore you might lose connectivity
for some clients. Any changes to the interface fields are saved only after you successfully apply them to the
controller(s).

Note

If you remove an interface here, it is removed only from this template and not from the controllers.Note

Controller > System > General

The following table describes the Template Detail fields in Configuration > Templates > Features and
Technologies > Controller > System > General - System.

Table 66: Controller > System > General - System Template

DescriptionField

Enable or disable flow control mode.802.3x Flow Control Mode

Enable or disable 802.3 bridging. This 802.3 bridging option is not available for Cisco 5500
and Cisco 2106 series controllers.

802.3 Bridging

Choose the desired Web RADIUS authentication. You can choose to use PAP, CHAP, or
MD5-CHAP for authentication between the controller and the client during the user credential
exchange.

Web Radius Authentication

Specify the number of seconds for the AP Primary Discovery Timeout. The default is 120
seconds, and the valid range is 30 to 3600 seconds.

AP Primary Discovery Timeout

Specify the back-up primary and secondary controller details.Back-up Primary Controller IP
Address

Back-up Primary Controller Name

Back-up Secondary Controller IP
Address

Back-up Secondary Controller
Name

Specify Layer 2 or Layer 3 transport mode. When set to Layer 3, the lightweight access point
uses IP addresses to communicate with the access points; these IP addresses are collected from
a mandatory DHCP server. When set to Layer 2, the lightweight access point uses proprietary
code to communicate with the access points.

Controllers through Version 5.2 use LWAPP and the new controller version uses CAPWAP.

CAPWAP Transport Mode

Choose to enable or disable broadcast forwarding. The default is disabled.Broadcast Forwarding
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DescriptionField

Choose Enable or Disable from the LAG Mode drop-down list. Link aggregation allows you
to reduce the number of IP addresses needed to configure the ports on your controller by
grouping all the physical ports and creating a link aggregation group (LAG).

If LAG is enabled on a controller, any dynamic interfaces that you have created are deleted to
prevent configuration inconsistencies in the interface database. When you make changes to the
LAG configuration, the controller has to be rebooted for the changes to take effect.

Interfaces cannot be created with the Dynamic AP Manager flag set. Also, you cannot create
more than one LAG on a controller.

LAG Mode

Choose to enable or disable peer-to-peer blockingmode. If you choose Disable, any same-subnet
clients communicate through the controller. If you choose Enable, any same-subnet clients
communicate through a higher-level router.

Peer to Peer Blocking Mode

From the Over-the-Air AP Provision Mode drop-down list, choose enable or disable.Over-the-Air Provisioning AP
Mode

From the AP Fallback drop-down list, choose enable or disable. Enabling fallback causes an
access point that lost a primary controller connection to automatically return to service when
the primary controller returns.

When a controller fails, the backup controller configured for the access point suddenly receives
a number of discovery and join requests. This might cause the controller to reach a saturation
point and reject some of the access points. By assigning priority to an access point, you have
some control over which access points are rejected. In a failover situation when the backup
controller is saturated, the higher priority access points can join the backup controller if the
lower priority access points are disjoined. Choose enable from the AP Failover Priority
drop-down list if you want to allow this capability.

AP Fallback

AP Failover Priority

Choose to enable or disable AppleTalk bridging.

This AppleTalk bridging option is not available on Cisco 5500 series controllers.

Apple Talk Bridging

Choose to enable or disable the Fast SSID Change option. If the option is enabled, the client
connects instantly to the controller between SSIDs without having much loss of connectivity.
Normally, each client is connected to a particular WLAN identified by the SSID. If the client
moves out of reach of the connected access point, the client has to reconnect to the controller
using a different access point. This normal process consumes some time as the DHCP (Dynamic
Host Configuration Protocol) server has to assign an IP address to the client.

Because the master controller is normally not used in a deployed network, the master controller
setting is automatically disabled upon reboot or operating system code upgrade. You might
want to enable the controller as themaster controller from theMaster ControllerMode drop-down
list.

Fast SSID Change

Choose to enable or disable access to the controller management interface fromwireless clients.
Because of IPsec operation, management via wireless is only available to operators logging in
across WPA or Static WEP.

Master Controller Mode

Wireless management is not available to clients attempting to log in via an IPsec WLAN.Wireless Management
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DescriptionField

Choose to enable or disable symmetric tunneling mode. With symmetric mobility tunneling,
the controller provides inter-subnet mobility for clients roaming from one access point to another
within a wireless LAN. The client traffic on the wired network is directly routed by the foreign
controller. If a router has Reverse Path Forwarding (RPF) enabled (which provides additional
checks on incoming packets), the communication is blocked. Symmetric mobility tunneling
allows the client traffic to reach the controller designated as the anchor, even with RPF enabled.

All controllers in a mobility group must have the same symmetric tunneling mode.

For symmetric tunneling to take effect, you must reboot.

Symmetric Tunneling Mode

Use the ACL Counters drop-down list to enable or disable ACL counters. The values per ACL
rule can be viewed for each controller.

ACL Counters

Enter the operator-defined RF mobility group name in the Default Mobility Domain Name text
box.

Default Mobility Domain Name

Specify the delay between tries for clients attempting to join another access point. With this
guest tunneling N+1 redundancy feature, the time it takes for a client to join another access
point following a controller failure is decreased because a failure is quickly identified, the
clients are moved away from the problem controller, and the clients are anchored to another
controller.

When you hover your mouse cursor over the field, the valid range of values appear.

Mobility Anchor GroupKeepAlive
Interval

Specify the number of queries to anchor before the client declares it unreachable.Mobility Anchor GroupKeepAlive
Retries

Enter the RF network group name from 8 to 19 characters. Radio ResourceManagement (RRM)
neighbor packets are distributed among access points within an RF network group. The Cisco
access points only accept RRM neighbor packets sent with this RF network name. The RRM
neighbor packets sent with different RF network names are dropped.

RF Network Name

Specify the time out for idle clients. The factory default is 300 seconds. When the timeout
expires, the client loses authentication, briefly disassociates from the access point, reassociates,
and reauthenticates.

Specify the timeout in seconds for the address resolution protocol. The factory default is 300
seconds.

User Idle Timeout

Specify the timeout in seconds.ARP Timeout

Select the Global TCP Adjust MSS check box to start checking the TCP packets originating
from the client, for the TCP SYN/ TCP ACK packets and MSS value and reset it to the
configured value on the upstream and downstream side.

Global TCP Adjust MSS

When this check box is selected, the AP will not broadcast local SSIDs or allow access to any
of the Ethernet ports.

Disable local access

Select this check box to create out-of-box RF profiles for both the radios along with out-of-box
AP group.

Out of Box
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DescriptionField

Choose enable or disableWeb Auth Proxy Redirect Mode if a manual proxy configuration is
configured on the browser of the client; all web traffic going out from the client is destined for
the PROXY IP and PORT configured on the browser.

Web Auth Proxy Redirect Mode

Enter the Web Auth Proxy Redirect Port. The default ports are 8080 and 3128. The range is
from 0 to 65535.

Web Auth Proxy Redirect Port

Enter the AP Retransmit Count and Intervals. The AP Retransmit Count default value is 5 and
the range is from 3 to 8. The AP Retransmit Interval default value is 3. The range is from 2 to
5.

AP Retransmit Count

AP Retransmit Interval

From the Global IPV6 Config drop-down list, choose Enabled or Disabled.Global IPv6 Config

Choose Dot1x System Authentication Control check box to enable or disable 802.1xDot1x System Authentication
Control

Enter the HTTP profiling port number. This allows custom http port configuration.HTTP Profiling Port

Controller > System > Global CDP Configuration

Cisco Discovery Protocol (CDP) is a device-discovery protocol that runs on all Cisco network equipment.
Each device sends identifying messages to a multicast address, and each device monitors the messages sent
by other devices. CDP is enabled on the Ethernet and radio ports of the bridge by default.

The following table describes the Template Detail fields in Configuration > Templates > Features and
Technologies > Controller > System > Global CDP Configuration.

Table 67: Controller > System > Global CDP Configuration Template

DescriptionField

Choose enable or disable CDP on the controller. This configuration cannot be applied on WiSM2
controllers.

CDP on controller

Choose to enable or disable CDP on the access points.Global CDP on APs

Enter the time in seconds at which CDP messages are generated. The default is 60.Refresh-time Interval

Enter the time in seconds before the CDP neighbor entry expires. The default is 180.Holdtime

Enter which version of the CDP protocol to use. The default is v1.CDPAdvertisement Version

Select the slots of Ethernet interfaces for which you want to enable CDP. CDP for Ethernet Interfaces
fields are supported for Controller Version 7.0.110.2 and later.

Ethernet Interface Slot

Select the slots of Radio interfaces for which you want to enable CDP. CDP for Radio Interfaces fields
are supported for Controller Version 7.0.110.2 and later.

Radio Interface Slot
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Controller > System > QoS Profiles

The following table describes the Template Detail fields in Configuration > Templates > Features and
Technologies > Controller > System > QoS Profiles.

Table 68: Controller > System > QoS Profiles Template

DescriptionField

All have a default of 0 or Off.NotePer-User Bandwidth Contracts

The average data rate for non-UDP traffic.Average Data Rate

The peak data rate for non-UDP traffic.Global CDP on APs

The average data rate for UDP traffic.Average Real-time Rate

The peak data rate for UDP traffic.Burst Real-time Rate

The Air QoS configurations are applicable for controller Version 7.0 and earlier.NoteOver-the-Air QoS

The maximum air bandwidth available to clients. The default is 100%.MaximumQoS RFUsage per AP

The depth of queue for a class of client. The packets with a greater value are dropped at the access
point.

QoS Queue Depth

Wired QoS Protocol

Choose 802.1P to activate 802.1P priority tags or None to deactivate 802.1P priority flags.Wired QoS Protocol

Choose 802.1P priority tag for a wired connection from 0 to 7. This tag is used for traffic and
CAPWAP packets.

802.1P Tag

Controller > System > SNMP Community

Use this option to create or modify a template for configuring SNMP communities on controllers. SNMP
communities only apply to SNMPv1 and v2c. SNMPv3 uses usernames and passwords.

For basic information about creating this template, see the Creating Feature-Level Configuration Templates
section in the Cisco Prime Infrastructure 3.1 User Guide.

When you enter the SNMP Community information, if you set the Access Mode option to Read Only, then
after applying this template, Prime Infrastructure will only have read access to the controller.

Controller > System > Traffic Stream Metrics QoS

Traffic stream metrics are a series of statistics about VoIP over your wireless LAN and informs you of the
QoS of the wireless LAN. These statistics are different than the end-to-end statistics provided by VoIP systems.
End-to-end statistics provide information on packet loss and latency covering all the links comprising the call
path. However, traffic stream metrics are statistics for only the WLAN segment of the call. Because of this,
system administrators can quickly determine whether audio problems are being caused by the WLAN or by
other network elements participating in a call. By observing which access points have impaired QoS, system
administrators can quickly determine the physical area where the problem is occurring. This is important when
lack of radio coverage or excessive interference is the root problem.
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Four QoS values (packet latency, packet jitter, packet loss, and roaming time), which can affect the audio
quality of voice calls, are monitored. All the wireless LAN components participate in this process. Access
points and clients measure the metrics, access points collect the measurements and then send them to the
controller. The access points update the controller with traffic stream metric information every 90 seconds,
and 10 minutes of data is stored at one time. The Prime Infrastructure queries the controller for the metrics
and displays them in the Traffic Stream Metrics QoS Status. These metrics are compared to threshold values
to determine their status level and if any of the statistics are displaying a status level of fair (yellow) or degraded
(red), the administrator investigates the QoS of the wireless LAN.

For the access points to collect measurement values, traffic stream metrics must be enabled on the controller.

The Traffic Stream Metrics QoS Controller Configuration page shows several QoS values. An administrator
can monitor voice and video quality of the following:

• Upstream delay

• Upstream packet loss rate

• Roaming time

• Downstream packet loss rate

• Downstream delay

Packet Loss Rate (PLR) affects the intelligibility of voice. Packet delay can affect both the intelligibility and
conversational quality of the connection. Excessive roaming time produces undesired gaps in audio.

There are three levels of measurement:

• Normal: Normal QoS (green)

• Fair: Fair QoS (yellow)

• Degraded: Degraded QoS (red)

System administrators should employ some judgment when setting the green, yellow, and red alarm levels.
Some factors to consider are:

• Environmental factors including interference and radio coverage that can affect PLR.

• End-user expectations and system administrator requirements for audio quality on mobile devices (lower
audio quality can permit greater PLR).

• Different codec types used by the phones have different tolerance for packet loss.

• Not all calls are mobile-to-mobile; therefore, some have less stringent PLR requirements for the wireless
LAN.

Controller > System > User Roles

Use this option to create or modify a template for configuring user roles. User roles determine how much
bandwidth the network can use. Four QoS levels (Platinum, Bronze, Gold, and Silver) are available for the
bandwidth distribution to Guest Users. Guest Users are associated with predefined roles (Contractor, Customer,
Partner, Vendor, Visitor, Other) with respective bandwidth configured by the Admin. These roles can be
applied when adding a new Guest User.

For basic information about creating this template, see the Creating Feature-Level Configuration Templates
section in the Cisco Prime Infrastructure 3.1 User Guide.
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Controller > WLANs > WLAN Configuration
WLAN templates allow you to define various WLAN profiles for application to different controllers.

You can configure multiple WLANs with the same SSID. This feature enables you to assign different Layer
2 security policies within the same wireless LAN. When you deploy the WLAN Configuration templates, the
controllers configured with Interface/Interface Group, selected RADIUS servers, LDAP servers, ACL name
with rules, and Ingress interface appear in the Template Deployment - Prepare and Schedule page.

Note

These restrictions apply when configuring multiple WLANs with the same SSID:

• WLANs with the same SSID must have unique Layer 2 security policies so that clients can make a
WLAN selection based on information advertised in the beacons and probes. These are the available
Layer 2 security policies:

• None (open WLAN)

• Static WEP or 802.1

• CKIP

• WPA/WPA2

• Broadcast SSIDmust be enabled on theWLANs that share an SSID so that the access points can generate
probe responses for these WLANs.

• FlexConnect access points do not support multiple SSIDs.

The following topics describe the fields on Configuration > Templates > Features and Technologies >
Controller > WLANs > WLAN Configuration:

• Controller > WLANs > WLAN Configuration > General

• Controller > WLANs > WLAN Configuration > Security

• Controller > WLANs > WLAN Configuration > QoS

• Controller > WLANs > WLAN Configuration > Advanced

• Controller > WLANs > WLAN Configuration > HotSpot

Controller > WLANs > WLAN Configuration > General

The following table describes the Template Detail fields in Configuration > Templates > Features and
Technologies > Controller > WLANs > WLAN Configuration > General.
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Table 69: Controller > WLANs > WLAN Configuration > General

DescriptionField

Select the check box to indicate whether or not this WLAN is a wired LAN.

Specify if you want guest users to have wired guest access from an Ethernet connection
designated and configured for guest access. Wired guest access ports might be available in a
guest office or specific ports in a conference room and accounts are added to the network
using the Lobby Ambassador portal. (The egress or ingress interface configurations are
applicable for wired LAN only.

Note

Use the Type drop-down list to choose the type of the wired LAN.

• Guest LAN—Indicates that this wired LAN is a guest LAN. If you select the Guest LAN option,
you need to select an Egress interface that has not already been assigned to any guest LAN.

• Remote LAN—Indicates that this wired LAN is a remote LAN.

Wired LAN

Enter a name in the Profile Name text box that identifies the WLAN or the guest LAN. Do not use any
spaces in the name entered.

Profile Name

Enter the name of the WLAN SSID. An SSID is not required for a guest LAN.

WLANswith the same SSIDmust have unique Layer 2 security policies so that clients canmake aWLAN
selection based on information advertised in the beacons and probes.

SSID

Select the Enable check box for the Status field.Status

Select the check box to give the WLAN an identifier.

Use theWlan Id text box to enter the WLAN identifier (an integer).

Configure Wlan Id

Modifications you make in the Security tab appear after you save the template.Security Policies

Set the WLAN policy to apply to All (802.11a/b/g/n), 802.11a only, 802.11g only, 802.11b/g only, or
802.11a/g only.

Radio Policy

Choose the available names of interfaces created by the Controller > Interfaces module.Interface/Interface Group

Select the Enable check box to enable the multicast VLAN feature.

From the Multicast VLAN Interface drop-down list, choose the appropriate interface name. This list is
automatically populated when you enable the multicast VLAN feature.

Multicast VLAN

Select to activate SSID broadcasts for this WLAN.Broadcast SSID

Controller > WLANs > WLAN Configuration > Security

The following table describes the Template Detail fields in Configuration > Templates > Features and
Technologies > Controller > WLANs > WLAN Configuration > Security.
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Table 70: Controller > WLANs > WLAN Configuration > Security

DescriptionField

Layer 2

No Layer 2 security selected.

• FT Enable—Select the check box to enable fast transition (FT) between access points.

Fast transition is not supported with FlexConnect mode.Note

Over the DS—Select the check box to enable or disable the fast transition over a distributed system (DS).

Reassociation Timeout—Time in seconds after which fast transition reassociation times out. The default is 20
seconds, and the valid range is 1 to 100.

To enable Over the DS or Reassociation Timeout, you should enable fast transition.

None

WEP 802.1X data encryption type:

• 40/64 bit key

• 104 bit key

• 152 bit key

802.1X

Static WEP encryption fields:

• Key sizes: Not set, 40/64, 104, and 152 bit key sizes.

• Key Index: 1 to 4.

• Encryption Key: Encryption key required.

• Key Format: ASCII or HEX.

• Allowed Shared Key Authentication—Select the check box to enable shared key authentication.

Regardless of the format you choose, for security reasons, only ASCII is visible on the WLC (and the Prime
Infrastructure). For this reason, you cannot use a template to replicate the configuration on a second controller
during auto provisioning. You should set the key format again in the template in case a discovered template is
applied to another device.

Static WEP

Use this setting to enable both staticWEP and 802.1X policies. If this option is selected, staticWEP and 802.1X
fields are displayed at the bottom of the page.

Static WEP encryption fields:

• Key sizes: Not set, 40/64, 104, and 152 bit key sizes.

• Key index: 1 to 4.

• Encryption Key: Enter encryption key.

• Key Format: ASCII or HEX.

• Allowed Shared Key Authentication—Select the check box to enable.

• 802.1 Data Encryption: 40/64 bit key, 104 bit key, 152 bit key.

Static
WEP-802.1X
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DescriptionField

Cisco Key Integrity Protocol (CKIP). A Cisco access point advertises support for CKIP in beacon and probe
response packets. CKIP can be configured only when Aironet IE is enabled on the WLAN.

CKIP is not supported on 10xx APs.Note

When selected, these CKIP fields are displayed.

• Key size: Not set, 40, or 104.

• Key Index: 1 to 4

• Encryption Key: Specify encryption key.

• Key Format: ASCII or HEX.

Regardless of the format you choose, for security reasons, only ASCII is visible on the WLC (and
Prime Infrastructure). For this reason, you cannot use a template to replicate the configuration on a
second controller during auto provisioning. You should set the key format again in the template in
case a discovered template is applied to another device.

Note

MMHMode—Select the check box to enable.

Key Permutation—Select the check box to enable.

CKIP

Select to filter clients by MAC address.

The ability to join a controller without specification within a MAC filter list is only supported on
mesh access points.

Note

For releases prior to 4.1.82.0, mesh access points do not join the controller unless they are defined
in the MAC filter list.

Note

You might want to disable the MAC filter list to allow newly added access points to join the controller. Before
enabling the MAC filter list again, you should enter the MAC addresses of the new access points.

MAC Filtering

Choose the desired type of authentication key management. The choices are 802.1X, CCKM, or PSK.

If you choose PSK, you must enter the shared key and type (ASCII or hexadecimal).Note

Regardless of the format you choose, for security reasons, only ASCII is visible on the WLC (and
Prime Infrastructure). For this reason, you cannot use a template to replicate the configuration on a
second controller during auto provisioning. You should set the key format again in the template in
case a discovered template is applied to another device.

Note

Authentication
Key Management

Layer 3

Choose between None and VPN Pass Through.

The VPN passthrough option is not available for the 2106 or 5500 series controllers.Note

Layer 3 Security
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DescriptionField

You can modify the default staticWEP (web authentication) or assign specific web authentication (login, logout,
login failure) pages and the server source.

1. To change the static WEP to passthrough, select theWeb Policy check box and choose the Passthrough
option from the drop-down list. This option allows users to access the network without entering a username
or password.

An Email Input check box appears. Select this check box if you want users to be prompted for their email
address when attempting to connect to the network.

1. Select theWebAuth on MAC Filter Failure radio button so that when clients fail on MAC filter, they are
automatically switched to WebAuth.

The WebAuth on Mac Filter Failure option works only when the Layer 2 Mac Filtering option is
enabled.

Note

1. To specify custom web authentication pages, unselect the Global WebAuth Configuration Enable check
box.

When the Web Auth Type drop-down list appears, choose one of the following options to define the web login
page for the wireless guest users:

• Default Internal—Displays the default web login page for the controller. This is the default value.

• CustomizedWebAuth—Displays customweb login, login failure, and logout pages.When the customized
option is selected, three separate drop-down lists for login, login failure, and logout page selection appear.
You do not need to define a customized page for all three of the options. ChooseNone from the appropriate
drop-down list if you do not want to display a customized page for that option.

• These optional login, login failure, and logout pages are downloaded to the controller as webauth.tar files.

• External—Redirects users to an external server for authentication. If you choose this option, you must
also enter the URL of the external server in the URL text box.

External web auth is not supported for 2106 and 5500 series controllers.Note

• You can select specific RADIUS or LDAP servers to provide external authentication in the Security >
AAA page.

The RADIUS and LDAP servers must be already configured to have selectable options in the
Security > AAA page. You can configure these servers in the RADIUS Authentication Servers
page and TACACS+ Authentication Servers page.

Note

If you selected External as the Web Authentication Type, choose Security > AAA, and choose up to three
RADIUS and LDAP servers using the drop-down lists.

Repeat this process if a second (anchor) controller is being used in the network.

Web Policy

AAA Server

Field Reference for Configuration Pages
72

Field Reference for Configuration Pages
Controller > WLANs > WLAN Configuration > Security



DescriptionField

Select to send the client authentication request through the dynamic interface that is set on the WLAN. When
you enable the Radius Server Overwrite Interface option, the WLC sources all RADIUS traffic for a WLAN
using the dynamic interface configured on that WLAN.

You cannot enable Radius Server Overwrite Interface when Diagnostic Channel is enabled.Note

The Radius Server Overwrite Interface option is supported in controller Version 7.0.x and later.Note

Select the Enable check box, then use the drop-down lists in the RADIUS and LDAP servers section to choose
authentication and accounting servers. This selects the default RADIUS server for the specified WLAN and
overrides the RADIUS server that is configured for the network. If all three RADIUS servers are configured
for a particular WLAN, server 1 has the highest priority, and so on.

If no LDAP servers are chosen here, Prime Infrastructure uses the default LDAP server order from the database.

Radius Server
Overwrite
Interface

Select to enable interim update for RADIUS Server Accounting. If you have selected this check box, specify
the Interim Interval value. The range is 180 to 3600 seconds, and the default value is 0.

The Interim Interval can be entered only when Interim Update is enabled.Note

Interim Update

Select the Local EAP Authentication check box if you have an EAP profile already configured that you want
to enable. Local EAP is an authentication method that allows users and wireless clients to locally authenticate.
It is designed for use in remote offices that want to maintain connectivity to wireless clients when the backend
system becomes disrupted or the external authentication server goes down.

Local EAP
Authentication

When you enable AAAOverride, and a client has conflicting AAA and controller WLAN authentication fields,
client authentication is performed by the AAA server. As part of this authentication, the operating systemmoves
clients from the default Cisco WLAN Solution to a VLAN returned by the AAA server and predefined in the
controller interface configuration (only when configured for MAC filtering, 802.1X, and/or WPA operation).
In all cases, the operating system also uses QoS and ACL provided by the AAA server, as long as they are
predefined in the controller interface configuration. (This VLAN switching by AAA override is also referred
to as identity networking.)

For instance, if the corporate WLAN primarily uses a management interface assigned to VLAN 2, and if AAA
override returns a redirect to VLAN 100, the operating system redirects all client transmissions to VLAN 100,
regardless of the physical port to which VLAN 100 is assigned.

When AAA override is disabled, all client authentication defaults to the controller authentication parameter
settings, and authentication is only performed by the AAA server if the controller WLANs do not contain any
client-specific authentication parameters.

The AAA override values might come from a RADIUS server, for example.

Allow AAA
Override

Controller > WLANs > WLAN Configuration > QoS

The following table describes the Template Detail fields in Design > Configuration > Feature Design >
Features and Technologies > Controller > WLANs > WLAN Configuration > QoS.
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Table 71: Controller > WLANs > WLAN Configuration > QoS

DescriptionField

Choose Platinum (voice), Gold (video), Silver (best effort), or Bronze (background). Services
such as VoIP should be set to gold while nondiscriminating services such as text messaging can
be set to bronze.

Quality of Service (QoS)

Data rates on a per-user basisOverride Per-User Rate
Limits

Define the average data rate for TCP traffic per user or per SSID by entering the rate in kbps in the
Average Data Rate text box. A value of 0 imposes no bandwidth restriction on the profile.

Average Data Rate

Define the peak data rate for TCP traffic per user or per SSID by entering the rate in kbps in the
Burst Data Rate text box. A value of 0 imposes no bandwidth restriction on the profile. The Burst
Data Rate should be greater than or equal to the Average Data Rate. Otherwise, the QoS policy
may block traffic to and from the wireless client.

Burst Data Rate

Define the average real-time rate for UDP traffic per user or per SSID by entering the rate in kbps
in the Average Real-Time Rate text box. A value of 0 imposes no bandwidth restriction on the
profile.

Average Real-Time Rate

Define the peak real-time rate for UDP traffic per user or per SSID by entering the rate in kbps in
the Burst Real-Time Rate text box. A value of 0 imposes no bandwidth restriction on the profile.
The Burst Real-Time Rate should be greater than or equal to the Average Real-Time Rate. Otherwise,
the QoS policy may block traffic to and from the wireless client.

Burst Real-Time Rate

Data rates on a per SSID basisOverride Per-SSID Rate
Limits

Define the average data rate TCP traffic per user or per SSID by entering the rate in kbps in the
Average Data Rate text box. A value of 0 imposes no bandwidth restriction on the profile.

Average Data Rate

Define the peak data rate for TCP traffic per user or per SSID by entering the rate in kbps in the
Burst Data Rate text box. A value of 0 imposes no bandwidth restriction on the profile. The Burst
Data Rate should be greater than or equal to the Average Data Rate. Otherwise, the QoS policy
may block traffic in the WLANs.

Burst Data Rate

Define the average real-time rate for UDP traffic per user or per SSID by entering the rate in kbps
in the Average Real-Time Rate text box. A value of 0 imposes no bandwidth restriction on the
profile.

Average Real-Time Rate

Define the peak real-time rate for UDP traffic per user or per SSID by entering the rate in kbps in
the Burst Real-Time Rate text box. A value of 0 imposes no bandwidth restriction on the profile.
The Burst Real-Time Rate should be greater than or equal to the Average Real-Time Rate. Otherwise,
the QoS policy may block traffic in the WLANs.

Burst Real-Time Rate

Choose Disabled, Allowed (so clients can communicate with the WLAN), or Required (to make
it mandatory for clients to have WMM enabled for communication).

WMM Policy
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DescriptionField

Select to enable support on Cisco 7920 phones.

If you wantWLAN to support older versions of the software on 7920 phones, select the 7920 Client
CAC check box to enable it. The Call Admission Control (CAC) limit is set on the access point
for newer versions of software.

7920 AP CAC

Controller > WLANs > WLAN Configuration > Advanced

The following table describes the Template Detail fields in Configuration > Templates > Features and
Technologies > Controller > WLANs > WLAN Configuration > Advanced.

Table 72: Controller > WLANs > WLAN Configuration > Advanced

DescriptionField

Select to enable FlexConnect local switching. If you enable FlexConnect local switching, the FlexConnect
access point handles client authentication and switches client data packets locally.

FlexConnect local switching is only applicable to the Cisco 1130/1240/1250 series access points. It is not
supported with L2TP or PPTP authentications, and it is not applicable to WLAN IDs 9 to 16.

VLAN ID—Enter a valid value between 1 to 4094 for VLAN Id. This field shows up only when you select
Guest LAN from the LAN Type drop-down list in the WLAN Configuration > General tab.

FlexConnect Local
Switching

Select to enable FlexConnect local authentication.

Local authentication is useful where you care unable to maintain the criteria of a remote office setup of
minimum bandwidth of 128 kbps with the roundtrip latency no greater than 100 ms and the maximum
transmission unit (MTU) no smaller than 500 bytes. In local switching, the authentication capabilities are
present in the access point itself. Thus local authentication reduces the latency requirements of the branch
office.

Local authentication can only be enabled on the WLAN of a FlexConnect AP that is in local
switching mode.

Note

Local authentication is not supported in the following scenarios:

• Guest authentication cannot be performed on a FlexConnect local authentication enabled WLAN.

• RRM information is not available at the controller for the FlexConnect local authentication enabled
WLAN.

• Local RADIUS is not supported.

• Once the client has been authenticated, roaming is supported after the WLC and the other FlexConnects
in the group are updated with the client information.

FlexConnect Local
Auth

When you enable hybrid-REAP local switching, theLearn Client IPAddress check box is enabled by default.
However, if the client is configured with Fortress Layer 2 encryption, the controller cannot learn the client IP
address, and the controller periodically drops the client. Disable this option so that the controller maintains
the client connection without waiting to learn the client IP address. The ability to disable this option is supported
only with hybrid-REAP local switching; it is not supported with hybrid-REAP central switching.

Learn Client IP
Address
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DescriptionField

Choose to enable the diagnostic channel feature or leave it disabled. The diagnostic channel feature allows
you to troubleshoot problems regarding client communication with aWLAN.When initiated by a client having
difficulties, the diagnostic channel provides the most robust communication methods with the fewest obstacles
to communication.

Diagnostic Channel

Select to enable support for Aironet information elements (IEs) for this WLAN. If Aironet IE support is
enabled, the access point sends an Aironet IE 0x85 (which contains the access point name, load, number of
associated clients, and so on) in the beacon and probe responses of this WLAN, and the controller sends
Aironet IEs 0x85 and 0x95 (which contains the management IP address of the controller and the IP address
of the access point) in the reassociation response if it receives Aironet IE 0x85 in the reassociation request.

Aironet IE

Select the IPv6 check box. You can configure IPv6 bridging and IPv4 web auth on the same WLAN.IPv6

Select to set the maximum time a client session can continue before requiring reauthorization.Session Timeout

Choose to enable or disable coverage hold detection (CHD) on this WLAN. By default, CHD is enabled on
allWLANs on the controller. If you disable CHD on aWLAN, a coverage hole alert is still sent to the controller,
but no other processing is done to mitigate the coverage hole. This feature is useful for guest WLANs where
highly mobile guests are connected to your network for short periods of time.

Coverage Hole
Detection

The Override Interface ACL drop-down list provides a list of defined access control lists (ACLs). Upon
choosing an ACL from the list, the WLAN associates the ACL to the WLAN. Selecting an ACL is optional,
and the default for this field is None.

Override Interface
ACL

You can configure peer-to-peer blocking per WLAN rather than applying the status to all WLANs. From the
Peer to Peer Blocking drop-down list, choose one of the following:

• Disable—Peer-to-peer blocking is disabled, and traffic is bridged locally whenever possible.

• Drop—The packet is discarded.

• Forward Up Stream—The packet is forwarded on the upstream VLAN, and the decision is made about
what to do with the packet.

For locally switched clients, the Forward Up Stream is same as Drop from 7.2.x version of
controllers.

Note

If FlexConnect local switching is enabled for the WLAN, which prevents traffic from passing through the
controller, this drop-down list is dimmed.

Peer-to-peer blocking does not apply to multicast traffic.Note

Peer to Peer
Blocking

Choose one of the following options:

• Disabled—Disables the Wi-Fi Direct Clients Policy for the WLAN and deauthenticates all Wi-Fi Direct
capable clients. The default is Disabled.

• Allow—Allows the Wi-Fi Direct clients to associate with an infrastructure WLAN.

• Not-Allow—Disallows the Wi-Fi Direct clients from associating with an infrastructure WLAN.

Wi-Fi Direct Client Policy is applicable to WLANs that have APs in local mode only.Note

The Wi-Fi Direct Clients Policy is applicable for controller Version 7.2.x. and later.Note

Wi-Fi Direct Clients
Policy
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Select the check box if you want to enable automatic client exclusion. If you enable client exclusion, you must
also set the timeout value in seconds for disabled client machines. Client machines are excluded by MAC
address, and their status can be observed. A timeout setting of 0 indicates that administrative control is required
to reenable the client.

When session timeout is not set, it implies that an excluded client remains and does not timeout
from the excluded state. It does not imply that the exclusion feature is disabled.

Note

Client Exclusion

Enter the maximum number of clients to be associated in a WLAN in the Maximum Clients text box. The
valid range is from 0 to 7000. The default value is 0.

A value of 0 allows unlimited number of clients to be associated with a WLAN.Note

Passive Client

Enable dynamic anchoring of static IP clients by selecting the Static IP Tunneling check box.Static IP Tunneling

This feature enables access points to detect the establishment, termination, and failure of voice calls and then
report them to the controller and Prime Infrastructure. It can be enabled or disabled per WLAN.

When media session snooping is enabled, the access point radios that advertise this WLAN snoop for Session
Initiation Protocol (SIP) voice packets. Any packets destined to or originating from port number 5060 are
considered for further inspection. The access point tracks whetherWi-Fi Multimedia (WMM) and non-WMM
clients are establishing a call, already on an active call, or in the process of ending a call and then notify the
controller of any major call events.

Media Session
Snooping

Select the KTS based CAC check box to enable KTS-based CAC support per WLAN.

WLC supports TSPEC-based CAC and SIP-based CAC. But there are certain phones that work with different
protocols for CAC, which are based on the KTS (Key Telephone System). For supporting CACwith KTS-based
SIP clients, WLC should understand and process the bandwidth request message from those clients to allocate
the required bandwidth on the AP radio, in addition to handling and sending certain other messages, as part
of this protocol.

The KTS CAC configuration is only supported by Cisco 5508, 7500,WISM2, and 2500 controllers
that run controller software Release 7.2.x. This feature is not supported by Cisco 4400 series
controllers.

Note

KTS based CAC

Choose SNMP NAC or Radius NAC. SIP errors that are discovered generate traps that appear on the client
troubleshooting and alarms screens. The controller can integrate with the NAC appliance in out-of-band mode,
where the NAC appliance remains in the data path only until clients have been analyzed and cleaned.
Out-of-band mode reduces the traffic load on the NAC appliance and enables centralized NAC processing.

NAC State
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Off-Channel Scanning Defer is essential to the operation of RRM, which gathers information about alternate
channel choices such as noise and interference. Additionally, Off-Channel Scanning Defer is responsible for
rogue detection. Devices that need to defer Off-Channel Scanning Defer should use the sameWLAN as often
as possible. If there are many of these devices (and the possibility exists that Off-Channel Defer scanning
could be completely disabled by the use of this feature), you should implement an alternative to local AP
Off-Channel Scanning Defer, such as monitor access points, or other access points in the same location that
do not have this WLAN assigned.

Assignment of a QoS policy (bronze, silver, gold, and platinum) to a WLAN affects how packets are marked
on the downlink connection from the access point regardless of how they were received on the uplink from
the client. UP=1,2 is the lowest priority, and UP=0,3 is the next higher priority. The marking results of each
QoS policy are as follows:

• Bronze marks all downlink traffic to UP=1.

• Silver marks all downlink traffic to UP=0.

• Gold marks all downlink traffic to UP=4.

• Platinum marks all downlink traffic to UP=6.

Set the Scan Defer Priority by clicking the priority argument, and set the time in milliseconds in the Scan
Defer Interval text box. Valid values are 0 to 60000. The default value is 100 milliseconds.

Scan Defer Priority

In 802.11a/n and 802.11b/g/n networks, lightweight access points broadcast a beacon at regular intervals,
which coincides with the Delivery Traffic Indication Map (DTIM). After the access point broadcasts the
beacon, it transmits any buffered broadcast and multicast frames based on the value set for the DTIM period.
This feature allows power-saving clients to wake up at the appropriate time if they are expecting broadcast
or multicast data.

Normally, the DTIM value is set to 1 (transmit broadcast andmulticast frames after every beacon) or 2 (transmit
after every other beacon). For instance, if the beacon period of the 802.11a/n or 802.11b/g/n network is 100
ms and the DTIM value is set to 1, the access point transmits buffered broadcast and multicast frames 10 times
per second. If the beacon period is 100 ms and the DTIM value is set to 2, the access point transmits buffered
broadcast and multicast frames 5 times per second. Either of these settings might be suitable for applications,
including VoIP, that expect frequent broadcast and multicast frames.

However, the DTIM value can be set as high as 255 (transmit broadcast and multicast frames after every 255th
beacon) if all 802.11a/n or 802.11b/g/n clients have power save enabled. Because the clients have to listen
only when the DTIM period is reached, they can be set to listen for broadcasts and multicasts less frequently,
resulting in longer battery life. For instance, if the beacon period is 100 ms and the DTIM value is set to 100,
the access point transmits buffered broadcast and multicast frames once every 10 seconds, allowing the
power-saving clients to sleep longer before they have to wake up and listen for broadcasts and multicasts,
resulting in longer battery life.

Many applications cannot tolerate a long time between broadcast and multicast messages, resulting in poor
protocol and application performance. We recommend a low DTIM value for 802.11a/n and 802.11b/g/n
networks that support such clients.

Under DTIM Period, enter a value from 1 to 255 in the 802.11a/n and 802.11b/g/n fields. The default value
is 1 (transmit broadcast and multicast frames after every beacon).

DTIM Period
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Select the check box to override DHCP server,. Another field appears where you can enter the IP address of
your DHCP server. For someWLAN configurations, this is required. Three valid configurations are as follows:

• DHCP Required and a valid DHCP server IP address—All WLAN clients obtain an IP address from the
DHCP server.

• DHCP is not required and a valid DHCP server address—All WLAN clients obtain an IP address from
the DHCP server or use a static IP address.

• DHCP not required and DHCP server IP address 0.0.0.0—All WLAN clients are forced to use a static
IP address. All DHCP requests are dropped.

You cannot choose to require a DHCP address assignment and then enter a DHCP server IP address.

DHCP Server

Select to enable signature generation for the 802.11 management frames transmitted by an access point
associated with this WLAN. Signature generation makes sure that changes to the transmitted management
frames by an intruder are detected and reported.

MFP Signature
Generation

ChooseEnabled,Disabled, orRequired for configuration of individualWLANs of a controller. If infrastructure
MFP is not enabled, this drop-down list is unavailable.

The Enabled parameter is the same as the Optional parameter that you choose from the MFP Client
Protection drop-down list in the WLC graphical user interface.

Note

Client-side MFP is only available for those WLANs configured to support Cisco Compatible
Extensions (version 5 or later) clients, and WPA2 must first be configured.

Note

MFP Client
Protection

Enter a value from 1 to 255 beacon intervals. The controller sends a DTIM packet for this WLAN based on
what is entered as an interval.

The DTIM configuration is not appropriate for guest LANs.Note

DTIM Period

Select to enable or disable profiling of all the clients that are associated with the WLAN.

Client profiling is not supported with FlexConnect local authentication.Note

Client profiling is configurable only when you select the DHCP Address Assignment check box.Note

Local Client
Profiling

Choose the mobility type from the following options:

• None—Configures the WLAN with simple IP.

• Mixed—Configures the WLAN with simple IP and PMIPv6.

• PMIPv6—Configures the WLAN with only PMIPv6.

PMIP Mobility

Controller > WLANs > WLAN Configuration > HotSpot

Mobile Concierge is a solution that enables 802.1X capable clients to interwork with external networks. The
Mobile Concierge feature provides service availability information to clients and can help them to associate
available networks.

The services offered by the network can be broadly classified into two protocols:

• 802.11u MSAP
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• 802.11u HotSpot 2.0

The following guidelines and limitations apply to Mobile Concierge:

• Mobile Concierge is not supported on FlexConnect Access Points.

• 802.11u configuration upload is not supported. If you perform a configuration upgrade and upload a
configuration on the controller, the HotSpot configuration on the WLANs is lost.

To create Mobile Concierge (802.11u) Groups, choose Configuration > Templates > Features and
Technologies > Controller> WLANs > WLAN Configuration > Hot Spot.

The following table describes the Template Detail fields in Configuration > Templates > Features and
Technologies > Controller > WLANs > WLAN Configuration > HotSpot.

Table 73: Controller > WLANs > WLAN Configuration > HotSpot

DescriptionField

802.11u Configurations

802.11u General Parameters

Select to enable 802.11u on the WLAN.

• From the drop-down list, in the HESSID field, enter the Homogenous Extended Service Set
Identifier value. The HESSID is a 6-octet MAC address that identifies the homogeneous ESS.

802.11u Status

Select to enable this WLAN to provide Internet services.Internet Access

Choose one of the following network types that best describes the 802.11u you want to configure on
this WLAN:

• Private Network
• Private Network with Guest Access
• Chargeable Public Network
• Free Public Network
• Emergency Services Only Network
• Personal Device Network
• Test or Experimental
• Wildcard

Network Type

Choose the authentication type that you want to configure for the 802.11u parameters on this network:

• Not configured
• Acceptance of Terms and Conditions
• Online Enrollment
• HTTP/HTTPS Redirection

Network Auth Type

Choose the IPv4 address type from the drop-down list.IPv4 Address Type

Choose the IPv6 address type from the drop-down list.IPv6 Address Type

Others
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Enter the following details:

• OUI name
• Is Beacon
• OUI Index

Select Add to add the OUI (Organizationally Unique Identifier) entry to this WLAN.

• In the group box,

OUI List

Enter the following details:

• Domain Name—The domain name operating in the 802.11 access network.
• Domain Index—Select the domain index from the drop-down list.

Select Add to add the domain entry to this WLAN.

Domain List

Enter the following details:

• Realm Name—The realm name.
• Realm Index—The realm index.

Select Add to add the domain entry to this WLAN.

OUI List

Service Advertisements

Select to enable service advertisements. If you enabledMSAP in the previous step, you must provide
a server index. Enter the server index for this WLAN. The server index field uniquely identifies an
MSAP server instance serving a venue that is reachable through the BSSID.

MSAP (Mobility Services Advertisement Protocol) is designed to be used primarily bymobile devices
that are configured with a set of policies for establishing network services. These services are available
for devices that offer higher-layer services, or network services that are enabled through service
providers. Service advertisements useMSAP to provide services to mobile devices prior to association
to a Wi-Fi access network. This information is conveyed in a service advertisement. A single-mode
or dual-mode mobile device queries the network for service advertisements before association. The
device's network discovery and the selection function may use the service advertisements in its
decision to join the network.

MSAP

If you enabled MSAP, you must provide a server index. Enter the server index for this WLAN. The
server index field uniquely identifies an MSAP server instance serving a venue that is reachable
through the BSSID.

MSAP (Mobility Services Advertisement Protocol) is designed to be used primarily by
mobile devices that are configured with a set of policies for establishing network services.
These services are available for devices that offer higher-layer services, or network services
that are enabled through service providers. Service advertisements use MSAP to provide
services to mobile devices prior to association to aWi-Fi access network. This information
is conveyed in a service advertisement. A single-mode or dual-modemobile device queries
the network for service advertisements before association. The device's network discovery
and the selection function may use the service advertisements in its decision to join the
network.

Note

Server Index

HotSpot 2.0
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Choose to enable HotSpot2.HotSpot2 Enable

Enter the Domain ID to be sent in hotspot2.0.Domain ID

Enter the WLAN profile Name.OSEN enable/Open wlan
profile

Select the link status.WAN Link Status

The symmetric link status. For example, you can configure the uplink and downlink to have different
speeds or same speeds.

WAN Symmetric Link Status

The downlink speed. The maximum value is 4,194,304 kbps.Down Link Speed

The uplink speed. The maximum value is 4,194,304 kbps.Up Link Speed

Specify the following:

• Operator Name—Specify the name of the 802.11 operator.
• Operator Index—Select an operator index. The range is from 1 to 32.
• Language Code—An ISO-14962-1997 encoded string defining the language. This string is a
three character language code.

Select Add to add the operator details.

Operator Name List

Specify the following:

• IP Protocol—The IP protocol that you want to enable. The following options are ESP, FTP,
ICMP, and IKEV2.

• Port No—The port number that is enabled on this WLAN.
• Status—The status of the port.

Port Config List

In the Online Sign Up List group box, specify the following. Online Sign Up (OSU) is the process
by which a mobile device registers with a Service Provider (SP), which enables you to select a plan
to obtain network access and is provisioned with the credentials necessary to securely to connect to
a network.

• OSU Index—The OSU Index uniquely identifies an instance of OSU server configuration.
• Select a value from the OSU Index drop-down list.
• Language—Language defined for the OSU index. The language code can be a minimum of 2
and maximum of 3 characters.

• SP Name—Enter the Service Provider (SP) name for the OSU index. The range for SP Name
is 1 to 255 characters.

• Description—Enter the Service Provider (SP) description for the OSU index. The description
can be a maximum of 255 characters.

Operator Sign Up List
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Specify the following:

• OSU Index— You can add only those OSU index that have configured in the Online Sign Up
List. The OSU Index uniquely identifies an instance of OSU server configuration. Select a value
from the OSU Index drop-down list.

• IconName—The icon name is pre populated. Youmust download icon image fromConfiguration
> Network > Network Devices, then select System > Commands path. Configure the icon
configurations before downloading icons to Cisco WLC.

• From the Icon drop-down list, choose the downloaded icon name. You can download the icon
from ftp or tftp server to the controller.

Online Sign Up Icon
Filename

Specify the following:

• OSU Index—You can add only those OSU index which have been configured in the Online
Sign Up List.

• Primary Method—The primary and secondary value should be different. The primary value
represents the primary server method or the particular OSU index.

• Secondary Method—The secondary value represents the secondary server method for the
particular OSU index.

• Uniform Resource Identifier (URI)—This represents the URI for the particular OSU index.
• Network Access Identifier (NAI) —This represents the NAI for the particular OSU index.

Online Sign Up Other
Configurations

Controller > mDNS
Multicast DNS (mDNS) service discovery provides a way to announce and discover services on the local
network. mDNS performs DNS queries over IP multicast. mDNS supports zero configuration IP networking.

Follow these guidelines and limitations when creating mDNS templates:

• You cannot delete an mDNS service when it is mapped to one or more profiles.
• The length of the profile name and the services name can be a maximum 31 characters.
• The length of the service string can be a maximum 255 characters.
• You cannot delete the default profile (default-mdns-profile).
• You cannot delete profiles when they are mapped to interfaces, interface-groups, or WLANs.
• You cannot removemDNS services from a profile when they are mapped to an interface, interface-groups,
or WLANs. You can add new services.

• Whenever you create and apply any mDNS template, it overwrites existing configuration on controller.
• You cannot enable mDNS snooping for WLAN when FlexConnect local switching is enabled.
• You cannot attach mDNS profiles to interfaces when AP Management is enabled.

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Controller > mDNS > mDNS.

Table 74: Controller > mDNS > mDNS

DescriptionField

Use the fields in this tab to configure the global mDNS parameters and update theMaster Services database.Services Tab
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Select the check box to enable snooping of mDNS packets.

The controller does not support IPv6 mDNS packets even when you enable mDNS snooping.Note

MDNSGlobal Snooping

The mDNS query interval, in minutes, that you can set. This interval is used by WLC to send periodic
mDNS query messages to services that do not send service advertisements automatically after they are
started. The range is from 10 to 120 minutes. The default value is 15 minutes.

Query Interval(10-120)

A list of the supported services that can be queried.Master Services

Name of the mDNS service.Master Service Name

Unique string associated to an mDNS service. For example, _airplay._tcp.local. is the service string
associated to AppleTV.

Service String

Select the check box to enable an mDNS query for a service.

Periodic mDNS query messages will be sent byWLC at configured Query Interval for services
only when the query status is enabled; otherwise, service should automatically advertised for
other services where the query status is disabled (for example AppleTV).

Note

Query Status

Use this tab to view the mDNS profiles configured on the controller and create newmDNS profiles. After
creating a new profile, you must map the profile to an interface group, an interface, or a WLAN.

Clients receive service advertisements only for the services associated with the profile. The controller
gives the highest priority to the profiles associated to interface groups, followed by the interface profiles,
then the WLAN profiles. Each client is mapped to a profile based on the order of priority.

By default, the controller has an mDNS profile, default-mdns-profile. You cannot delete this default
profile.

Profiles Tab

Name of the mDNS profile. You can create a maximum of 16 profiles.Profile Name

Select the services (using the check boxes) that you want to map to the mDNS profile.Mapped Services

Interfaces Templates Field Descriptions
The following topics contain field descriptions for pages found in Configuration > Templates > Features
and Technologies > Interfaces > Cellular:

• Interfaces > Cellular Profile

• Interfaces > GSM Profile

Interfaces > Cellular Profile

To deploy the cellular profile template on any UMTS, GSM, HSPA, HSPA+R7 modem, you should have the
GSM profile Interfaces > GSM Profile on the router.

Note
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The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Interfaces > Cellular > Cellular Profile.

Table 75: Interfaces > Cellular > Cellular Profile

DescriptionField

Validation Criteria

Choose the device type from the drop-down list.Device Type

Interface Details

Enter the name of the cellular interface. For fixed platform routers(8xx), it is always Cellular 0, for
modular platforms it is of the following form; Cellular slot/sub slot or port. For example, Cellular
0/1/0.

Cellular Interface

Choose one of the following options to configure the cellular interface:

• Primary WAN Interface
• Backup WAN Interface

Define this cellular interface as

Enter the primary interface details. This filed appears whenDefine this cellular interface as is set
to Backup WAN Interface.

Primary Interface

Enter a unique name to identify the route map.Route Map Tag

Enter a numeric value to define a route map condition.Sequence Number

The field value is set to Permit by default.Action

Enter the details of the access list that is associated with the route map to inspect an interesting
traffic. The ACL must be an extended ACL and can be named ACL also.

Access List

(Read only) The details are auto populated when a user enters the primary interface.First Hop Interface

Enter the IP address of the server to which connectivity is checked. This server is decided as part
of Service Level Agreement (SLA).

Target Address

Enter the timeout value in milliseconds for each ping request.Timeout Value

Enter the time interval at which the pings are generated.Time Interval

Dialer Configuration

Choose Yes to enable the persistent data connection.Persistent Data Connection

Enter the associate dialer. This field appears when Persistent Data Connection is set to yes.Associate Dialer

Enter the dialer idle timeout. This field appears when Persistent Data Connection is set to no.Dialer Idle Timeout

Chat-Script Configuration

Enter the string value that causes the cellular modem to dial out and initiate the traffic.Chat-Script Name
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Enter the timeout value used by the Cisco IOS device to wait for a response from the modem. The
call fails in case the Cisco IOS device does not get any expected response or no response from the
cellular modem.

Timeout Value

Interfaces > GSM Profile
The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Interfaces > Cellular > GSM Profile.

Table 76: Interfaces > Cellular > GSM Profile

DescriptionField

Choose device type from the drop-down list.Device Type

Template Detail

Enter the Cisco wireless WAN interface that support up to 16 profiles, but only one can be active at a
time. Generally profile number 1 is selected by default.

Cellular Interface

Enter the name that identifies the packet data network (PDN), that a mobile data user wants to
communicate with. Generally the APN is shared by the service provider, when a user buys a particular
cellular modem.

Access Point Name (APN)

Select the profile number from the drop-down list.Profile Number

Choose the Packet Data Protocol (PDP) type from the drop-down list. PDP offers a packet data connection
over which the user equipment such as mobiles and the network can exchange IP packets.

The PDP types available are:

• IPv4 (Default)
• PPP

PDP Type

Choose the type of authentication that is used by your service provider. CHAP authentication is more
secure than PAP authentication.

Authentication

For CHAP or PAP authentication, enter the username given to you by your Internet service provider
or network administrator.

UsernamePassword

Security Templates Field Descriptions
The following topics contain field descriptions for pages found in Configuration > Templates > Features
and Technologies > Security.

• Security > VPN Components
• Security > Zone Based Firewall
• Security > DMVPN
• Security > Easy VPN Remote
• Security > Easy VPN Server
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• Security > Easy VPN Server Proxy Setting
• Security > GETVPN-GroupMember
• Security > GETVPN-KeyServer
• Security > ScanSafe

Security > VPN Components
The following topics contain descriptions of the fields found in Configuration > Templates > Features and
Technologies > Security > VPN Components:

• Security VPN Components IKE Policies
• Security > VPN Components > IKE Settings
• Security > VPN Components > IPSec Profile
• Security > VPN Components > Pre-shared Keys
• Security > VPN Components > RSA-Keys
• Security > VPN Components > Transform Sets

Security VPN Components IKE Policies

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Security > VPN Components > IKE Policies.

Table 77: Security > VPN Components > IKE Policies

DescriptionField

IKE Policies

Enter the priority value of the IKE proposal. The priority value determines the order of the IKE proposals compared
by the two negotiating peers when attempting to find a common SA. If the remote IPsec peer does not support the
parameters selected in your first priority policy, the device tries to use the parameters defined in the policy with the
next lowest priority number.

The range is from 1 to 10000. The lower the number, the higher the priority.

Priority

Choose one of the following options from the Authentication drop-down list:

• PRE_SHARE—Authentication will be performed using pre-shared keys.
• RSA_SIG—Authentication will be performed using digital signatures.

Authentication

Choose the Diffie-Hellman (D-H) group used for driving a shared secret between two IPsec peers without transmitting
it to each other. A large modulus provides higher security but requires more processing time. The two peers must
have a matching modulus group. Choose one of the following options from Diffie-Hellman Group drop-down list:

• 1—Diffie-Hellman Group 1 (768-bit modulus).
• 2—Diffie-Hellman Group 2 (1024-bit modulus).
• 5—Diffie-Hellman Group 5 (1536-bit modulus; considered good protection for 128-bit keys).

D-H Group
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Choose one of the encryption algorithms from the Encryption drop-down list:

• AES-128—Encrypts according to the Advanced Encryption Standard (AES) using 128-bit keys.
• AES-192—Encrypts according to the AES using 192-bit keys.
• AES-256—Encrypts according to the AES using 256-bit keys.
• DES—Encrypts according to the Data Encryption Standard (DES) using 56-bit keys.
• 3DES—Encrypts three times using 56-bit keys. 3DES is more secure than DES but requires more processing
for encryption and decryption. However, it is less secure than AES.

A 3DES license is required to use this option.Note

Encryption

Choose the hash algorithm drop-down list. The hash algorithm creates a message digest that is used to ensure
message integrity. The options are:

• SHA (Secure Hash Algorithm)—Produces a 160-bit digest. SHA is more resistant to brute-force attacks than
MD5.

• MD5 (Message Digest 5)—Produces a 128-bit digest. MD5 uses less processing time than SHA.

Hash

Enter the lifetime of the SA, in seconds. When the lifetime is exceeded, the SA expires and must be renegotiated
between the two peers. As a general rule, the shorter the lifetime (up to a point), the more secure your IKE negotiations
will be. However, with longer lifetimes, future IPsec security associations can be set up more quickly than with
shorter lifetimes.

The range is from 60 to 86400. The default value is 86400.

IKE lifetime

Security > VPN Components > IKE Settings

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Security > VPN Components > IKE Settings.

Table 78: Security > VPN Components > IKE Settings

DescriptionField

IKE Settings

Select the Enable IKE check box to globally enable the IKE. (By default, the IKE is enabled.) You do
not have to enable IKE for individual interfaces, but it can be enabled globally for all the interfaces in
the router.

If you do not want to use the IKE for your IP Security (IPsec) implementation, you can disable the IKE
for all your IPsec peers. If you disable the IKE for one peer, you must disable it for all the IPsec peers.

Enable IKE

Select the Enable Aggressive Mode check box to enable the Internet Security Association and Key
Management Protocol (ISAKMP) aggressivemode. If you disable the aggressivemode, all the aggressive
mode requests to the device and all the aggressive mode requests made by the device will be blocked.

Enable Aggressive Mode

Field Reference for Configuration Pages
88

Field Reference for Configuration Pages
Security > VPN Components > IKE Settings



DescriptionField

Choose one option from the IKE identity drop-down list.

An ISAKMP identity is set whenever you specify pre-shared keys or RSA signature authentication. As
a general rule, you should set all the peers' identities in the sameway, either by IP address or by hostname.
The options are:

• IP Address—Sets the ISAKMP identity to the IP address of the interface that is used to communicate
to the remote peer during the IKE negotiations.

• DISTINGUISHED NAME—Sets the ISAKMP identity to the distinguished name (DN) of the
router certificate.

• HOSTNAME—Sets the ISAKMP identity to the hostname concatenated with the domain name
(for example, myhost.example.com).

IKE Identity

Enable the gateway to send the Dead Peer Detection (DPD) messages to the peer. DPD is a keepalive
scheme that allows the router to query the liveliness of its IKE peer.

Enable Dead Peer
Detection (DPD)

Specify the number of seconds between the DPD messages in the DPD Keepalive field. The range is
from 10 to 3600.

Keepalive

Specify the number of seconds between retries if the DPD messages fail during DPD Retry. The range
is from 2 to 60.

Retry

Security > VPN Components > IPSec Profile

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Security > VPN Components > IPSec Profile.

Table 79: Security > VPN Components > IPSec Profile

DescriptionField

Enter a name for this IPsec profile. When you edit a profile, you cannot edit the name of the IPsec profile.Name

Add a description for the IPsec profile that you are adding or editing.Description

Enter the transform set name. The transform set (see Security > VPNComponents > Transform Sets, page
2-87) encrypts the traffic on the tunnel.

Transform Sets

Enter the IPSec SA Lifetime to establish a new SA after the set period of time elapses. Enter the time in
seconds. The range is from 120 to 86400.

IPSec SALifetime (secs)

Security > VPN Components > Pre-shared Keys

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Security > VPN Components > Pre-shared Keys.

Table 80: Security > VPN Components > Pre-shared Keys

DescriptionField

Enter the IP address or the hostname of the remote peer.IP Address/Host Name
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Enter the subnet mask.Subnet Mask

Enter the pre-shared key, and reenter the key to confirm the pre-shared key.Pre-shared Key/Confirm Pre-shared Key

Security > VPN Components > RSA-Keys

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Security > VPN Components > RSA-Keys.

Table 81: Security > VPN Components > RSA-Keys

DescriptionField

Enter the name for the key pair.Label

Enter the key modulus value. If you want a modulus value from 512 to 1024, enter an integer value that is a
multiple of 64. If you want a value higher than 1024, you can enter 1536 or 2048. If you enter a value greater
than 512, key generation may take a minute or longer.

The modulus determines the size of the key. The larger the modulus, the more secure the key, but keys with
large modulus take longer to generate, and encryption/decryption operations take longer with larger keys.

Modulus

Select the type of the RSA key to be generated. The options are:

• general-keys
• usages-keys
• encryption
• signature

Type

Enable this field to generate RSA as an exportable key.Enable Exportable

Security > VPN Components > Transform Sets

A transform set represents a certain combination of security protocols and algorithms. During the IPsec security
association negotiation, the peers agree to use a particular transform set for protecting a particular data flow.
A transform set describes a particular security protocol with its corresponding algorithms.

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Security > VPN Components > Transform Sets.

Table 82: Security > VPN Components > Transform Sets

DescriptionField

Enter a name for the transform set.Name

Choose the ESP encryption algorithm used to encrypt the payload.ESP Encryption

Choose the ESP integrity algorithm used to check the integrity of the payload.ESP Integrity
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Choose the AH integrity from the drop-down list. The options are:

• AH with the MD5 (Message Digest 5) (a Hash-based Message Authentication Code [HMAC] variant)
authentication algorithm.

• AH with the SHA (Secure Hash Algorithm) (an HMAC variant) authentication algorithm.

AH Integrity

Enable or disable the IP compression with the Lempel-Ziv-Stac (LZS) algorithm.Compression

Choose the mode from the drop-down list. The options are:

• Transport—Encrypt data only. Transport mode is used when both endpoints support IPsec. Transport mode
places the authentication header or encapsulated security payload after the original IP header; thus, only the
IP payload is encrypted. This method allows users to apply network services such as quality-of-service (QoS)
controls to encrypted packets.

• Tunnel—Encrypt data and IP header. Tunnel mode provides stronger protection than transport mode. Because
the entire IP packet is encapsulated within AH or ESP, a new IP header is attached, and the entire datagram
can be encrypted. Tunnel mode allows network devices such as a router to act as an IPsec proxy for multiple
VPN users; tunnel mode should be used in those configurations.

Mode

Security > Zone Based Firewall
The following section contains descriptions of the fields in Configuration > Templates > Features and
Technologies > Security > Zone Based Firewall:

• Security > Zone Based Firewall > Policy Rules

Security > Zone Based Firewall > Policy Rules

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Security > Zone Based FireWall > Policy Rules.

Table 83: Security > Zone Based FireWall > Policy Rules

DescriptionElement

(Optional) Enter a name for the policy rule.Name

Select the source zone from the list of interface roles. The source zone specifies the name of the interface from
which the traffic is originating.

Source Zone

Select the destination zone from the list of interface roles. The destination zone specifies the name of the interface
to which the traffic is bound.

Destination Zone

Enter the source IP address of the inspected data. The valid parameters are:

• Any
• Other—If you select the Other option, you can choose a combination of IP address, Subnets, and Network
Objects.

Source
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Enter the destination IP address of the inspected data. The valid parameters are:

• Any
• Other—If you select the Other option, you can choose a combination of IP address, Subnet, and Network
Objects.

Destination

Select the service of the inspected data from the object selector. The valid parameters are:

• L3/4 Applications
• ACL-Based Application: TCP, UDP, ICMP

Service

Choose an action to perform on the traffic when the rule matches the condition. The rule matches when:

• The traffic Source IP matches the Source Rule condition.
• The traffic Destination IP matches the Destination Rule condition and the traffic Inspected Service matches
the Service Rule condition.

The action options are:

• Drop—Traffic that is handled by the drop action is silently dropped. The system does not send a notification
to the end host.

• Drop and Log—Traffic that is handled by the drop and log action is dropped and a syslog notification is
sent to the end host.

• Inspect—The inspect action offers state-based traffic control, the router maintains the connection or session
information for TCP and UDP traffic.

• Pass—This action allows the router to forward the traffic from one zone to another.
• Pass and Log—This action allows the router to forward traffic from one zone to another while creating a
syslog notification of the forwarded traffic.

Action

Security > DMVPN
The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Security > DMVPN.

Table 84: Security > DMVPN

DescriptionField

IPsec Information
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Select the Preshared Keys or Digital Certificates radio button.

• Preshared Keys—This allows a secret key to be shared between two peers
and be used by IKE during the authentication phase.

• Digital Certificates—Authentication method in which RSA key pairs are
used to sign and encrypt IKE key management messages. Certificates provide
nonrepudiation of communication between two peers, meaning that it can be
proven that the communication actually took place.

Authentication
Type

IKE Authentication

Enter the priority value of the IKE proposal. The priority value determines the order
of the IKE proposals compared by the two negotiating peers when attempting to
find a common security association (SA). If the remote IPsec peer does not support
the parameters selected in your first priority policy, the device tries to use the
parameters defined in the policy with the next lowest priority number.

Valid values range from 1 to 10000. The lower the number, the higher the priority.
If you leave this field blank, Security Manager assigns the lowest unassigned value
starting with 1, followed by 5, and continuing in increments of 5.

Priority

Choose the authentication type from the drop-down list.Authentication

Select the Diffie-Hellman (D-H) group. The D-H group is used for deriving a shared
secret between two IPsec peers without transmitting it to each other. A larger
modulus provides higher security but requires more processing time. The two peers
must have a matching modulus group. The options are:

1—Diffie-Hellman Group 1 (768-bit modulus).

2—Diffie-Hellman Group 2 (1024-bit modulus).

5—Diffie-Hellman Group 5 (1536-bit modulus, considered good protection for
128-bit keys, but group 14 is better). If you are using AES encryption, use this
group (or higher). The ASA supports this group as the highest group.

D-H Group

Choose the encryption algorithm from the drop-down list. The encryption algorithm
is used to establish the Phase 1 SA for protecting phase 2 negotiations:

AES-128—Encrypts according to the AES using 128-bit keys.

AES-192—Encrypts according to the AES using 192-bit keys.

AES-256—Encrypts according to the AES using 256-bit keys.

DES—Encrypts according to the DES using 56-bit keys.

3DES—Encrypts three times using 56-bit keys. 3DES is more secure than DES but
requires more processing for encryption and decryption. However, it is less secure
than AES. A 3DES license is required to use this option.

Encryption

Select the algorithm used in the IKE proposal. The hash algorithm creates a message
digest that is used to ensure message integrity. The options are:

• SHA (Secure Hash Algorithm)—Produces a 160-bit digest. SHA is more
resistant to brute-force attacks than MD5.

• MD5 (MessageDigest 5)—Produces a 128-bit digest.MD5 uses less processing
time than SHA.

Hash
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Specify the IKE lifetime value from 60 to 86400. The default is 86400. When the
lifetime is exceeded, the SA expires and must be renegotiated between the two
peers. As a general rule, the shorter the lifetime (up to a point), the more secure
your IKE negotiations will be. However, with longer lifetimes, future IPsec security
associations can be set up more quickly than with shorter lifetimes.

IKE Lifetime

Enter the transform set name. The transform set encrypts the traffic on the tunnel.NameEncryption Policy

Choose the algorithm used to encrypt the payload from the drop-down list. The
options are:

• ESP with the 128-bit AES encryption algorithm.
• ESP with the 192-bit AES encryption algorithm.
• ESP with the 256-bit AES encryption algorithm.
• ESP with the 168-bit DES encryption algorithm (3DES or Triple DES).
• Null encryption algorithm.

ESP Encryption

Choose the integrity algorithm used to check the integrity of the payload from the
drop-down list. The options are:

• ESP with the MD5 (HMAC variant) authentication algorithm.
• ESP with the SHA (HMAC variant) authentication algorithm.

ESP Integrity

Choose AH integrity from the drop-down list. The options are:

• AHwith theMD5 (Message Digest 5) (a Hash-basedMessage Authentication
Code [HMAC] variant) authentication algorithm.

• AHwith the SHA (Secure Hash Algorithm) (an HMAC variant) authentication
algorithm.

AH Integrity

Enable the IP compression to compress payload. IP compression with the
Lempel-Ziv-Stac (LZS) algorithm.

Compression

Choose the mode to transport the traffic.Mode

Topology and Routing
Information

Select the Spoke radio button to configure the router as a spoke in the topology.—Spoke

Select the Hub radio button to configure the router as a Hub in the topology.

Select one of the following routing protocols:

• EIGRP—Enter the AS number
• RIPV2
• Other

—Hub

Select the Create Dynamic Connection between Spokes check box to configure
the dynamic connection between spokes.

—Create dynamic
connection between
Spokes
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Multipoint GRE Interface
Information (These fields
appear only under Operate
> Device Work Center)

Choose the WAN interface that connects to the Internet from the drop-down list.—Select the Tunnel source
that connects to internet

Enter the IP address of the tunnel interface.—IP Address of this router’s
GRE Tunnel Interface

Enter the subnet mask.—Subnet Mask

NHRP and Tunnel
Parameters

Enter the NHRP Network ID. The network ID is a globally unique, 32-bit network
identifier from a nonbroadcast multiaccess (NBMA) network. The range is from 1
to 4294967295.

—Network ID

(Optional) Enter the number of seconds for which the Next Hop Resolution Protocol
(NHRP) NBMA addresses should be advertised as valid. The default value is 7200.

—Hold Time

Enter the authentication string.—NHRP Authentication
String

Enter the tunnel key. This is used to enable a key ID for a particular tunnel interface.
The range is from 0 to 4294967295.

—Tunnel Key

Enter the bandwidth. This is an optional field.—Bandwidth

(Optional) Enter the MTU size of IP packets that are sent on a particular interface.
The default value for Ethernet and the serial interface is 1500. The default value
varies depending upon the media type.

—IP MTU

Enter the TCP maximum segment size. The range is from 500 to 1460.—TCP Maximum Segment
Size

(Optional) Enter the physical interface.—Tunnel Source Interface

IPsec Information (These
fields appear only under
Operate > Device Work
Center)

Field Reference for Configuration Pages
95

Field Reference for Configuration Pages
Security > DMVPN



DescriptionField

Enter the name of the transform set.NameEncryption Policy

Choose the encryption algorithm. The algorithm used to encrypt the payload.ESP Encryption

Choose the integrity algorithm. The algorithm used to check the integrity of the
payload.

ESP Integrity

Choose the AH integrity from the drop-down list.AH Integrity

Choose appropriate option to enable or disable payload compression.Compression

Choose the mode. Indicates the mode to transport the traffic.Mode

NHS Server

Enter the cluster value to form a group having one or more hubs. The range is from
0 to 10.

Cluster IDCluster Support

Enter the maximum number of connections that can be active in a particular group
or cluster.

Max Connections

Select the priority of the particular hub in a cluster. Depends on the priority of the
spoke router that will form a tunnel with the hub devices.

Priority

Enter the IP address of the next-hop server.Next Hop Server

Enter the IP address of the hub's physical interface.—IP Address of Hub's
physical interface

Security > Easy VPN Remote
Cable modems, xDSL routers, and other forms of broadband access provide high-performance connections
to the Internet, but many applications also require the security of VPN connections that perform a high level
of authentication and encrypt the data between two endpoints. However, establishing a VPN connection
between two routers can be complicated and typically requires tedious coordination between network
administrators to configure the VPN parameters of the two routers.

The Cisco Easy VPN Remote feature eliminates much of this tedious work by implementing Cisco Unity
Client Protocol, which allows most of the VPN parameters to be defined at a Cisco IOS Easy VPN server.
This server can be a dedicated VPN device, such as a Cisco VPN 3000 series concentrator or a Cisco PIX
Firewall or a Cisco IOS router that supports the Cisco Unity Client Protocol.

After the Cisco Easy VPN server is configured, VPN connection is created with minimal configuration on a
Cisco device. When the Easy VPN remote initiates the VPN tunnel connection, the Cisco Easy VPN server
pushes the IPsec policies to the Easy VPN remote and creates the corresponding VPN tunnel connection.

Before you create an Easy VPN Client template, create the necessary ACLs, such as the identical addressing
ACL, the interesting traffic ACL, and the protected subnet ACL using the ACL template. For more information,
see Cisco Prime Infrastructure 3.1 User Guide.

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Security > Easy VPN Remote.
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Table 85: Security > Easy VPN Remote

DescriptionField

Easy VPN Remote Profile
Name and Interface
Configuration

Enter a name for the profile.—Profile Name

These are the interfaces that are included in the Easy VPN connection. All hosts
or subnets that are connected to these interfaces are a part of the VPN.

Inside InterfacesInterface and Server
Association

The WAN interface that connects to the Easy VPN server or concentrator.Outside Interfaces

This number provides a routable interface to selectively send traffic to different
Easy VPN concentrators and to the Internet.

Virtual Template
Number

Enter the Easy VPN server address. Up to ten IPv4 server addresses or server
hostnames can be added.

Easy VPN Servers

Enter the idle time for the server in seconds. The range is from 60 to 86400.
The default value is 60.

Idle Time

Each VPN Remote
Connection Settings

Choose the Client mode if you want the PCs and other devices on the router’s
inside networks to form a private network with private IP addresses. Network
Address Translation (NAT) and Port Address Translation (PAT) will be used
for routing the traffic. Devices outside the LAN will not be able to ping the
devices on the LAN or reach them directly.

ClientMode of Operation

Choose theNetwork Extensionmode if you want the devices that are connected
to the inside interfaces to have IP addresses that are routable and reachable by
the destination network. The devices at both ends of the connection will form
one logical network. PAT is automatically disabled, allowing the PCs and hosts
at both ends of the connection to have direct access to one another.

Network Extension

Choose the Network Extension Plus mode to request an IP address via mode
configuration and automatically assign it to an available loopback interface.
The IPsec SAs for this IP address are automatically created by Easy VPN
Remote. This IP address can be used for connecting to your router for remote
management and troubleshooting (ping, Telnet, and Secure Shell).

If the router is not running a Cisco IOS image that supports Easy
VPNRemote Phase 4 or later, you will not be able to set the Network
Extension Plus mode.

Note

Network Extension
Plus

Enter the ACL for the subnets that are not directly a part of the provided inside
interface.

—Protected Subnets ACL
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DescriptionField

Choose Auto if you want the VPN tunnel to be established automatically when
the Easy VPN configuration is delivered to the router configuration file.
However, you will not be able to control the tunnel manually.

AutoConnection Method

Choose Manual if you want to control when the VPN tunnel is established and
terminated.

Manual

Choose Interesting Traffic when you want the tunnel to be established only
when a specific traffic is sensed. This traffic is determined by the Interesting
Traffic ACL.

Interesting Traffic

EasyVPN Remote
Authentication
Mechanisms

Choose the device authentication method. The options are Pre-shared Key and
Digital Certificate.

—Primary Authentication

Enter the IPsec group name. This group name must match the group name
defined in the VPN concentrator or server. Obtain this information from your
network administrator.

Group NamePre Shared Key
Configuration

Select the Enable Encrypted Password check box to encrypt the password.Enable Encrypted
Password

Selecting pre-shared keys allows for a secret key to be shared between two peers
and be used by IKE during the authentication phase.

Pre Shared Key

Reenter the pre-shared Key to confirm the key.Confirm Pre Shared
Key

An authentication method in which RSA key pairs are used to sign and encrypt
IKE key management messages. Certificates provide nonrepudiation of
communication between two peers, meaning that it can be proved that the
communication actually took place.

—Digital Certificate

Extended Authentication

Enable XAuth is enabled by default on Cisco IOS devices.—Enable XAuth

Choose theUseWebAuthentication radio button to use the web authentication
method. Select theUse HTTPAuthorization for each client behind the Easy
VPN Remote check box to use the HTTP authorization.

—Use Web Authentication

Select the Save Credentials radio button and provide the username and
password. Reenter the password to confirm the password.

—Save Credentials

Select the Prompt for Credentials radio button and provide the credentials
when prompted.

—Prompt for Credential

EasyVPNRemote Firewall
Settings
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Select theEasyVPN through Firewall check box to enable the firewall settings.—Enable EasyVPN through
Firewall

Enter the Cisco Tunneling Control Protocol (cTCP) port number. This number
should match the cTCP port number on the EZVPN server. The range is from
1 to 65535. The default value is 10000.

—cTCP Port Number

Enter the Firewall Keepalive period, in seconds. The range is from 5 to 3600.
The default value is 5.

—NAT/Firewall Keepalive

Security > Easy VPN Server
The Easy VPN Server feature introduces server support for the Cisco VPN Client Release 3.x and later and
Cisco VPN hardware clients (such as the Cisco Integrated Services Routers and the Cisco Application-Specific
Routers). By using IP Security (IPsec), the centrally managed IPsec policies are pushed to the client device
by the server and helps end users minimize the configuration.

You can use the Dynamic Virtual Tunnel Interface or Dynamic Crypto Map method to configure an Easy
VPN server.

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Security > Easy VPN Server.

Table 86: Security > Easy VPN Server

DescriptionField

Validation Criteria

Choose Routers.—Device Type

Interface Configuration
Methods

Enter the interface name that connect to the WAN link.—Outside Interface

Enter the virtual template number and the IPsec profile name that you
created in the IPsec Profile template (see “Security > VPN Components >
IPSec Profile” section on page 2-85). Alternatively, you can enter the name
of an IPsec profile that already exists in the device. The IPsec profiles that
already exist in the device are displayed in the device view.

—Configure Dynamic Virtual
Tunnel Interface

Enter the Crypto map name and the transform set name that you created in
the Transform Set template (see “Security > VPNComponents > Transform
Sets” section on page 2-87). Alternatively you can enter the name of a
transform set that already exists in the device. The transform sets that
already exist in the device are shown in the device view.

—Configure Dynamic Crypto
Map

ISAKMP Settings

Select the client configuration address type from the drop down list.—Client Configuration Address
Type

Field Reference for Configuration Pages
99

Field Reference for Configuration Pages
Security > Easy VPN Server



DescriptionField

Enable the device to send dead peer detection (DPD) messages to Easy
VPN clients. If a client does not respond to the DPD messages, the
connection is terminated.

—Enable Dead Peer Detection

Specify the number of seconds between DPD messages in the Keepalive
Interval field. The range is from 10 to 3600.

—Keep Alive Interval

Specify the number of seconds between retries if the DPD messages fail.
The range is from 2 to 60.

—Retry Interval

AAA Group/User Policy

Enter the same AAA Group Method List profile name that you created in
the CLI template.

—AAA Group Method List

Enter the same AAA User Method List profile name that you created in
the CLI template.

—AAA User Method List

Select the Enable PKI download check box to obtain user attributes from
the AAA server and push to the remote device throughmode configuration.
The username that is used to get the attributes is retrieved from the remote
device certificate.

—Enable PKI download

Provide those ISAKMP group names that are not present locally in the
router but whose identity still needs to bematchedwith the ISAKMP profile.

—VPN groups

EasyVPN Group
Configuration

General

Enter an EasyVPN group name.Group NameGeneral

Select the Enable Encrypted Key check box to allow providing an
encrypted pre-shared key.

Enable Encrypted Key

Pre-shared keys allow for a secret key to be shared between two peers and
to be used by IKE during the authentication phase.

Pre-Shared Key

Reenter the pre-shared Key to confirm the key.Confirm Pre-SharedKey

Select the Assign IP Address to Remote Clients check box to create new
IP address pools for internal IP address allocation to clients.

Assign IP Address to
Remote Clients

Address Pool Configuration

Enter the starting IP address of the range, for example, 1.1.1.1.Starting IP Address

Enter the ending IP address of the range, for example, from 1.1.1.1 to
1.1.254.1.

Ending IP Address

Enter the subnet mask used by the connecting clients for local connectivity.Subnet Mask

Enter the maximum number of connections allowed in the configuration.
The range is from 1 to 5000.

Max Connections
Allowed
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Select the Enable XAuth check box to enable the extended authentication
methods.

Enable XAuthXAuth Options

Enter the banner that the server to pushes to the Easy VPN Remote.XAuth Banner

The maximum number of logins allowed per user. The range is from 1 to
10.

Max Logins allowed per
user

Select the Enable group lock for XAuth check box to perform an extra
authentication check during XAuth. The group name entered during XAuth
is compared by the server with the group name sent for the pre-shared key
device authentication. If they do not match, the server denies the connection.

Enable group lock for
XAuth

The client is allowed to store the password locally when prompted for its
XAuth credentials after receiving the policy during IKEmode configuration
on a subsequent connection to the server.

Save XAuth password
on router

DNS &WINS

Enter the name of the DNS domain to which a group belongs.—Domain Name

Select the Configure DNS Servers check box to specify the primary and
secondary DNS server for the group.

—Configure DNS Servers

Enter the IP address of the primary DNS server.—Primary DNS Server

Enter the IP address of the secondary DNS server.—Secondary DNS Server

Select the Configure WINS Server check box to specify the primary and
secondary WINS server for the group.

—Configure WINS Server

Enter the IP address of the primary WINS server.—Primary WINS Server

Enter the IP address of the secondary WINS server.—Secondary WINS Server

Split Tunneling

Enter the name of the ACL that represents the protected subnets for split
tunneling purposes.

—Split Tunnel ACL

Enter the domain names that must be tunneled or resolved to the private
network.

—Split DNS Configuration

Settings

Enter the URL that the remote device must use to get the configuration
from the server. The URL must be a nonnull-terminated ASCII string that
specifies the complete path of the configured file.

URLConfiguration Push

Enter the version of the configuration. The range is from 1 to 32767.Version

Assign backup gateways to push the list of backup gateways to the client
device. These gateways are used if a previous gateway fails.

Backup GatewaysBackup Configuration
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Select the Include local LAN check box to allow a nonsplit tunneling
connection to access the local subnetwork at the same time as the client.

Include local LANAccess Settings

Select the Enable perfect forward secrecy check box to notify the client
about whether perfect forward secrecy is required for any IPsec SA.

Enable perfect forward
secrecy

Select the Enable Firewall Are-U-There check box to enable the
Are-U-There firewall.

Enable Firewall
Are-U-There

Firewall and Proxy Settings

Enter the browser proxy profile as configured by the Easy VPN Browser
Proxy Template.

Browse Proxy Settings

Firewall Settings

Select the Enable cTCP check box to configure cTCP encapsulation for
Easy VPN. A maximum of 10 port numbers can be configured.

—Enable cTCP

Enter the cTCP port number.—cTCP Port Number(s)

Enter the cTCP keep alive period, in seconds. The range is from 5 to 3600.—

Security > Easy VPN Server Proxy Setting
The Easy VPN Server Proxy Setting feature allows you to specify the browser proxy settings that will be
pushed by the Easy VPN server to the EasyVPN remote and the Easy VPN clients. When you use the Easy
VPN Server Proxy Setting feature, you do not have to manually modify the proxy settings of the web browser
when you connect to the corporate network using the Cisco IOS VPN client or manually revert the proxy
settings when you disconnect from the network.

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Security > Easy VPN Server Proxy Setting.

Table 87: Security > Easy VPN Server Proxy Setting

DescriptionField

Enter a name for the browser proxy setting profile.Browser Proxy Name

• Choose theNo Proxy Server option if you do not want the clients in this group
to use proxy server.

• Choose theAutomatically Detect Proxy Settings option if you want the clients
in this group to automatically detect a proxy server when they use the VPN
tunnel.

• Choose theManual Configuration option tomanually configure a proxy server
for the clients in this group.

Proxy Server Settings Used by Client Browser

Enter the IP address of the proxy server.IP Address of Proxy Server

Enter the port number of the proxy server.Port
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DescriptionField

Enter the addresses of the hosts for whom the proxy server will not be used.Do not Use Proxy Server for Accessing the
Following Hosts

Select the check box to prevent the clients from using the proxy server for local
(LAN) addresses.

Bypass Proxy Serve for Local Addresses

Security > GETVPN-GroupMember
The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Security > GET VPN Group Member.

Table 88: Security > GET VPN Group Member

DescriptionField

Group Information

Enter the group ID. This is a unique identity for a
GETVPN group member. This can be a number or
an IP address.

—Group ID

Enter the group Name for the GETVPN group
member.

—Group Name

Use this anchored field and its associated pop-up
dialog box to specify the authentication type and
policies for this GETVPN group member.

—IKE Authentication
Policy

Select this radio button to select pre-shared Key as
the IKE authentication type. If you select this radio
button, you must provide the key in the Pre-Shared
Key field that is present immediately below the
button.

Pre-Shared Key

Enter the pre-shared key again to confirm. This field
is displayed only when you select Pre-Shared Key
as the authentication type.

Confirm Pre-Shared Key

Select this radio button to select Digital Certificate
as the IKE authentication type. If you choose this
authentication type, the router must have a digital
certificate issued by a Certificate Authority to
authenticate itself.

Digital Certificate
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Set the authentication policy’s negotiation priority
by entering a value from 1 to 10000, with 1 as the
highest priority. The priority value determines the
order of the IKE proposals compared by the two
negotiating peers when attempting to find a common
SA. If the remote IPsec peer does not support the
parameters selected in your first priority policy, the
device tries to use the parameters defined in the
policy with the next lowest priority number.

Priority

Select the authentication policy’s authentication type
from the list.

Authentication

Select the authentication policy’s Diffie-Hellman
group from the list.

D-H Group

Select the authentication policy’s encryption type
from the list.

Encryption

Select the authentication policy’s hash type from
the list

Hash

Enter the SA lifetime, in seconds.When the lifetime
is exceeded, the SA expires andmust be renegotiated
between the two peers. As a general rule, the shorter
the lifetime, the more secure your IKE negotiations
will be.

IKE Lifetime

Enter the WAN interface registration for the
GETVPN group member.

—WAN Interface

Traffic Details

Enter the Local Exception Policy ACL specifying
the traffic that the GETVPN group member must
send in clear text.

—Local Exception Policy
ACL

Enter the Fail Close ACL specifying the traffic that
must be allowed when GETVPN encryption fails.
If the Fail Close ACL feature is configured, all the
traffic passing via the groupmember will be dropped
until the group member is registered successfully.
After the group member is registered successfully
and SAs are downloaded, this feature is disabled
automatically.

—Fail Close ACL

Key Servers
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Enter the IP address or hostname of the primary
encryption key server. The primary key server is
responsible for creating and distributing group
policies to all group members and periodically
synchronizing with the secondary key servers.

—Primary Key Server

Use this edit table to specify the set of secondary
key servers. Enter them in order of priority, with the
highest priority at the top of the edit table. During
periods when the primary key server is down or
inaccessible, the accessible secondary key server
with the highest priority is elected to serve as the
primary key server.

—Secondary Key Servers

Select the Enable Passive SA check box to enable
the Passive SA mode on the group member.

—Enable Passive SA

Security > GETVPN-KeyServer
The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Security > GET VPN Key Server.

Table 89: Security > GET VPN Key Server

DescriptionField

Template Detail

Enter the group name for the GETVPN group member template.Group Name

Enter a unique identity for the GETVPN group member. This can be a number or an IP address. The
number range is from 0 to 2147483647.

Group ID

IKEAuthentication Policy

Click the Preshared Keys or Digital Certificates radio button:

• Preshared Keys—This allows for a secret key to be shared between two peers and to be used by
IKE during the authentication phase.

• Digital Certificates—An authentication method in which RSA key pairs are used to sign and
encrypt IKE key management messages. Certificates provide nonrepudiation of communication
between two peers, meaning that it can be proven that the communication actually took place.

Authorization Type

The priority value of the IKE proposal. The priority value determines the order of the IKE proposals
compared by the two negotiating peers when attempting to find a common SA. If the remote IPsec
peer does not support the parameters selected in your first priority policy, the device tries to use the
parameters defined in the policy with the next lowest priority number.

Valid values range from 1 to 10000. The lower the number, the higher the priority.

Priority
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Choose the encryption algorithm from the drop-down list. The encryption algorithm is used to establish
the Phase 1 SA for protecting Phase 2 negotiations:

• AES-128—Encrypts according to the AES using 128-bit keys.
• AES-192—Encrypts according to the AES using 192-bit keys.
• AES-256—Encrypts according to the AES using 256-bit keys.
• DES—Encrypts according to the DES using 56-bit keys.
• 3DES—Encrypts three times using 56-bit keys. 3DES is more secure than DES but requires more
processing for encryption and decryption. It is less secure than AES. A 3DES license is required
to use this option.

Encryption

The hash algorithm used in the IKE proposal. This algorithm creates a message digest that is used to
ensure message integrity. The options are:

• SHA (Secure Hash Algorithm)—Produces a 160-bit digest. SHA is more resistant to brute-force
attacks than MD5.

• MD5 (Message Digest 5)—Produces a 128-bit digest. MD5 uses less processing time than SHA.

Hash

The Diffie-Hellman group is used for deriving a shared secret between the two IPsec peers without
transmitting it to each other. A larger modulus provides higher security but requires more processing
time. The two peers must have a matching modulus group. The options are:

• 1—Diffie-Hellman Group 1 (768-bit modulus).
• 2—Diffie-Hellman Group 2 (1024-bit modulus).
• 5—Diffie-Hellman Group 5 (1536-bit modulus, considered good protection for 128-bit keys, but
group 14 is better). If you are using AES encryption, use this group (or higher). The ASA supports
this group as the highest group.

Diffie-Hellman Group

The lifetime of the SA, in seconds. When the lifetime is exceeded, the SA expires and must be
renegotiated between the two peers. As a general rule, the shorter the lifetime (up to a point), the more
secure your IKE negotiations will be. However, with longer lifetimes, future IPsec security associations
can be set up more quickly than with shorter lifetimes.

You can specify a value from 60 to 2147483647. The default is 86400.

Lifetime

Enter the name of the interface to which the crypto map must be associated.Registration Interface

Traffic Details

Choose an ACL for the traffic that must be excluded from encryption.Local Exception ACL

Choose an ACL for the traffic that must be sent in clear text until the group member registers with the
key server. If the Fail Close feature is configured, all the traffic passing via the group member will be
dropped until the group member is registered successfully. After the group member is registered
successfully and SAs are downloaded, this feature is disabled automatically.

Fail Close ACL

Key Server Information

Specify the primary key server IP address to which the client connects. The primary key server is
responsible for creating and distributing group policies to all group members and periodically
synchronizing with the secondary key servers. The server with the highest priority is elected as a
primary key server.

Primary Key Server
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Specify the secondary key server IP address to which the group member falls back when the primary
key server registration fails. A group member can be configured to register to any available key server
from a list of all the secondary key servers. Group member configuration determines the registration
order. The key server defined first is contacted first, followed by the second defined key server, and
so on. You can have a maximum of eight key servers for a group member.

Secondary Key Server

Migration

Use this option to enable the Passive SA mode on the group member. The Passive SA mode overrides
the receive-only SA option on the key server and encrypts all outbound traffic.

Enable Passive SA

Enter the group name for the GETVPN group member template.Group Name

Security > ScanSafe
Cisco ISR Web Security with Cisco Scansafe is a cloud-based Security as a Service (SaaS) that allows you
to scan the content of the HTTP and HTTPs traffic. When Cisco ISR Web Security with Cisco ScanSafe is
integrated with a router, the selected HTTP and HTTPS traffic is redirected to the ScanSafe cloud for content
scanning and malware detection.

When Cisco ISR Web Security with Cisco ScanSafe is enabled and the ISR is configured to redirect web
traffic to Cisco ISR Web Security with Cisco ScanSafe, the ISR transparently redirects HTTP and HTTPS
traffic to the ScanSafe proxy server based on the IP address and port. You can configure the ISR to relay web
traffic directly to the originally requested web server without being scanned by Cisco ISR Web Security with
Cisco ScanSafe.

Whitelisting Traffic

You can configure the ISR so that approved web traffic is not redirected to Cisco ISR Web Security with
Cisco ScanSafe for scanning. When you bypass this scanning, the ISR retrieves the content directly from the
originally requested web server without contacting Cisco ISR Web Security with Cisco ScanSafe. When it
receives the response from the web server, it sends the data to the client. This is called whitelisting traffic.

For more information on ScanSafe see Security Configuration Guide

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Security > ScanSafe.

Table 90: Security ScanSafe

DescriptionField

Server Information

Enter the IPv4 address or hostname of the primary ScanSafe server.Primary Server

Specify the HTTP port through which HTTP requests are to be redirected to the primary
server. By default, ScanSafe uses port 80 for the HTTP traffic. However, you can choose to
use different ports for each request type.

HTTP Port
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DescriptionField

Specify the HTTPS port to redirect the HTTPS requests to the primary server. By default,
ScanSafe uses port 443 for HTTPS traffic. However, you can choose to use different ports
for each request type.

HTTPS Port

Enter the IPv4 address or hostname of the secondary ScanSafe server.Secondary Server

Specify the HTTP port through which HTTP requests are to be redirected to the secondary
server. By default, ScanSafe uses port 80 for HTTP traffic.

HTTP Port (secondary)

Specify the HTTPS port through which HTTPS requests are to be redirected to the secondary
server. By default, ScanSafe uses port 443 for HTTPS traffic.

HTTPS Port

Specify the license key that the ISR sends to the ScanSafe proxy server to indicate the
organization from which the request originated. The license is a 16-byte hexadecimal key.

Scansafe License

Select the Encrypt License Info check box to encrypt the license information.Encrypt License Info

Specify the primary ScanSafe server timeout, in seconds. The ISR waits for the specified
timeout period before polling the ScanSafe proxy server to check its availability.

Server Timeout

Specify the primary ScanSafe session idle timeout, in seconds. If the primary server fails, the
ISR will use the secondary server as the active ScanSafe proxy server. The ISR automatically
falls back to the primary server as long as it is active for three consecutive timeout periods.

Session Timeout

Specify the source IPv4 address or interface name on which ScanSafe is enabled.Source Interface

Specify how the ISR should handle the incoming traffic when it cannot reach the configured
ScanSafe proxy servers. The options are Drop all traffic or Allow all traffic. Drop all traffic
is the default.

Router behavior when ScanSafe
server fail to respond

User Information

Enter a Global User when web authentication (webauth) is not configured under the router’s
ingress interface.

Global User

Enter a Global User Group when web authentication (webauth) is not configured on the
router’s egress interfaces.

Global User Group

Use the two edit tables to specify the user group information to be included or excluded during
exchanges with the ScanSafe tower. The user group information is used only when web
authentication (webauth) is configured on the router’s ingress and egress interfaces.

User Group Inclusion & Exclusion
Info

Select this option to send the whitelist information to the ScanSafe Tower and specify the
Safe URL, Safe User Agent, and Safe ACL information that is to be sent.

Notify Whitelist Info to ScanSafe
Tower

CLI Templates Field Descriptions
The following topics describe the fields used in the system CLI templates.

• 802.1X Change of Authorization-IOS
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• Access Layer-IOS
• Authentication Proxy-IOS
• Banner Configuration-IOS
• Certificate Authority-IOS
• Core Layer-IOS
• Crypto Map Configuration-IOS
• DNS Configuration-IOS
• DNS Configuration-NAM
• DNS Configuration-Nexus
• Distribution Layer-IOS
• EEM Environmental Variables-IOS
• Embedded Event Manager Configuration-IOS
• Enable Password-IOS
• GOLD Boot Level and Monitoring Test for Cat6k Devices-IOS
• GOLD Monitoring Test for Non Stack Devices-IOS
• GOLD Monitoring Test for Stack Enabled Devices-IOS
• Guest Users
• HTTP-HTTPS Server and WSMA Configuration-IOS
• MAC Trap Configuration
• Mediatrace-Responder-Configuration
• Medianet-PerfMon
• RADIUS Configuration-IOS
• Reload Configuration-IOS
• Reload Configuration-NAM
• Web User Configuration-NAM
• User Defined Protocol Configuration-NAM

802.1X Change of Authorization-IOS
Use this option to support RADIUS client configuration for dynamic authorization for switches.

The following table describes the Template Detail fields in Configuration > Templates > Features and
Technologies > Templates > CLI Templates > System Templates - CLI > 802.1X Change of
Authorization-IOS.

Table 91: CLI Templates > System Templates - CLI > 802.1X Change of Authorization-IOS

DescriptionField

Form View

DNShost name or IP address of the RADIUS server hostRADIUS client IP Address or Host Name

Specify the type of authorization (any, all, session key) the device must use for
RADIUS clients. The client must match the configured attributes for authorization.

Type of authorization the device uses for
RADIUS clients
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DescriptionField

Specify the authentication and encryption key to the RADIUS server.

The key is a text string that must match the encryption key used on the RADIUS
server. The leading spaces are ignored, but spaces within and at the end of the key
are used. If you use spaces in the key, do not enclose the key in quotation marks
unless the quotation marks themselves are part of the key

RADIUS Key shared between the device and
RADIUS clients

Specify the port number on which the device listens for RADIUS requests.

The port number should be from 0 to 65535. The default value is 1700.

Port on which the device listens for RADIUS
requests

Access Layer-IOS
Use this option to configure the platform, LAN Switch Universal Settings, Access Switch Global Settings,
Client Connectivity, and connect the devices to Distribution or WAN Router.

The following table describes the Template Detail fields in Configuration > Templates > Features and
Technologies > Templates > CLI Templates > System Templates - CLI > Access Layer-IOS.

Table 92: CLI Templates > System Templates - CLI > Access Layer-IOS

DescriptionField

Form View tab

Deploys the template only on the selected device type.

To avoid deployment issues, do not edit this field.Note

Device Type

Deploys the template only on the selected device OID.

To avoid deployment issues, do not edit this field.Note

Device OID

Enter the Switch number for Catalyst 2960-S and 3750-X Platform.Switch Number

LAN Switch Universal Configuration

Enter the hostname for the device to be configured.Host name

Enter the default domain name that the Cisco IOS software uses to complete
unqualified hostnames (names without a dotted-decimal domain name). Do not
include the initial period that separates an unqualified name from the domain name.

IP Domain-name

Enter the SNMP-server community read-only access (RO) to set up the community
access string to permit access to the Simple Network Management Protocol
(SNMP).

SNMP-server community RO

Enter the SNMP-server community read-write access (RW) to set up the community
access string to permit access to the Simple Network Management Protocol
(SNMP).

SNMP-server community RW

Enter theEnable Secret Password command to provide encryption automatically.Enable Secret Password
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DescriptionField

Enter the Username Admin Password.Username Admin Password

Enter the IP address of the TACACS server.IP Address of Tacacs Server

Enter the TACACS secret key to authenticate the switch to the TACACS server.TACACS Key

Enter the IP address of the NTP Server in order to keep the clocks in sync for
applications and other desktop processes.

NTP Server IP Address

Enter the time zone to comply with the newDaylight Saving Time (DST) changes.Time Zone

Select the number of hours behind or ahead from Coordinated Universal Time
(UTC).

Hours offset from UTC

Enter the number of minutes behind or ahead from Coordinated Universal Time
(UTC).

Minutes offset from UTC

Enter the Daylight Saving Time.Summer Time zone

Access Switch Global Settings and Client
Connectivity

Enter the voice VLAN to enable access ports to carry IP voice traffic from an IP
phone.

Voice VLAN

Enter the data VLAN to carry only user-generated traffic.Data VLAN

Configure Access Switch Global Settings

Enter the management VLAN for managing the switch from a remote location by
using protocols such as telnet, SSH, SNMP, syslog, and so forth.

Management VLAN

Enter the management IP address for discovering, monitoring, auditing, and
managing the IP address space used on a network.

Management IP Address

Enter the management subnet mask.Management Subnet Mask

Enter the IP address of the default router.Default Router IP Address

Other Settings

Select the interface type from the drop-down list.Interface Type to Configure Client Connectivity

Enter the starting interface number, for example, 0/1 for Gigabit Ethernet,1 for
PortChannel.

Start Interface Number

Enter the ending interface number, for example, 2.End Interface Number

Select the required option from the drop-down list.Connect to Distribution or WAN Router

Enter the Channel Group number to assign and configure an EtherChannel interface
to an EtherChannel group.

Channel Group Number
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DescriptionField

Select the Interface Type from the drop-down list.Interface Type for Connect to Distribution or
WAN Router

Enter the starting interface number, for example, 0/1 for Gigabit Ethernet,1 for
PortChannel.

Start Interface Number

Enter the ending interface number, for example, 2.End Interface Number

Enter the unused VLAN as native VLAN.Unused VLAN for Hopping

Authentication Proxy-IOS
Use this option to log in to the network or access the Internet using HTTP and helps you to deploy the
Authentication Proxy system-defined configuration template on Cisco IOS devices that have been configured
for VPN functionality.

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Templates > CLI Templates > System Templates - CLI > Authentication Proxy-IOS.

Table 93: CLI Templates > System Templates - CLI > Authentication Proxy-IOS

DescriptionField

Select the required option to enable, disable. If you do not want to make any change, select
No Change.

AAA Action

Select either TACACS+ or RADIUS as your first method of authorization. Select None if
you do not want to configure.

AAA Method1

Select either TACACS+ or RADIUS as your second method of authorization, based on your
selection in the first method. Select None if you do not want to configure.

AAA Method2

Timeout value. The default timeout value can be in the range from 1 to 2147483647. The
default value is 60.

Cache Timeout in Minutes

Select Enable or Disable to set or reset Banner display in the login page.

• If you select Enable, the router name is displayed in the login page.
• If you select Disable, then the router name is not displayed.

If you do not want to make any changes to the banner, select No Change.

Banner Action

Enter the text that you want displayed in the banner. If you enter the banner text, then this
text is displayed instead of the router name in the login page.

This is an optional field.

Banner Text
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DescriptionField

Select Enable or Disable an authentication proxy rule.

• If you select Enable, a named authentication proxy rule is created and associated with
access list.

• If you select Disable, the associated proxy rule is removed.

Select No Change if you do not want to make changes to the Authentication Proxy Rule
group of fields.

Authentication Proxy Rule Action

Enter a name for the authentication proxy rule.

The name can be up to 16 alphanumeric characters.

Authentication Proxy Rule Name

Enter a timeout value to override the default cache timeout.

This is an optional field. The overriding timeout value should be in the range of 1 and
2147483647.

Authentication Proxy Rule Overriding
Timeout

Enter a Standard Access list name or number to be used with the Authentication proxy.

This is an optional field.

Authentication Proxy Rule ACL
Number/Name

Select the required option to enable or disable AAA.New Model [AAA] Action

Banner Configuration-IOS
The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Templates > CLI Templates > System Templates - CLI > Banner Configuration-IOS.

Table 94: CLI Templates > System Templates - CLI > Banner Configuration-IOS

DescriptionField

Form View tab

Select the appropriate option to add or remove a message of the day banner. Select No Change if you are not
modifying an existing task, and you do not want to change the value in this field.

Motd Action

Enter message, if you select Add in Action field. When a user connects to the router, the message-of-the-day
(Motd) banner appears before the login prompt.

Motd Message

Select the appropriate option to add or remove an Exec banner. Select No Change if you are not modifying an
existing task, and you do not want to change the value in this field.

Exec Action

Enter message, if you select Add in Action field. After the user logs in to the router, the Exec banner or the
incoming banner will be displayed.

Exec Message

Select the appropriate option to add or remove an Incoming banner. SelectNo Change if you are not modifying
an existing task, and you do not want to change the value in this field.

Incoming Action

Enter message, if you select Add in Action field. After the user successfully logs in to the router, the Exec banner
or the incoming banner will be displayed.

IncomingMessage
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DescriptionField

Select the appropriate option to add or remove a Login banner. Select No Change if you are not modifying an
existing task, and you do not want to change the value in this field.

Login Action

Enter message, if you select Add in Action field. When a user connects to the router, the Motd banner (if
configured) appears first, followed by the login banner and prompts.

Login Message

Select the appropriate option to add or remove a Slip/PPP banner. Select No Change if you are not modifying
an existing task, and you do not want to change the value in this field.

Slip_PPP Action

Enter custom SLIP or PPP connection message, if you select Add in Action field. This is useful when legacy
client applications require a specialized connection string.

Slip_PPPMessage

Certificate Authority-IOS
This template provides manageability and scalability for IP security standards on VPN devices.

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Templates > CLI Templates > System Templates - CLI > Certificate Authority-IOS.

Table 95: CLI Templates > System Templates - CLI > Certificate Authority-IOS

DescriptionField

Form View tab

Select Enable or Disable to activate/deactivate Certificate Authority (CA).

• If you select Enable you can create or modify CA.
• If you select Disable, you can delete the CA.

Certificate Authority Action

Enter the CA name. This name is used to identify the Certificate Authority to be configured.

This name is the CA domain name.

Certificate Authority Name

• Select Enable to allow router to connect to the CA, using the URL specified in the Value
field.

• Select Disable, if you do not want to connect to the CA.
• Select No Change to leave the Enrollment URL field unchanged.

Enrollment URL Action

Enter the URL of the CA.

The URL should include any available nonstandard cgi-bin script location.

Enrollment URL Value

• Select Enable if the CA provides a Registration Authority (RA).
• Select Disable to disable the specified LDAP Server.
• Select No Change to leave the Enrollment Mode field unchanged.

Enrollment Mode Action

Enter the LDAP server of the CA, if your CA system provides an RA.

LDAP server contains the location of CRLs (certification revocation lists) and certificates.

Enrollment Mode LDAP Server

Field Reference for Configuration Pages
114

Field Reference for Configuration Pages
Certificate Authority-IOS



DescriptionField

Enter the wait period between certification request retries.

The wait period is from 1 to 60 minutes.

Select this option to set the default wait period to 1 minute.

Enrollment Retry Period in Minutes

Enter the certification request retry number.

The retry number must be from 1 to 100.

Select this option to set the default retry period to 1 minute.

Enrollment Retry Count Number

Select Enable to check the Certificate Revocation List.

If you select Disable, Certificate Revocation list is unchecked.

If you do not want to make any change, select No Change.

CRL Optional Action

Select an option to enable, disable or make no change to certificate query.

• If you select Enable, certificate query will be added to all trust points on the router.
• If you select Disable, the certificate will not be queried.

Certificate Query Action

Select an option to generate, delete or make no change to the RSA key pairs. This feature
allows you to configure a Cisco IOS router to have multiple key pairs.

Thus, the Cisco IOS software can maintain a different key pair for each identity certificate.

RSA Key pairs Action

Specify the key type:

• General Purpose—To generate a general purpose key pair that is used for both encryption
and signature.

• Usage—To generate separate usage key pairs for encrypting and signing documents.

RSA Key pairs Key Type

Choose the size of the key modulus in the range of 360 to 4096 for Signature Keys. Choosing
a key modulus greater than 512 may take a few minutes.

Enter number of modulus bits

Core Layer-IOS
Use this option to configure the Platform, LAN Switch Universal Settings, Core Switch Global Settings, IP
Multicast Routing, and connect the devices to Distribution Layer.

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Templates > CLI Templates > System Templates - CLI > Core Layer-IOS.

Table 96: CLI Templates > System Templates - CLI > Core Layer-IOS

DescriptionField

Form View tab

Configure LAN Switch Universal Setting

Enter the hostname of the LAN Switch Universal Configuration.Host name
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DescriptionField

Enter the default domain name that the Cisco IOS software uses to complete
unqualified hostnames (names without a dotted-decimal domain name). Do
not include the initial period that separates an unqualified name from the
domain name.

IP Domain-name

Enter the SNMP-server community read-only access (RO) to set up the
community access string to permit access to the Simple NetworkManagement
Protocol (SNMP).

SNMP-server community RO

Enter the SNMP-server community read-write access (RW) to set up the
community access string to permit access to the Simple NetworkManagement
Protocol (SNMP).

SNMP-server community RW

Enter the enable secret password command to provide encryption automaticallyEnable Secret Password

Enter the Username Admin Password.Username Admin Password

Enter the IP Address of the TACACS server.IP Address of Tacacs Server

Enter the TACACS secret key to authenticate the switch to the TACACS
server.

TACACS Key

Enter the IP address of the NTP Server in order to keep the clocks in sync for
applications and other desktop processes.

NTP Server IP Address

Enter the time zone to comply with the new Daylight Saving Time (DST)
changes.

Time Zone

Select the number of hours behind or ahead from Coordinated Universal Time
(UTC).

Hours offset from UTC

Enter the number of minutes behind or ahead from Coordinated Universal
Time (UTC).

Minutes offset from UTC

Enter the Daylight Saving Time.Summer Time zone

Configure the Core Switch Global Settings

Enter the Loopback-1 IP address.Loopback-1 IP Address

Enter the Loopback-2 IP address.Loopback-2 IP Address

Enter the autonomous system number to uniquely identify the network.Autonomous System Number

Enter the network address.Network Address

Enter the inverse mask.Inverse Mask

Enter the IP address of Rendezvous-point (RP), which acts as the meeting
place for sources and receivers of multicast data.

IP address of Rendezvous-point

Enter the access list number.Access List Number
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DescriptionField

Enter the multicast network address.Multicast Network

Enter the multicast inverse mask address.Multicast Inverse Mask

Other Setting

Enter the Multicast Source Discovery Protocol (MSDP) to allow multicast
sources for a group to be known to all rendezvous points (RPs) in different
domains.

MSDP Core Switch IP Address to Configure IP
Multicast Routing

Connecting to Distribution Layer

Enter the port channel number.Port Channel Number

Enter the port channel IP address.Port Channel IP Address

Enter the port channel subnet mask.Port Channel Subnet Mask

<Present as Port Channel Network Mask>

Enter the TenGigabitEthernet first interface number.TenGigabitEthernet First Interface Number

Enter the TenGigabitEthernet second interface number.TenGigabitEthernet Second Interface Number

Crypto Map Configuration-IOS
Use this option to configure IPSec on devices. You must configure the IKE and Transform configuration
before configuring this template, and it can be downloaded only to VPN-enabled devices

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Templates >CLI Templates > SystemTemplates - CLI >CryptoMapConfiguration-IOS.

Table 97: CLI Templates > System Templates - CLI > Crypto Map Configuration-IOS

DescriptionField

Form View tab

Select an option to add or remove the Cisco IOS configuration.Crypto Map Action

Enter the name for the crypto map.Crypto Map Name

Enter the number for the crypto map.

The value must be from 1 to 65535.

Map Number

Select the map type (manual or isakmp) for the crypto map.

• Manual - Manual keying is usually only necessary when a Cisco device is configured to encrypt traffic
to another vendor's device that does not support Internet Key Exchange (IKE).

• ISAKMP - The ISAKMP provides a framework for Internet key management and provides the specific
protocol support for negotiation of security attributes.

Map Type
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DescriptionField

Enter the description for the crypto map.Map Description

Enter the extended access list for crypto map.Crypto ACL

Enter the IPsec peer hostname or IP address to be associated with the crypto map.IPSec Peer

Enter the transform set name (see Security > VPN Components > Transform Sets) to be used with the crypto
map.

Transform Set Name

DNS Configuration-IOS
Use this option to configure Domain Name System (DNS) on Cisco IOS devices.

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Templates > CLI Templates > System Templates - CLI > DNS Configuration-IOS.

Table 98: CLI Templates > System Templates - CLI > DNS Configuration-IOS

DescriptionField

Form View tab

Enter the IPv4 Address/IPv6 Address of DNS name server(s) that you want to add.

Separate multiple addresses with commas.

If the device accepts only one DNS server, then the first address will be considered.

Add DNS Servers

Enter the IPv4 Address/IPv6 Address of DNS name server(s) that you want to remove.

Separate multiple addresses with commas.

Remove DNS Servers

Select this option to remove the domain names.

If you do not want to make any change, select No Change.

RemoveDomainName

Enter the IP addresses of DNS name server(s) that you want to remove.

Separate multiple addresses with commas.

Domain Name

Select to enable or disable IP DNS-based hostname-to-address translation.

If you do not want to make any change, select No Change.

Domain Lookup

Select to enable or disable or make no change to the CLNS NSAP option. If this option is enabled, any
packet with the specified CLNS NSAP prefix causes CLNS (Connectionless Network Service) protocol to
behave as if no route were found.

If you do not want to make any change, select No Change.

CLNS NSAP

Select to enable or disable or make no change to the OSPF (Open Shortest Path First) protocol option.

If you do not want to make any change, select No Change.

OSPF
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DescriptionField

Select an option to add, remove, or make no change to the domain list.

If you do not want to make any change, select No Change.

Domain List Action

Enter domain names to complete unqualified hostnames, or add to the existing list.

Separate multiple domain names with commas.

Do not include an initial period before domain names.

Domain List

DNS Configuration-NAM
Use this option to configure Domain Name System (DNS) on NAM category devices.

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Templates > CLI Templates > System Templates - CLI > DNS Configuration-NAM.

Table 99: CLI Templates > System Templates - CLI > DNS Configuration-NAM

DescriptionField

Form View tab

Enter the IPv4 Address addresses of DNS name server(s) that you want to add.

Separate multiple addresses with commas.

If the device accepts only one DNS server, then the first address will be considered.

Add DNS Servers

Select this option to remove the domain names.RemoveDomainName

Enter the IP addresses of DNS name server(s) that you want to remove.

Separate multiple addresses with commas.

Domain Name

Select to disable domain name servers.Disable Name Servers

DNS Configuration-Nexus
Use this option to configure Domain Name System - DNS on Nexus devices.

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies >Templates > CLI Templates > System Templates - CLI > DNS Configuration-Nexus.

Table 100: CLI Templates > System Templates - CLI > DNS Configuration-Nexus

DescriptionField

Form View tab
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DescriptionField

Enter the IPv4 Address/IPv6 Address of DNS name server(s) that you want to add.

Separate multiple addresses with commas.

If the device accepts only one DNS server, then the first address will be considered.

Add DNS Servers

Enter the IPv4 Address/IPv6 Address of DNS name server(s) that you want to remove.

Separate multiple addresses with commas.

Remove DNS Servers

Select this option to remove the domain names.Remove Domain Name

Enter the IP addresses of DNS name server(s) that you want to remove.

Separate multiple addresses with commas.

Domain Name

Select to enable or disable IP DNS-based hostname-to-address translation.

If you do not want to make any change, select No Change.

Domain Lookup

Select an option to add, remove, or make no change to the domain list.

If you do not want to make any change, select No Change.

Domain List Action

Enter domain names to complete unqualified hostnames, or add to the existing list.

Separate multiple domain names with commas.

Do not include an initial period before domain names.

Domain List

Distribution Layer-IOS
Use this option to configure the Platform, LAN Switch Universal Settings, Distribution Global Settings, and
connect the devices to Access Layer and LAN Core or WAN Router.

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Templates > CLI Templates > System Templates - CLI > Distribution Layer-IOS.

Table 101: CLI Templates > System Templates - CLI > Distribution Layer-IOS

DescriptionField

Form View tab

Deploys the template only on the selected device type.

Do not edit this field to avoid deployment issues.Note

Device Type

Deploys the template only on the selected device OID.

Do not edit this field to avoid deployment issues.Note

Device OID

Enter the Switch number.Switch Number

LAN Switch Universal Configuration
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Enter the hostname of the LAN Switch Universal Configuration.Host name

Enter the default domain name that the Cisco IOS software uses to complete
unqualified hostnames (names without a dotted-decimal domain name). Do not
include the initial period that separates an unqualified name from the domain name.

IP Domain-name

Enter the SNMP-server community read-only access (RO) to set up the community
access string to permit access to the Simple NetworkManagement Protocol (SNMP).

SNMP-server community RO

Enter the SNMP-server community read-write access (RW) to set up the community
access string to permit access to the Simple NetworkManagement Protocol (SNMP).

SNMP-server community RW

Enter the enable secret password command to provide encryption automatically.Enable Secret Password

Enter the Username Admin Password.Username Admin Password

Enter the IP address of the TACACS server.IP Address of Tacacs Server

Enter the TACACS secret key to authenticate the switch to the TACACS server.TACACS Key

Enter the IP address of the NTP Server in order to keep the clocks in sync for
applications and other desktop processes.

NTP Server IP Address

Enter the time zone to comply with the new Daylight Saving Time (DST) changes.Time Zone

Select the number of hours behind or ahead fromCoordinated Universal Time (UTC).Hours offset from UTC

Enter the number of minutes behind or ahead from Coordinated Universal Time
(UTC).

Minutes offset from UTC

Enter the Daylight Saving Time.Summer Time zone

DistributionGlobal Settings Configuration

Enter the Loopback-1 IP address.Loopback-1 IP Address

Enter the IP address of Rendezvous-point (RP), which acts as the meeting place for
sources and receivers of multicast data.

IP address of Rendezvous-point

Enter the multicast network address.Multicast Network Address

Enter the network address.Network Address

Enter the inverse mask address.Inverse Mask

Enter the autonomous system number to uniquely identify each network.Autonomous System Number

Other Setting

Enter the access list number.Access List Number

Connecting to Access Layer

Enter the data VLAN to carry only user-generated traffic.Data VLAN
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DescriptionField

Enter the voice VLAN to enable access ports to carry IP voice traffic from an IP
phone.

Voice VLAN

Enter the management VLAN for discovering, monitoring, auditing, and managing
the IP address space used on a network.

Management VLAN

Enter the unused VLAN as native VLAN to prevent hopping.Unused VLAN for Hopping

Enter the channel group number to assign and configure an EtherChannel interface
to an EtherChannel group.

Channel Group Number

Select the interface type from the drop-down list.Interface Type

Enter the TenGigabitEthernet first interface number.TenGigabitEthernet First Interface Number

Enter the TenGigabitEthernet second interface number.TenGigabitEthernet Second Interface Number

Enter the Dynamic Host Configuration Protocol (DHCP) IP Address to allocate the
network device an IP address.

DHCP Server IP Address

Enter the data VLAN IP address.Data VLAN IP Address

Enter the data VLAN IP mask.Data VLAN IP Mask

Enter the voice VLAN IP address.Voice VLAN IP Address

Enter the voice VLAN IP mask.Voice VLAN IP Mask

Enter the Management VLAN IP address.Management VLAN IP Address

Enter the Management VLAN IP mask.Management VLAN IP Mask

Connecting to LAN Core or WAN Router

Enter the port channel number.Port Channel Number

Enter the port channel IP address.Port Channel IP Address

Enter the port channel subnet mask.Port Channel Subnet Mask

Enter the network address.Network Address

Enter the network subnet mask.Network Subnet Mask

Select the interface type from the drop-down list.Interface Type

Enter the starting interface number for connecting to LAN Core or WAN router.Start Interface Number

Enter the ending interface number for connecting to LAN Core or WAN router.End Interface Number
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EEM Environmental Variables-IOS
Use this option to configure Embedded Event Manager (EEM) Environmental variables used by the EEM
TCL script policies on Cisco IOS devices.

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Templates > CLI Templates > System Templates - CLI > EEM Environmental
Variables-IOS.

Table 102: CLI Templates > System Templates - CLI > EEM Environmental Variables-IOS

DescriptionField

Form View tab

Select either:

• Add—to add one or more variables.

or

• Remove—to remove one or more variables.

Action

Enter the name for the variable.

Example:

my_counter

You can create a maximum of five variables at a time.

Variable Name

Enter the value for the variable.

Example:

15

Now the variablemy_counter will have the value 15.

Variable Value

Five variable names and variable values can be entered at one time. To enter more than five variable names
and values, the template must be redeployed.

Note

Embedded Event Manager Configuration-IOS
Use this option to configure Embedded Event Manager (EEM) scripts or applets on the Cisco IOS devices.

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Templates > CLI Templates > System Templates - CLI > Embedded Event Manager
Configuration-IOS.
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Table 103: CLI Templates > System Templates - CLI > Embedded Event Manager Configuration-IOS

DescriptionField

Form View tab

Select Register or Unregister to register or unregister a script or applet.EEM Configuration Action

Select either Script or Applet as the policy.

When you choose script as the policy type, enter the following fields:

• Create New Directory
• Directory Name
• Enter the Server Name
• Enter the Script File Location with Name

When you choose Applet as the policy type, enter the following fields:

• Enter the Applet Name
• Enter the Applet File Content

EEM Configuration Policy Type

Check this option if you want to create a new directory on the device to copy the script.

If you select this check box, the input given in the Directory Name text box is used to create a
new directory.

Create New Directory

Enter the absolute path of the directory where the file needs to be placed on the device.

Example:

disk0:/Testing

Here a new directory Testing is created in the device under the disk0 partition.

Ensure that the selected directory has enough space before the script files are copied.

Directory Name

Enter the TFTP server name.

The script file should be available in the TFTP boot folder.Note

Enter the Server Name

Use this option to enter the file location to upload the scripts to deploy on the device.

Ensure that you enter the absolute path along with the filename.

You can specify only single script file.Note

Enter the Script File Location

Enter the Applet Name if you have chosen Unregister as the EEM Configuration Action.Enter the Applet Name

Enter the Applet File Content if you have chosen Register as the EEM Configuration Action.Enter the Applet File Content

Enable Password-IOS
Use this option to configure the enable or secret password and enter into the enable mode on Cisco IOS
devices.

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Templates > CLI Templates > System Templates - CLI > Enable Password-IOS.
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Table 104: CLI Templates System Templates - CLI Enable Password-IOS

DescriptionField

Form View tab

Select an option to enable, disable, or make no change to the enable password.

If you do not want to make any change, select No Change.

Action

Enter the enable password.Enable Password

Set the Enable Password level. The level can be from 1 to15.

For a Cisco IOS device, it is advisable not to disable both Enable Password and Enable Secret password as
enabling the password will not allow the Cisco IOS device to go into the Enable mode. You can do this only if
you have the console password for the device.

If you have selected Enable Password as No Change in the Common Parameters pane, and selected Disable for
Enable Secret in the IOS Parameters pane, then Enable Secret Password is updated in the Device and Credentials
database.

If you have selected Enable Password as Disable in the Common Parameters pane, and selected No Change for
Enable Secret in the IOS Parameters pane, then Enable Password is updated in the Device and Credentials database.

Password Level

Select this option to encrypt the password.Encrypted

Select an option to enable, disable or make no change to the secret password.Secret Action

Enter the secret password.Secret Password

Set the password level. The level can be between 1 and 15.Level

Select this option to encrypt the password.Encrypted

GOLD Boot Level and Monitoring Test for Cat6k Devices-IOS
Use this option to configure GOLD Boot Level and Monitoring tests on Cat6k devices.

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Templates > CLI Templates > System Templates - CLI > GOLD Boot Level And
Monitoring Test for Cat6k Devices-IOS.

Table 105: CLI Templates > System Templates-CLI > GOLD Boot Level and Monitoring Test for Cat6k Devices-IOS

DescriptionField

Select either Enable to enable the actions or Disable to disable the actions.Gold Boot Level Configuration Action

Select either Complete to set the boot level to Complete or Minimal to set the boot
level to Minimal.

Gold Bootup Level
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DescriptionField

Select any of the following:

• Addinterval —To add an interval.
• Nointerval —To not to add an interval.

If you do not want to make any changes to the GOLD Monitoring Test Action, select
No Change.

GOLD Monitoring Test Action

Enter the Gold Monitoring Test Module Number that is in the selected device. You
can enter one or more module numbers separated by commas.

GOLD Monitoring Test Module Number

Select any of the following:

• All - Allows you to configure all diagnostic tests.
• Testnames —Allows you to manually enter the test names.
• TestRange —Allows you to enter a range for tests to be run.

Tests Details Action

Enter one or more test names separated by comma. Do not add space in between
commas. This field is mandatory if action is Testnames.

Test Names

Enter test ranges. This field is mandatory if action is TestRange.Range

Enter the number of days till which you require the tests to be run on the devices. The
number of days can be any value from 0 to 20.

No. of Days To Configure HealthMonitoring
Interval

Enter the hours, minutes and seconds frequency at which the tests should be run.Begin Time To Configure HealthMonitoring
Interval

Enter the millisecond frequency at which the tests should be run. You can enter any
value from 0 to 999 for the second.

Configuring Health Monitoring Interval in
Milliseconds

Select any of the following:

• Enable - To start the Health Monitoring tests.
• Disable - To stop the running Health Monitoring tests.

If you do not want to make any changes to the Health Monitoring test action, select
No Change.

Enable/Disable Health Monitoring
Diagnostics Test Action

GOLD Monitoring Test for Non Stack Devices-IOS
Use this option to configure GOLD monitoring tests on nonstack devices.

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Templates > CLI Templates > System Templates - CLI > GOLDMonitoring Test for
Non Stack Devices-IOS.
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Table 106: CLI Templates > System Templates - CLI > GOLD Monitoring Test for Non Stack Devices-IOS

DescriptionField

Select any of the following:

• Addinterval - To add an interval
• Nointerval - To not to add an interval

If you do not want to make any changes to the Non Stack Health Monitor Action, select No
Change.

Non Stack Health Monitor Action

Select any of the following:

• All - Allows you to configure all diagnostic tests.
• Testnames - Allows you to manually enter the test names.
• TestRange - Allows you to enter a range for tests to be run.

Non Stack Tests Details Action

GOLD Monitoring Test for Stack Enabled Devices-IOS
Use this option to configure GOLD Monitoring tests on stack-enabled devices.

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Templates > CLI Templates > System Templates - CLI > GOLDMonitoring Test for
Stack Enabled Devices-IOS.

Table 107: CLI Templates > System Templates - CLI > GOLD Monitoring Test for Stack Enabled Devices-IOS

DescriptionField

Select any of the following:

• Addinterval - To add an interval
• Nointerval - To not to add an interval

If you do not want to make any changes to the Stack Health Monitor Action, selectNo Change.

Stack Health Monitor Action

Enter the Switch ID. You can enter a single switch ID or a number of switch IDs separated by
comma. Example 1: Enter 2 if you want to include switch with ID 2. Example 2: Enter 3, 6 if
you want to include switches with IDs 3 and 6.

Stack Health Monitor Switch Id(s)

Select any of the following:

• All - Allows you to configure all diagnostic tests.
• Testnames - Allows you to manually enter the test names.
• TestRange - Allows you to enter a range for tests to be run.

Stack Tests Details Action

Guest Users
The purpose of a guest user account is to provide a user account for a limited amount of time. A Lobby
Ambassador is able to configure a specific time frame for the guest user account to be active. After the specified
time period, the guest user account automatically expires. Choose Configuration > Templates > Features
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& Technologies > CLI Templates > System Templates - CLI > Guest Users to access the Guest Users
template page.

Table 108: CLI Templates > System Templates - CLI > Guest Users

DescriptionField

Enter a guest username in the User Name text box. The maximum size is 24 characters.User Name

Enter a password for this username in the Password text box.Password

• Choose tbe guest user to connect to from the Profile drop-down list.
• Choose a user role for the guest user from the drop-down list. User roles are predefined by the administrator and
are associated with the access of the guest.

User Role is used to manage the amount of bandwidth allocated to specific users within the network.

Choose one of the following radio buttons to specify the lifetime of the guest account:

• • Limited—The period of time that the guest user account is active using the hours and minutes drop-down
lists. The default value for Limited is one day (8 hours).

• Unlimited Lifetime—no expiration date for the guest account.

• Choose the area (indoor, outdoor), controller list, or config group to which the guest user traffic is limited from
the Apply to drop-down list.

• Modify the default guest user description on the General tab if necessary. This is not mandatory.
• Modify the Disclaimer text on the General tab, if necessary. If you want the supplied text to be the default, select
theMake this Disclaimer default check box. This is not mandatory.

• Click Save.

Advanced

HTTP-HTTPS Server and WSMA Configuration-IOS
Use this option to configure HTTP access on devices that, in turn, configure WSMA and VPN functionality.

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Templates > CLI Templates > System Templates - CLI > HTTP-HTTPS Server and
WSMA Configuration-IOS.

Table 109: CLI Templates > System Templates - CLI > HTTP-HTTPS Server and WSMA Configuration-IOS

DescriptionField

Select an option to enable or disable HTTP or HTTPs access on the device. Select No Change if you do
not want to make changes to the server action.

Server Action

Specify the HTTP or HTTPs server port number from 1024 to 65535. Default HTTP prt number is 80 and
default HTTPS port number is 443.

Port Number

Select an option to enable or disable authentication method. Select No Change if you do not want to make
changes to the authentication action.

Authentication Action
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DescriptionField

Select an authentication method:

• aaa
• Enable
• local
• tacacs

AuthenticationMethod

Select an option to enable or disable access list. Select No Change if you do not want to make changes to
the Access List Action.

Access List Action

Enter the Access Control List number or name to be used. The access list number must be from 1 to 99.ACL Number/Name

Select an option to enable or disable WSMA action. SelectNo Change if you do not want to make changes
to the WSMA Action.

WSMA Action

To apply HTTP-HTTPS Server and WSMA Configuration-IOS template for Cisco IOS devices, do the
following:

Create two instances for the template, that is, you can edit the given template and save the template as
HTTP-WSMA-For-ISR-ASR-Series (with WSMA as enable/disable) and then again edit the given template
and save the template with a different name.

You must enable the WSMA option for ISR, ISR-G2 and ASR series of routers. Keep the WSMA option as
“No Change” for other routers.

Note

MAC Trap Configuration
Use this option to enable SNMPv1 or SNMPv2 MAC Notification Traps on switches.

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Templates > CLI Templates > System Templates - CLI > MAC Trap Configuration.

Table 110: CLI Templates > System Templates - CLI > MAC Trap Configuration

DescriptionField

Deploys the template only on the selected device OID.

Do not edit this field to avoid deployment issues.Note

Device OID

Enter the time interval between traps from 0 to 2147483647 seconds.Notification Interval

Enter the hostname or IP address of the trap receiver.Host Name/IP Address

Enter the SNMP v1/v2c community string.SNMP Community

Enter the UDP port number on which the trap is received from 0 to 65535.UDP Port

Enter the interface or interface range on which the trap must be configured.Interface Range
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Mediatrace-Responder-Configuration
The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Templates > CLI Templates > System Templates - CLI > -Responder-Configuration.

Table 111: CLI Templates > System Templates - CLI > Mediatrace-Responder-Configuration

DescriptionField

Enter a name for the template and an optional description.NameDescription

Enter one or more tags.

Tags are used to group templates. There are two ways you can tag a template:

• Create the tags when you create the template.
• Use the Tag icon located under the Templates search bar.

Tags

Choose Routers.Device Type

Enter the OS Version for the selected device type. This must be at least the minimum Cisco IOS version shown
in the following table. If this field is left empty, all available types for the chosen device type category
(Family/Series/Type) will be displayed.

OS Version

Medianet-PerfMon
Use this option to configure performance monitoring for Medianet. In the Form View tab, you cannot edit
the fields since they act as variables for the CLI Template.

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Templates > CLI Templates > System Templates - CLI > Medianet-PerfMon.

Table 112: CLI Templates > System Templates - CLI > Medianet-PerfMon

DescriptionField

Indicates the name for the template and an optional description.NameDescription

Enter one or more tags.

Tags are used to group templates. There are two ways you can tag a template:

• Create the tags when you create the template.
• Use the Tag icon located under the Templates search bar.

Tags

Select one of the Medianet PerfMon-compatible device types from the drop-down list.Device Type

Enter the OS Version for the selected device type. This must be at least the minimum Cisco IOS
version shown in the following table. If this field is left empty, all available types for the chosen device
type category (Family/Series/Type) will be displayed.

OS Version

A name for the NetFlow exporter on the device types you selected. This can be any collection of
characters (for example: EXPORTER-1 ).

Flow Exporter Name
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DescriptionField

The IP address of the Prime Infrastructure server.Flow Exporter Address

The port on which the NetFlow monitor will receive the exported data. Use the default 9991 port
unless you have a special need to override it.

Flow Exporter Port

An arbitrary name for the Medianet Performance Monitor caching the data from the flow exporter
(for example: MP-MONITOR-1 ).

PerformanceMonitor Name

The name of the interface on the device whose NetFlow data you want to monitor (for example:
ethernet 0/0 ).

Interface

An arbitrary name for the NetFlow monitor caching the data from the flow exporter (for example:
FLOW-MONITOR-1 ).

Flow Monitor Name

RADIUS Configuration-IOS
Use this option to configure Single Radius Host and Radius Group for IOS devices.

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Templates > CLI Templates > System Templates - CLI > Radius Configuration-IOS.

Table 113: CLI Templates > System Templates - CLI > Radius Configuration-IOS

DescriptionField

Enter the RADIUS group name.Radius Group Name

Specify the authentication and encryption key to the RADIUS server.Shared Key

Specify the key for verification.Verify Shared Key

DNS name or IP address of the RADIUS server group/host.

If you are entering a single RADIUS host, only the following fields must be entered:

• Shared Key
• Verify Shared Key
• Server name or IP address for Radius Group/Host
• Authentication Port
• Accounting Port
• Enable for 802.1X / MAB AAA
• Enable AAA for Web Authentication

Server name or IP Address for Radius
Group/Host

Specify the port number for authentication requests. Authentication and Accounting port
numbers cannot be the same. The host is not used for authentication if port number is set
to 0. The default authorization port number is 1645.

Authentication Port

Specify the port number for accounting requests. Authentication and Accounting port
numbers cannot be the same. The host is not used for accounting if the port number is set
to 0. The default accounting port number is 1646.

Accounting Port
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DescriptionField

DNS name or IP address of the RADIUS server group.Server name or IP Address for Radius
Group Only

Specify the port number for authentication requests. Authentication and Accounting port
numbers cannot be the same. The host is not used for authentication if port number is set
to 0. The default authorization port number is 1645.

Authentication Port

Specify the port number for accounting requests. Authentication and Accounting port
numbers cannot be the same. The host is not used for accounting if the port number is set
to 0. The default accounting port number is 1646.

Accounting Port

DNS name or IP address of the RADIUS server group.Server name or IP Address for Radius
Group Only

Specify the port number for authentication requests. Authentication and Accounting port
numbers cannot be the same. The host is not used for authentication if port number is set
to 0. The default authorization port number is 1645.

Authentication Port

Specify the port number for accounting requests. Authentication and Accounting port
numbers cannot be the same. The host is not used for accounting if the port number is set
to 0. The default accounting port number is 1646.

Accounting Port

DNS name or IP address of the RADIUS server group.Server name or IP Address for Radius
Group Only

Specify the port number for authentication requests. Authentication and Accounting port
numbers cannot be the same. The host is not used for authentication if port number is set
to 0. The default authorization port number is 1645.

Authentication Port

Specify the port number for accounting requests. Authentication and Accounting port
numbers cannot be the same. The host is not used for accounting if the port number is set
to 0. The default accounting port number is 1646.

Accounting Port

DNS name or IP address of the RADIUS server group.Server name or IP Address for Radius
Group Only

Specify the port number for authentication requests. Authentication and Accounting port
numbers cannot be the same. The host is not used for authentication if port number is set
to 0. The default authorization port number is 1645.

Authentication Port

Specify the port number for accounting requests. Authentication and Accounting port
numbers cannot be the same. The host is not used for accounting if the port number is set
to 0. The default accounting port number is 1646.

Accounting Port

Select the required option to enable or disable AAA for 802.1X and MAB authentication.Enable for 802.1X / MAB AAA

Select the required option to enable or disable AAA for Web-Based Authentication
(WebAuth).

Enable AAA for Web Authentication

Field Reference for Configuration Pages
132

Field Reference for Configuration Pages
RADIUS Configuration-IOS



Reload Configuration-IOS
Use this option to reload the Cisco IOS devices.

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Templates > CLI Templates > System Templates - CLI > Reload Configuration-IOS.

Table 114: CLI Templates > System Templates - CLI > Reload Configuration-IOS

DescriptionField

Check this option if you do not want to save the configurations before reloading.Do not Save config before reload

Enter the duration to wait after reload in minutes.Enter time to wait after reload

Reload Configuration-NAM
Use this option to reload the NAM devices.

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Templates > CLI Templates > System Templates - CLI > Reload Configuration-NAM.

Table 115: CLI Templates > System Templates - CLI > Reload Configuration-NAM

DescriptionField

Enter the duration to wait after reload in minutes.Enter time to wait after reload

Web User Configuration-NAM
Use this option to create, edit, and remove a local web user for NAM devices.

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Templates >CLI Templates > SystemTemplates - CLI >WebUser Configuration-NAM.

Table 116: CLI Templates > System Templates - CLI > Web User Configuration-NAM

DescriptionField

Select an option to add or remove web user group of fields. Select No Change, if you do not
want to make changes to the action.

Action

Enter the username of the web user.Username

Enter the DES password for the username.Enter DES encrypted WebUser
Password

Select the required option to enable or disable account management. Select No Change, if
you do not want to make changes to account management.

Account Management

Select the required option to enable or disable system configuration. Select No Change, if
you do not want to make changes to system configuration.

System Config
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DescriptionField

Select the required option to enable or disable capture configuration. Select No Change, if
you do not want to make changes to capture configuration.

Capture

Select the required option to enable or disable alarm configuration. SelectNo Change, if you
do not want to make changes to alarm configuration.

Alarm Config

Select the required option to enable or disable collection configuration. Select No Change,
if you do not want to make changes to collection configuration.

Collection Config

User Defined Protocol Configuration-NAM
The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Templates > CLI Templates > System Templates - CLI > User Defined Protocol
Configuration-NAM.

Table 117: User Defined Protocol Configuration-NAM Template Page Field Descriptions

DescriptionField

Select an option to add, remove or replace the user-defined protocol.Action

Select the protocol:

• TCP
• UDP

Protocol

Enter the port number. You can enter any port number in the range of 0 to 65535.Port

Enter the name of the user-defined protocol.Name

Select this option to enable host—Examines a stream of packets; produces a table of all network addresses observed
in those packets (also known as the collection data).

Each entry records the total number of packets and bytes sent and received by that host and the number of nonunicast
packets sent by that host.

Host

Select this option to enable host conversations.Conversations

Select this option to enable Application Response Time.ART

Network Analysis Module Field Descriptions
The following topics contain field descriptions for pages found in Configuration > Templates > Features
and Technologies >Network Analysis Module

• Network Analysis Module > Monitoring
• Network Analysis Module > System
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Network Analysis Module > Monitoring
The following table describes the fields in Configuration > Templates > Features and Technologies >
Network Analysis Module > Monitoring.

Table 118: Network Analysis Module > Monitoring

DescriptionField

Enable Response Time Monitor check box and enter response time
ResponseTime1<=ResponseTime2<=ResponseTime3<=ResponseTime4<=ResponseTime5<=ResponseTime6<=Late
Response Time.

Response Time

Enable the Call Signal Monitoring check box and enter MOS Quality Ranges as per NAM supported values.Voice

Enable the RTP Stream Monitoring check box and enter the filter with source and destination IPv4/IPv6 address and
mask.

RTP Filter

Enter minimum values for short term and long term interval.Aggregation Interval

Network Analysis Module > System
The following table describes the T fields in Configuration > Templates > Features and Technologies >
Network Analysis Module > System.

Table 119: NAM Analysis Module > System

DescriptionField

Enter the Domain Name and DNS server IP address.DNS Parameters

Create SNMP community with read-only or read-write permissions.SNMP Agent

Enable the Synchronize System Time With NTP check box and enter the Primary NTP Server Name/IP
Address (IPV4 or IPV6), Secondary NTP Server Name/IP Address (IPV4 or IPV6), and Time Zone.

System Time

Enable theMail check box and enter the External Mail Server and Mail Alarm to (mail ID).Email Setting

Enable theWeb Data Publication check box and enter the Access list IP address or Subnet which has to
be permitted.

Web Data Publication

Enter community details with the IP address and UDP port for the SNMP trap.SNMP Trap

Job status of the system template deploy for NAM3 displays failure, but changes happen on the NAM device.Note
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Wireless Configuration Field Descriptions
The following topics contain field descriptions for pages found on Design > Configuration > Wireless
Configuration.

• FlexConnect Parameters
• Lightweight AP Configuration Templates
• Switch Location Configuration Template
• Autonomous AP Migration Templates
• Controller Configuration Groups

FlexConnect Parameters
The following table describes the FlexConnect fields when you chooseConfiguration > Network > Network
Devices, select Device Type > Wireless Controller, click a Device Name of a controller, then select
FlexConnect.

Table 120: Wireless Controller > FlexConnect Parameters

DescriptionField

General tab

Name of the template applied to this controller.Template Name

From the drop-down list, choose the primary radius authentication server present on the controller.
If the selected or configured Radius Authentication Server is not present on the controller with
version less than 7.4, the template will fail.

You must configure the RADIUS server configuration on the controller before you apply
FlexConnect RADIUS server configuration from the Prime Infrastructure.

Primary Radius

From the drop-down list, choose the secondary radius authentication server present on the
controller. If a RADIUS authentication server is not present on the controller, the Prime
Infrastructure configured RADIUS server does not apply.

Secondary Radius

FlexConnect AP tab

Select the check box to apply to the FlexConnect group.

An AP Ethernet MAC address cannot exist in more than one FlexConnect group on the same
controller. The controller does not allow you to set an AP Ethernet MAC in a FlexConnect group
if it is already present in another FlexConnect group.

Ethernet MAC

Click to add an additional FlexConnect AP (present in the Prime Infrastructure) to an existing
FlexConnect group. When you click Add AP, only those access points that are part of this
FlexConnect group is listed.

To enable local authentication for a FlexConnect group, click the FlexConnect Configuration
tab. Make sure that the Primary RADIUS Server and Secondary RADIUS Server parameters are
set to None on the General tab.

Add AP
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DescriptionField

Select to allow a FlexConnect access point to authenticate clients using LEAP.LEAP

Select to allow a FlexConnect access point to authenticate clients using EAP-FAST. You must
provide the EAP-FAST key as well as confirm the EAP-FAST key.

EAP-FAST

• To use manual PAC provisioning, enter the key used to encrypt and decrypt PACs in the
EAP=FAST Key text box. The key must be 32 hexadecimal characters.

• To allow PACs to be sent automatically to clients that do not have one during PAC
provisioning, select the Ignore Server Key check box.

Protected Access Credentials
(PACs)

Enter the authority identifier of the EAP-FAST server. The identifier must be 32 hexadecimal
characters.

EAP-FAST Authority ID

Enter the authority identifier of the EAP-FAST server in text format. You can enter up to 32
hexadecimal characters.

EAP-FAST Authority Info

Specify a PAC timeout value by entering the number of seconds for the PAC to remain visible
in the edit text box. The valid range is 2 to 4095 seconds.

EAP-FAST PAC Timeout

Image Upgrade tab

Select this option to upgrade the FlexConnect access points.FlexConnect AP Upgrade

Select this option to specify the maximum retries for the slave to undertake to start the download
from the master in the FlexConnect group. This option is available only if you select the
FlexConnect AP Upgrade check box.

You are allowed to add an access point as a master access point only if the FlexConnect AP
Upgrade check box is enabled on the General tab.

Slave Maximum Retry Count

Lightweight AP Configuration Templates
• Lightweight AP Configuration Templates > Template Basic

• Lightweight AP Configuration Templates > AP Parameters

• Lightweight AP Configuration Templates > Mesh

• Lightweight AP Configuration Templates > 802.11a/n/ac

• Lightweight AP Configuration Templates 802.11a > SubBand

• Lightweight AP Configuration Templates > 802.11b/g/n

• Lightweight AP Configuration Templates > 802.11a/b/g/n

• Lightweight AP Configuration Templates > CDP

• Lightweight AP Configuration Templates > FlexConnect

• Lightweight AP Configuration Templates > Schedule
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Lightweight AP Configuration Templates > Template Basic
The following table describes the fields in the Template Basic tab inConfiguration >Templates > Lightweight
Access Points.

Table 121: Lightweight AP Configuration Templates > Template Basic

DescriptionField

Name of the Lightweight AP Configuration template.Template
Name

Description for the Lightweight AP Configuration template.Description

Lightweight AP Configuration Templates > AP Parameters
The following table describes the fields in the AP Parameters tab inConfiguration > Templates > Lightweight
Access Points.

Table 122: Lightweight AP Configuration Templates > AP Parameters

DescriptionField

General

Enter the location in the Location text box.Location

Select the Admin and Enabled check box to enable administrative status.

To conserve energy, access points can be turned off at specified times during nonworking
hours. Select the Enabled check box to allow access points to be enabled or disabled.

Admin Status
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DescriptionField

From the drop-down list, choose one of the following:

• Local—Default
• Monitor—Monitor mode only.

ChooseMonitor to enable this access point template for CiscoAdaptive wIPS. OnceMonitor
is selected, select theEnhancedWIPS Engine check box and the Enabled check box. Then
select the AP Monitor Mode Optimization check box and choose WIPS from the AP
Monitor Mode Optimization drop-down list.

• FlexConnect—Cisco 1030 remote edge lightweight access point (REAP) used for
Cisco 1030 IEEE 802.11a/b/g/n remote edge lightweight access points.

FlexConnect must be selected to configure an OfficeExtend access point. When the AP
mode is FlexConnect, FlexConnect configuration options display including the option to
enable OfficeExtend AP and to enable Least Latency Controller Join.

• Rogue Detector—Monitors the rogue access points but does not transmit or contain
rogue access points.

• Bridge
• Sniffer—The access point “sniffs” the air on a given channel. It captures and forwards
all the packets from the client on that channel to a remote machine that runs airopeek
(a packet analyzer for IEEE 802.11 wireless LANs). It includes information on
timestamp, signal strength, packet size, and so on. If you choose Sniffer as an operation
mode, you are required to enter a channel and server IP address on the AP/Radio
Templates 802.11b/g/n or 802.11a/n parameters tab.

The sniffer feature can be enabled only if you are running AiroPeek, which is a third-party
network analyzer software that supports decoding of data packets. For more information
on AiroPeek, see http://www.wildpackets.com.

• SE-Connect—Thismode allows a CleanAir-enabled access point to be used extensively
for interference detection on all monitored channels. All other functions such as IDS
scanning and Wi-Fi are suspended.

This option is displayed only if the access point is CleanAir-capable.

Changing the AP mode reboots the access point.

AP Mode

Choose an option from the drop-down list.AP Sub Mode

Select the Enhanced wIPS engine and the Enabled check box to enable.Enhanced wIPS Engine

Enter the height of the access point (in feet) in the text box.AP Height (feet)

Select the Enabled check box to enable mirror mode.Mirror Mode

Choose the appropriate country code from the drop-down list.Country Code

Enter the stats collection interval in the text box.Stats Collection Interval

Select the Enabled check box to enable Cisco Discovery Protocol.Cisco Discovery Protocol

Choose Low,Medium, High, or Critical from the drop-down list to indicate the access
point failover priority. The default priority is low.

AP Failover Priority
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DescriptionField

Pre-Standard 802.3af switchesPre-Standard 802.3af switches

Antenna Band ModeAntenna Band Mode

Domain Name can be configured only on APs which have static IP.Domain Name

Domain Name Server IP can be configured only on APs which have static IP.Server IP Address

Select the Encryption check box to enable encryption.Encryption

Select the check box to enable rogue detection.Rogue Detection

Select the SSH Access check box to enable SSH access.SSH Access

Select the Telnet Access check box to enable Telnet access.Telnet Access

You can configure link latency on the controller to measure the link between an access point
and the controller.

Link latency is supported for use only with FlexConnect access points in
connectedmode. FlexConnect access points in standalonemode are not supported.

Note

Link Latency

Select the TCP Adjust MSS check box to enable TCP to adjust MSS.TCP Adjust MSS

VLAN Tagging is supported only from controller version 7.3.1.26. If you change the mode
or value of VLAN tagging, the access point will be rebooted. VLAN tagging cannot be
enabled when the AP is in Bridge mode. Enabling VLAN tagging will ignore the value of
Native VLAN ID.

VLAN Tagging

AP Group Name.AP Group Name

Select the check box to enable a reboot of the access point after making any other updates.Reboot AP

Power Injector Configuration

When enabled, this allows you to manipulate power injector settings through Prime
Infrastructure without having to go directly to the controllers. If the Enable Power Injector
State is selected, power injector options appear.

Power Injector State

Choose installed or override from the drop-down list.Power Injector Selection

Enter the MAC address of the injector switch.Injector Switch MAC Address

Global Username Password
Configuration

Select the check box to enable an override for the global username/password. Enter and
confirm the new access point username and password in the appropriate text boxes.

Override Global Username Password

SupplicantCredentialsConfiguration
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DescriptionField

Select the Override Supplicant Credentials check box to prevent this access point from
inheriting the authentication username and password from the controller. The default value
is unselected. The Override Supplicant Credentials option is supported in controller Release
6.0 and later.

In the Username, Password, and Confirm Password text boxes, enter the unique username
and password that you want to assign to this access point.

Override Supplicant Credentials

AP Retransmit Configuration

Enter the AP Retransmit Count. The AP Retransmit Count default value is 5 and the range
is from 3 to 8.

AP Retransmit Count

Enter the AP Retransmit Intervals. The AP Retransmit Interval default value is 3. The range
is 2 to 5.

AP Retransmit Interval (secs)

Controller Configuration

Select the check box to enable the drop-down lists for the primary, secondary, and tertiary
controller names.

• Primary, Secondary, and Tertiary Controller Name—The Primary/Secondary/Tertiary
Controller names.

• Primary, Secondary, and Tertiary Controller IP—The Primary/Secondary/Tertiary
Controller IP is the Management IP of the controller.

Controllers Configuration

• Venue Group
• Venue Type
• Secondary Venue Name
• Language

Venue Configuration

Enable the BLE Beacon Configuration check box and configure the following:

• Beacon Id
• Major Field
• Minor Field
• Tx Power (dBM)

BLE Beacon Configuration

AP LAN Port Configuration

This configuration is
applicable only for Cisco
Aironet 702W Series APs
and Cisco 1810W Series
APs.

Note

Select the check box to enable the LAN Override on the access point.AP LAN Override

Displays the port number.Port

Select the check box to enable the port status.State
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DescriptionField

The first LAN port contains a POE through which you can configure the POE status. Select
the check box to enable the POE status.

POE Status

Enter the VLAN ID.VLAN ID

Lightweight AP Configuration Templates > Mesh
The following table describes the fields in theMesh tab inConfiguration > Templates > Lightweight Access
Points.

Table 123: Lightweight AP Configuration Templates > Mesh

DescriptionField

Enter a bridge group name (up to 10 characters) in the text box.

Bridge groups are used to logically group the mesh access points to avoid two networks on the
same channel from communicating with each other. For mesh access points to communicate,
they must have the same bridge group name. For configurations with multiple RAPs, make sure
that all RAPs have the same bridge group name to allow failover from one RAP to another.

Note

Bridge Group Name

Choose the data rate for the backhaul interface from the drop-down list. Data rates available are dictated
by the backhaul interface. The default rate is 18 Mbps.

This data rate is shared between the mesh access points and is fixed for the whole mesh network.
Do not change the data rate for a deployed mesh networking solution.

Note

Data Rate (Mbps)

From the Ethernet Bridging drop-down list, enable Ethernet bridging for the mesh access point.Ethernet Bridge

Choose the role of the mesh access point from the drop-down list (MAP or RAP). The default setting is
MAP.

An access point in a mesh network functions as either a root access point (RAP) or mesh access point
(MAP).

Role

The group box provides information such as interface name, mode, VLAN ID, and Trunk ID. Select the
appropriate interface and specify its mode.

Ethernet Interfaces area

Lightweight AP Configuration Templates > 802.11a/n/ac
The following table describes the fields in the 802.11a/n/ac tab inConfiguration > Templates > Lightweight
Access Points.
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Table 124: Lightweight AP Configuration Templates > 802.11a/n/ac

DescriptionsField

Select the check boxes of the 802.11a parameters that must be applied:

• Channel Assignment
• Channel Width
• Admin Status

802.11a parameters

Select the check boxes of the 802.11ac parameters that must be applied. 802.11ac parameters are only
applicable for 11ac modules.

• Channel Width
• Admin Status

802.11ac parameters

Select the Power Assignment check box to choose the appropriate power level.Power Assignment

Select the Antenna Selection check box to select any of the 11n Antenna Selection parameters.Antenna Selection

Select the CleanAir check box to enable CleanAir functionality. CleanAir is supported from the WLC
Release 7.0 for CleanAir-supported APs.

CleanAir

Select the check boxes of the configuration that must be applied:

• Antenna Mode—Choose an antenna mode.
• Antenna Diversity—Choose enabled or disabled. Antenna diversity refers to the access point sampling
the radio signal from two integrated antenna ports to choose the preferred antenna.

• Antenna Type—Indicate an external or internal antenna.
• Antenna Name—Select the Antenna Type check box, then choose the applicable antenna name from
the drop-down list.

• Antenna Gain—Enter a value for antenna gain.
• Azimuth—Configure each access point with the custom Azimuth in degrees. Azimuth and Elevation
are the angle used to define the apparent position of the access point.

• Elevation—Configure each access point with the custom Elevation in degrees.
• Up / Down—Select Up or Down from the drop-down list.

Antenna Configuration

Lightweight AP Configuration Templates 802.11a > SubBand
The following table describes the fields in the 802.11a SubBand tab in Configuration > Templates >
Lightweight Access Points. In the 802.11a SubBand tab, select the 802.11a Sub Band options (for either 4.9
or 5.8 parameters) that must be applied. The SubBand options are disabled unless the check box to the left of
the field is selected.c

Table 125: Lightweight AP Configuration Templates 802.11a > SubBand

DescriptionField

Click if you want to enable administration privileges.Admin Status

Select the check box and then choose the appropriate channel from the drop-down list.

The channel number is validated against the radio list of supported channels.Note

ChannelAssignment
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DescriptionField

Select the check box and then choose the appropriate power level from the drop-down list.

The power level is validated against the radio list of supported power levels.Note

Power Assignment

Select the check box and then choose Disable or Enable from the drop-down list.

The access point must be reset for the WLAN override change to take effect.Note

WLAN Override

Indicate an external or internal antenna.Antenna Type

Select the Antenna Type check box, then choose the applicable antenna name from the drop-down list.Antenna Name

Lightweight AP Configuration Templates > 802.11b/g/n
The following table describes the fields in the 802.11b/g/n tab inConfiguration > Templates > Lightweight
Access Points.

Table 126: Lightweight AP Configuration Templates > 802.11b/g/n

DescriptionsField

Choose a Global assignment method or choose Custom to specify a channel.Channel Assignment

From the drop-down list, choose either 20 MHz or 40 MHz.Channel Width

Select if you want to enable administration privileges.Admin Status

Choose a Global assignment method or choose Custom to specify a power assignment.Power Assignment

Select to enable.TrackingOptimizedMonitorMode

Select the Antenna Selection check box, then select the appropriate antennas from the list.Antenna Selection

Select this check box to enable CleanAir.CleanAir

Select the check boxes of the configuration that must be applied:

• Antenna Mode—Choose an antenna mode.
• Antenna Diversity—Choose enabled or disabled. Antenna diversity refers to the access
point sampling the radio signal from two integrated antenna ports to choose the preferred
antenna.

• Antenna Type—Indicate an external or internal antenna.
• Antenna Name—Select the Antenna Type check box, then choose the applicable antenna
name from the drop-down list.

• Antenna Gain—Enter a value for antenna gain.
• Azimuth—You must configure every access point with the custom Azimuth in degrees.
Azimuth and Elevation are the angle used to define the apparent position of the access
point.

• Elevation—You must configure every access point with the custom Elevation in degree.
• Up / Down—From the drop-down list, choose Up or Down.

Antenna Configuration
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Lightweight AP Configuration Templates > 802.11a/b/g/n
The following table describes the fields in the 802.11a/b/g/n tab inConfiguration > Templates > Lightweight
Access Points.

Use this tab to configure Hyper Location, WSM, and Monitor Mode AP module radios.

Table 127: Lightweight AP Configuration Templates > 802.11a/b/g/n

DescriptionsField

This configuration is supported only for XORRadios. Select the checkbox to configure the radio assignment
methods.

The assignment methods are Auto, Serving, or Monitor.

Choose either 2.4 GHz or 5 GHz radio for Serving radio role assignment.

Radio Role Assignment

Select the check box if you want to enable administration privileges.Admin Status

(Only for Serving radio role assignment). Select this check box to configure one of the following:

• Global—Use this setting if the channel of the access point is set globally by the controller.
• Custom—Use this setting if the channel of the access point is set locally. Select a channel from the
Custom drop-down list. The values in the drop-down varies for 2.4 GHz and 5 GHz radios.

Channel Assignment

(Only for Serving radio role assignment). Channel width is supported only for 11n supported APs. Only
radios with 20 MHz is supported for a 2.4 GHz radio. For 5 GHZ, from the Channel Width drop-down
list, choose 20 MHz, 40 MHz, 80 MHz or 160 MHZ.

Channel Width

(Only for Serving radio role assignment). Choose an antenna mode from the drop-down list.Antenna Mode

(Only for Serving radio role assignment). Select Right/Side A, Left/Side B, or Enabled.Antenna Diversity

Select the Antenna Type check box and then choose an applicable antenna name from the drop-down list.Antenna Type

(For Serving andMonitor radio role assignment). Choose the applicable antenna name from the drop-down
list.

Antenna Name

(Only for Auto mode). Configure an antenna for A band by selecting an antenna name from the drop-down
list.

XOR Antenna A

(Only for Auto mode). Configure an antenna for B band by selecting an antenna name from the drop-down
list.

XOR Antenna B

(Only for Serving radio role assignment). Enter the desired antenna gain in the text box. To configure
custom antenna gain, select Others for the Antenna Name.

Antenna Gain

(Only for Serving radio role assignment). Prime Infrastructure provides the ability to enable or disable the
use of specific antennas. All antennas are enabled by default. Select any of the 11n Antenna Selection
parameters:

• Antenna A
• Antenna B
• Antenna C
• Antenna D

Antenna Selection
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DescriptionsField

Select the CleanAir check box and choose the applicable option from the drop-down list.

For Serving and Auto mode, these options are available:

• Enabled
• Disabled

For Monitor Mode XOR, these options are available:

• 2.4 GHz Enabled
• 5 GHz Enabled
• Both Enabled
• Both Disabled

CleanAir

Select one of the following:

• Global—Use this setting if the power level is set globally by the controller.
• Custom—Use this setting if the power level of the access point is set locally. Choose a power level
from the drop-down list.

Power Assignment

Select the check boxes of the configuration that must be applied:

• Azimuth—You must configure every access point with the custom Azimuth in degrees. Azimuth and
Elevation are the angle used to define the apparent position of the access point.

• Elevation—You must configure every access point with the custom Elevation in degree.
• Up / Down—Select Up or Down from the drop-down list.

Antenna Configuration

Lightweight AP Configuration Templates > CDP
The following table describes the fields in the CDP tab inConfiguration > Templates > Lightweight Access
Points.

Table 128: Lightweight AP Configuration Templates > CDP

DescriptionField

Select the check boxes for the ethernet interface slots for which you want to enable
CDP.

Cisco Discovery Protocol on Ethernet Interfaces

Select the checkbox for the radio interfaces slots for which you want to enable
CDP.

Cisco Discovery Protocol on Radio Interfaces

Lightweight AP Configuration Templates > FlexConnect
The following table describes the fields in the FlexConnect tab inConfiguration > Templates > Lightweight
Access Points.
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Table 129: Lightweight AP Configuration Templates > FlexConnect

DescriptionField

Select the check box to enable FlexConnect configuration (including VLAN support, native VLAN
ID, and profile name VLAN mappings).

These options are only available for access points in FlexConnect mode.Note

FlexConnect Configuration

The default is Enabled.

Unselecting the check box simply disables OfficeExtend mode for this access point. It does not undo
all of the configuration settings on the access point. If you want to clear the access point configuration
and return it to factory default settings, click Clear Config at the bottom of the access point details
page. If you want to clear only the access point personal SSID, click Reset Personal SSID at the
bottom of the access point details page.

When you select Enable for the OfficeExtend AP, several configuration changes automatically occur
including: encryption and link latency are enabled; rogue detection, SSH access, and Telnet access
are disabled.

When you enable the OfficeExtend access point, you must configure at least one primary, secondary,
and tertiary controller (including name and IP address).

OfficeExtend

When enabled, the access point switches from a priority order search (primary, secondary, and then
tertiary controller) to a search for the controller with the best latency measurement (least latency).
The controller with the least latency provides the best performance.

The access point only performs this search once when it initially joins the controller. It does not
recalculate the latency measurements of primary, secondary, and tertiary controllers once joined to
see if the measurements have changed.

Least Latency Controller Join

Select the check box to enable VLAN Support.VLAN Support

The valid native VLAN ID range is 1 to 4094. If you are changing the mode to REAP and if the
access point is not already in REAP mode, then all other REAP parameters are not applied on the
access point.

Native VLAN ID

Select the WLAN VLAN Mapping check box to enable WLAN VLAN mapping (including WLAN
profile name and VLAN ID mappings).

WLAN VLAN Mapping

Select the VLAN ID ACL Mapping check box to enable VLAN ID ACL Mappings. Enter a VLAN
ID and choose the Ingress and Egress ACLs from the drop-down list boxes to map to the VLAN ID
specified.

Web Auth ACL Mapping

Select the Policy ACL Mapping check box to enable policy ACL mapping.Policy ACL Mapping

Select the Local Split ACL Mapping check box to enable Local Split ACL mapping.Local Split ACL Mapping

Lightweight AP Configuration Templates > Schedule
The following table describes the fields in the Schedule page in Lightweight AP Configuration Templates.
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Table 130: Lightweight AP Configuration Templates Schedule

DescriptionField

Allows you to configure and start the template deployment at a scheduled time.

Now—Deploys the template right away.

Date—Enter a date in the text box or use the calendar icon to select a start date.

Start Time

Select from none, hourly, daily, or weekly to determine how often this scheduling occurs.

You can deploy the template using the AP Selection or Schedule tabs.

Recurrence

Switch Location Configuration Template
The following table describes the Template Detail fields on Design > Wireless Configuration > Switch
Location Configuration.

Table 131: Design > Wireless Configuration > Switch Location Configuration

DescriptionField

Map Location

Choose a campus for the map location for a switch/switch port.Campus

Choose a building for the map location for a switch/switch port.Building

Choose a floor for the map location for a switch/switch port.Floor

Imports the civic information for the campus, building, and floor selected.Import

ELIN andCivic Location

The Emergency Location Identification Number.ELIN

The available civic address information for the switch/switch port.Civic Address tab

Detailed information about the switch/switch port location.Advanced tab

Select or unselect this check box to enable or disable NMSP for the switch.NMSP

Autonomous AP Migration Templates
The following table describes the Template Detail fields inDesign >Configuration >Wireless Configuration
> Autonomous AP Migration Templates.

Table 132: Autonomous AP Migration Template Page

DescriptionField

Template name.Name
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DescriptionField

Template description.Description

Number of APs.AP Count

Scheduled run time.Schedule Run

Indicates one of the following:

• Not initiated—The template is yet to start the migration and starts at the scheduled time.
• Disabled—The template is disabled and does not run at the scheduled time. This is the default state for a template
when it is created without selecting any autonomous access points.

• Expired—The template did not run at the scheduled time (this might be due to the Prime Infrastructure server
being down).

• Enabled—The template is yet to start the migration and starts at the scheduled time.
• In progress—The template is currently converting the selected autonomous access points to CAPWAP.
• Success—The template has completed the migration of autonomous access point to CAPWAP successfully.
• Failure—The template failed to migrate all the selected autonomous access point to CAPWAP. You can check
the detailed status about the failures by using the View Migration Status page.

• Partial Success—The template failed to migrate a subset of the selected autonomous access point to CAPWAP.
You can check the detailed status about the failures by using the View Migration Status page.

Status

Autonomous AP Migration Templates Add Template
The following table describes the Template Detail fields inDesign >Configuration >Wireless Configuration
> Autonomous AP Migration Templates.

Table 133: Autonomous AP Migration Templates

DescriptionField

Upgrade Options

Ensures that after the conversion every access point gets an IP from the DHCP server.DHCP Support

Allows you to retain the same hostname for this access point.

The hostname is retained in the CAPWAP, only when you are migrating the AP to CAPWAP for the first
time. It might not be retained if you are upgrading an AP for several times. The CAPWAP access points
hostname is set to default if autonomous access points hostname has more than 32 characters.

If you upgrade the access points to LWAPP from 12.3(11)JA, 12.3(11)JA1, 12.3(11)JA2, 12.3(11)JA3
autonomous images, the converted access points might not retain their static IP address, netmask, hostname
and default gateway.

Retain AP HostName

Increases the default timeouts for the CLI commands executed on the access point.

If you enable this option, the env_vars file stores the remote TFTP server location. This information is
copied to the access point. If this option is not selected, then the Prime Infrastructure internal TFTP server
is used to copy the env_vars file to the access point.

Migrate overWANLink

Enter the DNS address.DNS Address
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DescriptionField

Enter the domain name.Domain Name

Controller Details

Enter controller IP address.Controller IP

Specify the controller the access point should join by entering the access point manager IP address.

For SSC-enabled access points, this IP address must be the same as the controller IP field. ForMIC-enabled
access points, the IP addresses need not match.

AP Manager IP

Enter the username.User Name

Enter the password for the username.Password

TFTP Details

Enter the IP address of the Prime Infrastructure server. Prime Infrastructure provides its own TFTP and
FTP server during the installation and setup.

TFTP Server IP

Enter the TFTP directory that was defined during Prime Infrastructure setup.File Path

Enter the CAPWAP conversion file defined in the TFTP directory during Prime Infrastructure setup (for
example, c1240-rcvk9w8-tar.123-11JX1.tar).

File Name

Schedule Details

Choose an option by which you want to apply the template for migration.Apply Template

Enter the email address of recipient to send notifications.Notification

Controller Configuration Groups
The following topics describe the fields in Design > Wireless Configuration > Wireless Configuration >
Controller Configuration Groups.

• Controller Configuration Groups > Add Config Group
• Controller Configuration Groups > General
• Controller Configuration Groups > Apply Schedule

Controller Configuration Groups > Add Config Group
The following table describes the Template Detail fields inController Configuration Groups > Add Config
Group.

Table 134: Wireless Configuration > Controller Configuration Groups

DescriptionField

The group name must be unique across all groups.GroupName
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DescriptionField

Other templates created in Prime Infrastructure can be assigned to a config group. The same WLAN template can be
assigned to more than one config group. Choose from the following:

• Select and add later: Add a template at a later time.

• Copy templates from a controller: Copy templates from another controller. Choose a controller from a list of
current controllers to copy its applied template to the new config group. Only the templates are copied.

The order of the templates is important when dealing with radio templates. For example, if the template
list includes radio templates that require the radio network to be disabled prior to applying the radio
parameters, the template to disable the radio network must be added to the template first.

Note

Templates

Controller Configuration Groups > General
The following table describes the Template Detail fields in Controller Configuration Groups > General.

Table 135: Wireless Configuration > Controller Configuration Groups > General

DescriptionField

If selected, all the templates that are part of this group are audited against the controller during network
and controller audits.

To enable this option, set the template-based audit option under Administration > System >
Audit.

Note

Enable BackgroundAudit

If selected, the templates are automatically applied during the audit if any discrepancies are found.

To enable this option, set the template-based audit option under Administration > System >
Audit.

Note

Enable Enforcement

If selected, the mobility group name is pushed to all controllers in the group.Enable Mobility Group

A name that is pushed to all controllers in the group. You can also use this field to change the group
name.

A controller can be part of multiple configuration groups.Note

Mobility Group Name

Date and time config group was last modified.Last Modified On

Date and time last changes were applied.Last Applied On

Controller Configuration Groups > Apply Schedule
The following table describes the Template Detail fields in Controller Configuration Groups > Apply
Schedule.
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Table 136: Wireless Configuration > Controller Config Groups > Apply Schedule

DescriptionField

This option is available only when the Schedule option is not enabled.Note

ClickApply to start the provisioning of mobility groups, mobility members, and templates to all the controllers
in the config group. After you apply, you can leave this page or log out of Prime Infrastructure. The process
continues, and you can return later to this page to view a report.

Do not perform any other configuration group functions during the apply provisioning.Note

The report appears in the Recent Apply Report page. It shows which mobility groups, mobility members, or
templates were successfully applied to each of the controllers.

Apply

Enabling the Schedule option disables the Apply option.Schedule

Enter a starting date and time, then click Schedule.Start DateStart Time

Compliance Field Descriptions
The following topics contain field descriptions for Compliance:

• Configuration > Compliance > Policies
• Configuration > Compliance > Profiles
• Configuration > Compliance > Violation Summary

Configuration > Compliance > Policies
Table 137: Configuration > Compliance > Policies > New Rule Fields

DescriptionField

Rule Information

All information entered in this
section is free text and does
not impact the conditions and
the subsequent violations.

Enter a name for the rule.Rule Title

Enter a brief descriptionDescription

Enter a brief note on the impact of the violation that the rule will generate.Impact

Enter a brief description of the fix that will help you decide to choose or to not choose the rule against
a specific policy. This description appears when you check the rule in the Rule Selector pane.

Suggested Fix

Platform Selection
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DescriptionField

Check the platforms on which the condition must be run. If you select Cisco Devices, all of Cisco
platforms specified in the list are included. The platforms checked in this section impacts the ignore
count of an audit job. For example, if you run a rule on all the devices within your scope, including
devices not selected in the Available Platforms pane, such devices are not audited and are marked
against Ignore count.

Available Platforms

Rule Inputs

Click New to add inputs for the new rule. The input you create in this pane reflects in the Policy
Profile page. Youmust provide rule inputs for the rule you have selected. For example, you can create
an input to be IP Address. Any user who wants to run this rule can enter an IP address specific to the
rule and add it to a specific profile. Enter the required details:

For Identifier, Enter your own Identifier, or click theGenerate button to generate an identifier based
on the title.

The following fields appear based on the option that you choose in the Data Type field:

• Is List of Values—Check this check box to add multiple values to be associated with the rule
input. A table appears where you can add, edit, and delete values. You can also set a default
value.

• Accept Multiple Values—Check this check box if you want to provide more than one value at
the time of audit. This is applicable only for the execution type rule input.

• Min Value—Enter a minimum integer value for the rule input. This is applicable only for the
integer data type.

• Max Value—Enter a maximum integer value for the rule input. This is applicable only for the
integer data type.

• Default Value—Enter a default value for the rule input. The format of the value that you enter
in this field depends on the data type that you choose in the Data Type field. For example, if
you choose Integer as the data type, you can enter an integer value only.

• Max Length—Enter the maximum length that is applicable for the rule input.
• Val RegExp—Enter a valid regular expression that will be used for execution or fix.

New Rule Input

Conditions and Actions

Click New to create conditions and actions for the new rule.New Conditions and Actions

New Conditions and
Actions—ConditionsDetails
Tab
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DescriptionField

• Condition Scope—Select the scope of the conditions from one of the below:

• Configuration—Checks the complete running configuration.
• Device Command Outputs—Checks the output of show commands.
• Device Properties—Checks against the device properties and not the running configuration.
• Previously Matched Blocks—Runs the conditions against blocks that have been defined
in previous conditions. To run the condition with this option, you must have checked Parse
as Block option in one of the previous conditions. You cannot select this option for the first
condition of a rule.

• Device Property—Select one of the following device properties:

• Device Name
• IP Address
• OS Name
• OS Version

This option is enabled only if you selected Device Properties in the Condition Scope
drop-down list.

Note

• ShowCommands—Select the required show command that is applicable for the platform selected.
You can also enter a show command against which the audit must be performed.

This option is enabled only if you selected Device Command Outputs in the Condition
Scope drop-down list.

Note

Condition Scope Details

Block Options

Checking this option enables you to run conditions on specific blocks (as defined in this section) in
running configuration files. This option can be for show commands is enabled only if you selected
Configuration in the Condition Scope option.

Parse as Blocks

This field is mandatory if Parse as Blocks option is enabled. This must be a regular expression. Rule
inputs and Grep outputs can be used here.

Block Start Expression

This field is optional. By default, blocks end when the top-level or a sub-level command begins. If
you prefer to break the block earlier, enter the value as a regular expression.

Block End Expression

Check the option, as required. If you select:

• All Sub Blocks—The rule is marked a success only if all the blocks fulfill the specified condition.
• Any Sub Block—The rule is marked a success even if one of the sub blocks fulfill the condition.
• Raise One Violation for Each Failing Instance—If you check this option, the violation count
specified in the Job view increases by as many number of violations as the condition encounters
in each block.

Rule Pass Criteria

Condition Match Criteria

Choose an option based on the value you will enter in the subsequent fields.Operator
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DescriptionField

Click Edit. The Select Operator Function page appears. Select a predefined function and enter the
function parameters based on the predefined function that you have selected.

This field is available only if you selected the option Execute a Function or Evaluate
Expression from the Operator field.

Note

Operator Function

The value must be a regular expression. Rule inputs and Grep outputs can be used here. This variable
can be grepped for use in the subsequent conditions. It follows the convention of condition
<Condition.value number> such as, <2.1> <2.2>... This numerical identifier can be used from the
next condition as input parameter for Operator selected in the previous field.

If you select the Evaluate Expression from the Operator field, click Edit to select the Operator
function.

If the you select “checkTraffic” as Function Name, it checks traffic on any ACL. Enter the value
for expected traffic in Traffic and ACL fields, as the following Example.

"Traffic" = "deny tcp any any eq 27665 log", "ACL" = <1.1>

"Traffic" = "<_Expected_Traffic>", "ACL" = <1.1>, which means expected traffic has be captured
from execution type rule input "_Expected_Traffic".

Value

Check the option, as required. If you select:

• All Sub Blocks—The rule is marked a success only if all the blocks fulfill the specified condition.
• Any Sub Block—The rule is marked a success even if one of the sub blocks fulfill the condition.
• Raise One Violation for Each Failing Instance—If you check this option, the violation count
specified in the Job view increases by as many number of violations as the condition encounters
in each block.

Rule Pass Criteria

New Conditions and
Actions—Action Details
Tab

Select one of the following actions that Compliance Audit must perform upon detecting a violation:

• Continue—If the condition is met or not met, the rule continues to run based on the condition
number specified in the field. If a condition number is not specified, the rule skips to the next
immediate condition.

• Does Not Raise a Violation—Does not raise a violation; stops further execution of rule.
• Raise a Violation—Raises a violation and stops further execution of rule.
• Raise a Violation and Continue—Raises a violation and continues execution of rule.

Select Action

Specify the condition number to which the rule must continue with in case the condition is met or is
not met. You cannot specify a condition number that is lesser than or equal to the current condition
number. This field is available only if you selected the option Continue from the Select Action field.
If the Condition Number field is blank, the next available condition is used.

Condition Number

Specify a severity that Compliance Audit must flag if a violation is detected. This field is available
only if you selected the option, Raise a Violation from the Select Action field.

Violation Severity
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DescriptionField

Select one of the following message type:

• Default Violation Message—Select this option if you determine a violation as not fixable (or
requiring manual intervention).

• User defined Violation Message—Select this option to enter a comment and provide a CLI fix
to fix a violation.

This field is available only if you selected the option, Raise a Violation from the Select Action field.

Violation Message Type

This field is available only if you selected User defined ViolationMessage in the Violation
Message Type field.

Note

Enter a violation message that will be displayed in the Job View window. Rule inputs can be used
here.

Violation Message

This field is available only if you selected User defined ViolationMessage in the Violation
Message Type field.

Note

Enter a relevant CLI fix if the device does not meet the condition specified. Do not enter config t,
configure, and its exit commands. Rule inputs and Grep outputs can be used here.

The exit command is allowed in main and sub-level commands.Note

Following are the formats for the CLI fix that you enter in this field:

• For an execution type input, enter <Rule input ID>
• For a fix type input, enter ^<Rule input ID>^
• For a grep type output, enter <n.m>, where n is the condition number and m is the output number.

Fix CLI

Configuration > Compliance > Profiles
Table 138: Configuration > Compliance > Profiles

DescriptionField

Profile Actions

Create new compliance profile.Add

Edit the compliance profile description.Edit

Run compliance audit for the selected policy profile.Run

Delete the compliance profile.Delete

Prime Infrastructures archives the latest available backup configuration. If the backup configuration
is not available, the device is not be audited and will be marked against non-audited devices.

Latest Archived Configuration

Prime Infrastructure polls for the latest configuration from the device and then performs the audit.
If a Show command is used in the compliance policy, the output of the Show command is taken
from the current device configuration.

Current Device Configuration
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Configuration > Compliance > Violation Summary
The following table displays the information about the rules that you selected for the compliance audit, violation
count, instance count, highest severity and ignore count.

Table 139: Configuration > Compliance > Violations Summary Fields

DescriptionField

Number of rules selected in a policy at the time the policy profile was created. This may be subset of the total
number of rules defined for the policy.

Selected Rules

This lists the number of distinct violations (for a particular policy, for the number of devices) that were observed
in each job. For example, if a particular policy is violated in 100 devices, the violation count is only 1.

Violation Count

Summation of the violation count for all the device. For example, if a particular policy is violated in 100 devices,
the instance count is 100.

Instance Count

The highest severity of the various rules comprising the policy. The highest (as decided at the time of creating
rules) is shown. This overrides the lower severity items.

Highest
Severity

This is the count of rules ignored due to devices falling outside the scope of platforms defined against the rule.Ignore Count

Configure Switches
The following topics contain field descriptions for configuring switches:

• Configure > Switches

• Configure > Switches > IP Address

• Configure > Switches > Add Switches

Configure > Switches
The following table diplays the field description in the summary of switches page:

Table 140: View Switches

DescriptionField

IP address of the switch. Click the IP address of a
switch to get more details.

Management IP Address

Name of the switch.Device Name

Type of SwitchDevice Type

Indicates Reachable if the switch is reachable or
Unreachable if the switch is unreachable.

Reachability Status
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DescriptionField

Status of the last inventory collection. The possible
values are OK, Partial, Failed, NA (for SPT-only
switches), or In Progress.

Inventory Collection Status

Specifies the status of the latest inventory collection.
If the inventory collection was not successful, lists
the possible reasons for the failure.

Inventory Status Detail

Displays the most recent date in which the inventory
was collected.

Last Inventory Collection Date

Date and time the switch was added to the Prime
Infrastructure.

Creation Time

Indicates the license status of the switch, which can
be Full Support or SPT only.

License Status

Configure > Switches > IP Address
The following table displays the field description in the summary information that is displayed while viewing
switch details.

Table 141: Configure > Switches Summary Information

General Parameters

IP address of the switch.IP Address

Name of the switch.Device Name

Date and time of the last inventory collection.Last Inventory Collection Date

Status of the last inventory collection. The possible values are OK, Partial, or
Failed.

Inventory Collection Status

Version of software running on the switch.Software Version

Location of the switch.Location

Contact name for the switch.Contact

Indicates Reachable if the switch is reachable or Unreachable if the switch is
unreachable.

Reachability Status

SNMP Parameters

SNMP version number, which can be v1, v2c, or v3. For switch port tracing to
be successful in switches configured with SNMP v3, the context for the
corresponding VLAN must be configured in the switch.

Version

Retries (in seconds) allowed before the process stops without success.Retries
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General Parameters

Indicate the amount of time (in seconds) allowed before the process time outs.
The valid range is 2 to 90 seconds. The default is 10 seconds.

Timeout

If you selected v3 in the Version drop-down list,
the following fields appear:

UsernameUsername

Authentication type with can be None, HMAC-SHA, or HMAC-HD5.Auth. Type

Authentication password.Auth. Password

Privacy type with can be None, CBC-DES, or CFB-AES-128.Privacy Type

Privacy password.Privacy Password

If you selected v1 or v2c, this field indicates the SNMP community string.Community

Telnet/SSH Parameters

Protocol used.Protocol

Username.User Name

Password.Password

Confirm the password by entering it again.Confirm Password

Enable password.Enable Password

Confirm the password by entering it again.Confirm Password

Timeout value (in seconds).Timeout

Configure > Switches > Add Switches
The following table displays the field descriptions in the adding switches page:

Table 142: Adding a Switch

DescriptionField

General Parameters

Select:

• Device Info to manually enter comma-separated IP addresses of
Ethernet switches.

• CSV File to import a CSV file that contains IP addresses of multiple
switches. Enter the CSV file path in the text box or click Browse to
navigate to the CSV file on your computer.

Add Format Type
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DescriptionField

If you selected Device Info, enter comma-separated IP addresses of the
Ethernet switches.

IP Addresses

Select:

• Full

• SPT only to specify Switch Port Tracing support only.

License Level

SNMP Parameters

Enter SNMP parameters for the write access, if available.
If you enter read-only access parameters, the switch is
added but the Prime Infrastructure is unable to modify
the configuration.

Enter the SNMP version number, which can be v1, v2c, or v3. For switch
port tracing to be successful in switches configured with SNMP v3, the
context for the corresponding VLAN must be configured in the switch.

Version

Enter the retries (in seconds) allowed before the process stops without
success.

Retries

Enter the SNMP timeout value (in seconds).SNMP Timeout (in secs)

If you selected v1 or v2c in the Version drop-down list,
the Community field appears:

Enter the SNMP community string.Community

If you selected v3 in the Version drop-down list, the
following fields appear:

Enter the username.Username

Enter the authentication type with can be None, HMAC-SHA, or
HMAC-HD5.

Auth. Type

Enter the authentication password.Auth. Password

Enter the privacy type with can be None, CBC-DES, or CFB-AES-128.Privacy Type

Enter the privacy password.Privacy Password

Telnet/SSH Parameters

Select the protocol.Protocol

Enter the username.User Name

Enter the password.Password

Confirm the password by entering it again.Confirm Password
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DescriptionField

Enter the enable password.Enable Password

Confirm the enable password by entering it again.Confirm Password

Enter the timeout value (in seconds).Timeout (in secs)

CSV File Fields
The following table displays the field description in the CSV file:

Table 143: Fields in the CSV File

DescriptionField

IP addressip_address

Network masknetwork_mask

SNMP credentials version. Can be v1, v2, or v3.snmp_version

SNMP community (Mandatory for v2.)snmp_community

SNMP V2 community.snmpv2_community

SNMP V3 username (Mandatory for v3.)snmpv3_user_name

SNMP V3 authorization type. Can be None or HMAC-MD5 or HMAC-SHA
(Mandatory for v3.)

snmpv3_auth_type

SNMP V3 authorization password (Mandatory for v3).snmpv3_auth_password

SNMP V3 privacy type. Can be None or DES or CFB-AES-128 (Mandatory
for v3.)

snmpv3_privacy_type

SNMP V3 privacy password (Mandatory for v3.)snmpv3_privacy_password

SNMP retriessnmp_retries

SNMP timeoutsnmp_timeout

telnet, ssh2protocol

for switches and APs, if configured (Mandatory if configured.)telnet_username

for switches and APs (mandatory)telnet_password

Enables the specified passwordenable_password

The telnet timeout periodtelnet_timeout
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